Hard Disk Manager™ for Virtual Server

User Manual
Contents

Introduction .......................................................................................................................... 9
What’s New in Hard Disk Manager for Virtual Server .......................................................... 9
Product Components ........................................................................................................... 10
Features Overview ............................................................................................................. 11
Key Features .......................................................................................................................... 11
User Friendly Fault Minimizing Interface ............................................................................ 11
Backup Facilities ................................................................................................................ 11
Restore Facilities ................................................................................................................. 12
Virtualization Facilities ...................................................................................................... 13
Copy Facilities ..................................................................................................................... 13
Boot Management Facilities ............................................................................................. 13
Partition/Hard Disk Management Facilities ........................................................................ 13
File System Optimization Facilities ................................................................................ 14
Wipe Facilities .................................................................................................................... 14
Automatization Facilities .................................................................................................. 14
Auxiliary Facilities ............................................................................................................. 14
Supported Technologies .................................................................................................... 15
Supported Virtual Machines ............................................................................................. 16
Supported File Systems ..................................................................................................... 16
Supported Media ................................................................................................................ 16
Getting Started .................................................................................................................. 17
Distribution ........................................................................................................................ 17
Distributive CD ................................................................................................................... 17
Online Distribution .......................................................................................................... 17
Registration ......................................................................................................................... 17
How to Download Updates/Upgrades ................................................................................. 18
64-bit Support............................................................................................................................................ 36
Copy Operations ........................................................................................................................................ 36
Drive Partitioning ....................................................................................................................................... 36
Data Sanitization ........................................................................................................................................ 37
Scheduling ................................................................................................................................................. 37
Windows Components ........................................................................................................ 38
Interface Overview ................................................................................................................................ 38
General Layout......................................................................................................................................... 38
Main Menu ................................................................................................................................................ 40
Tool Bar .................................................................................................................................................... 44
Virtual Operations Bar ............................................................................................................................... 45
Common Tasks Bar .................................................................................................................................. 45
Disk Map .................................................................................................................................................... 47
Explorer Bar .............................................................................................................................................. 48
Partition List ............................................................................................................................................... 50
Properties Bar .......................................................................................................................................... 52
Legend Bar ................................................................................................................................................ 52
Status Bar ................................................................................................................................................ 52
Settings Overview .................................................................................................................................. 53
General Options ........................................................................................................................................ 53
Backup Image Options ............................................................................................................................... 54
Partitioning Options .................................................................................................................................. 55
General Copy and Backup Options ........................................................................................................... 56
CD/DVD Recording Options ..................................................................................................................... 57
Hot Processing Options ............................................................................................................................ 58
Run during Backup Options ..................................................................................................................... 59
E-Mail Options .......................................................................................................................................... 61
Operation Dependency Options .............................................................................................................. 62
Managing Tasks .................................................................................................................................................................. 124
Creating a Scheduled Task .................................................................................................................................................. 126
Scripting ........................................................................................................................................................................... 127
Extra Functionality .......................................................................................................................................................... 129
View Partition/Hard Disk Properties .................................................................................................................................. 129
Volume Explorer .............................................................................................................................................................. 129
File Transfer Wizard .......................................................................................................................................................... 130
Mount Partition .................................................................................................................................................................. 132
Downgrade NTFS Version ................................................................................................................................................... 133
Mount Archive .................................................................................................................................................................. 134
Test Surface ...................................................................................................................................................................... 135
Check File System Integrity ................................................................................................................................................ 136
Check Archive Integrity ..................................................................................................................................................... 136
Check Recovery Discs ....................................................................................................................................................... 138
Edit/View Sectors ............................................................................................................................................................. 139
Send Log Files .................................................................................................................................................................. 140
View Logs ............................................................................................................................................................................ 141

Typical Scenarios ............................................................................................................................................................. 142

Backup Scenarios ............................................................................................................................................................. 142
Creating the Backup Capsule ............................................................................................................................................... 142
Back ing up a hard disk or partition to the Backup Capsule ............................................................................................... 143
Back ing up a hard disk or partition to external media (CD/DVD) ..................................................................................... 145
Back ing up a hard disk or partition to a network drive ...................................................................................................... 146
Back ing up a hard disk or partition to an FTP server .......................................................................................................... 148
Back ing up a dual boot Mac to an external USB drive ..................................................................................................... 150
Back ing up files to a local mounted/unmounted (without drive letter assigned) partition .............................................. 153
Creating a differential to a full partition backup ................................................................................................................ 155
Creating an increment to a full partition backup ................................................................................................................ 158

Copyright © 1994-2010 Paragon Software Group. All rights reserved.
Creating an increment to a full file backup ........................................................................................................................ 161
Backing up with Smart Backup Wizard ............................................................................................................................... 162
Creating a cyclic partition backup....................................................................................................................................... 163
Merging a full partition backup with one of its differentials.............................................................................................. 166

Recovery Scenarios .......................................................................................................................................................... 169
Fixing MBR after a boot virus attack................................................................................................................................... 169
Fixing Windows startup ability ........................................................................................................................................... 171
Restoring a hard disk from the bootable Backup Capsule................................................................................................. 175
Restoring a system partition from external media (CD/DVD)............................................................................................ 178
Restoring a system partition from a network drive............................................................................................................ 181
Restoring a system partition from a local drive.................................................................................................................. 185
Restoring a dual boot Mac from an external USB drive ..................................................................................................... 188
Restoring a file increment................................................................................................................................................... 191
Restoring a file increment to a partition backup................................................................................................................ 193
Copying of data from the corrupted system disk to another hard disk ............................................................................. 197
Burning of data from the corrupted system disk to CD/DVD ............................................................................................. 200
Copying of data from a backup to the corrupted system partition.................................................................................... 203
Restoring separate files and folders from a backup........................................................................................................... 206

Resize Scenarios................................................................................................................................................................. 211
Creating a new partition to detach operating system from the rest of data ........................................................................ 211
Increasing size of a system partition by taking unused space of an adjacent partition ..................................................... 213
Increasing size of a system partition by taking unused space from any other ................................................................... 215
Shrinking a system partition to increase size of a data partition ....................................................................................... 219
Resizing partitions of Apple Boot Camp ............................................................................................................................. 222

Creating Dual Boot Systems .............................................................................................................................................. 224
For Windows computers..................................................................................................................................................... 224

System Migration and Virtualization Scenarios.................................................................................................................. 234
Migrating system to another hard disk (Clone HDD)........................................................................................................... 234
Introduction
Paragon Hard Disk Manager™ for Virtual Server is an integrated set of powerful tools that is specially designed to tackle most of the problems you might face while using PC. Its functionality covers all aspects of a computer life cycle beginning from carrying out all the necessary partitioning operations to install the system from scratch and providing its data reliable protection to secure utilization of an outdated hard disk.

In this manual you will find the answers to many of the technical questions, which might arise while using the program.

⚠️ Our company is constantly releasing new versions and updates to its software, that’s why images shown in this manual may be different from what you see on your screen.

What’s New in Hard Disk Manager for Virtual Server
- **Connect VD** to connect a virtual disk as if it’s an ordinary physical disk, thus opening up all functionality available for physical disks to virtual.
- **P2V Copy** to migrate a Win2K+ physical system to a virtual environment in the online mode.
- **P2V Restore** to migrate a Win2K+ physical system backed up with a Paragon disaster recovery tool to a virtual environment.
- **P2V Adjust OS** to recover the startup ability after unsuccessful virtualization with a 3rd party tool.
- **Support for major virtualization software vendors** including Microsoft Virtual PC, Microsoft Virtual Server, Microsoft Hyper-V, VMware Workstation, VMware Fusion, VMware ESX Server.
- **Next generation Adaptive Restore™** (P2P Adjust OS) to successfully migrate a Win2K+ physical system to a different hardware platform (P2P) by allowing automatic injection of all required drivers and the other actions crucial for a migration of this kind.
- **Easy Partition Resize** to resize partitions directly on the Disk Map with the drag-and-drop technique.
- **Express Create Partition Wizard** to create a new partition in the most appropriate place of a hard disk, format it to NTFS and then make it available in the system by assigning a drive letter.
- **Express Resize Partitions Wizard** to increase free space on one partition by up-taking the unused space of an adjacent partition of a hard disk (including partitions of Apple Boot Camp).
- **Safe Defragmentation Mode** to guarantee data loss free defragmentation of any version of NTFS and FAT.
- **Smart Backup Wizard** to secure system and data with the minimal efforts possible. With a unique intelligent work algorithm and a highly intuitive user interface, you can easily back up exactly what you need - the whole system, e-mail databases (MS Outlook, Express, Windows Mail) media files or office documents of the My Documents folder, or any other files and folders.
- **Smart Driver Injector** to make the process of adding new drivers for P2V and P2P operations smooth and easy.
- **Support for the latest operating systems from Microsoft (Windows 7 and Windows Server 2008 R2).**
• **Backup to an FTP server** to provide a new level of system and data protection.

• **Selective Restore** to easily extract files and folders from a backup image with the Restore Wizard without the need to restore the whole image.

• **Scheduling for the File backup** to set up a timetable for any file-based backup operation, thus providing a new level of flexibility.

• **Boot Corrector for WinPE** to fix most of the system boot problems not only with the Linux and PTS DOS bootable recovery environments, but WinPE 2.1 as well.

• **The latest Linux kernel** to enjoy support of a wider range of hardware configurations, including the brand new Intel ICH9 chipset.

• **WinPE 2.1 based bootable recovery environment** to enjoy support of a wider range of hardware configurations with the option to add drivers for specific hardware on-the-fly.

• **More flexibility for online data processing techniques** to provide for easier configuration for both, Paragon Hot Processing and Microsoft Volume Shadow Copy Service (VSS).

• **Better support for 64-bit platforms** to reboot your computer to one of the three special modes (Windows native, Linux, or DOS) to automatically complete operations, which cannot be accomplished under 64-bit Windows.

• **Automatic data exclusion** with an advanced system of filters will help you automate the process of building up contents of the future backup image, by excluding irrelevant data such as movies, music, etc.

• **Better support for GUID Partition Table (GPT)** to back up and restore not only single GPT volumes but entire disks, including the option of resize during the restore operation.

• **Better support for the Apple Boot Camp Configuration** with the option not only to back up and restore this kind of configurations, but to copy single volumes or entire disks with resize.

• **Better support for Linux ExtFS** starting from Ext2FS up to the brand new Ext4FS.

• **More usability** when managing backup tasks with the new Task List and Archive View.

**Product Components**

In order to cope with different tasks, the product contains several components:

• **Windows based set of utilities** is the crucial part of the product. With the help of an easy to use launcher you may find and run tasks of any complexity in the field of data and system protection, hard disk partitioning and cloning, etc.

• **Linux/DOS based recovery environment** is a multi-platform bootable media that enables to run utilities under Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes. Both platforms have their strong sides, for instance Linux can boast support of FireWire (i.e. IEEE1394) or USB devices. It enables to burn CD/DVD disks. However there can be some difficulties with detecting new hardware. DOS in its turn has no problems of that kind but is limited in features. The Linux/DOS recovery environment
requires no installation and can be of great help when the system fails to boot. Besides it offers a Windows XP like environment.

- **WinPE based recovery environment.** Especially for keen followers of Windows, our product also offers a WinPE 2.1 based bootable media. Unlike the Linux/DOS recovery environment it can boast an excellent hardware support and the same interface as the Windows version can. However its system requirements are much tougher.

**Features Overview**

This chapter dwells upon key benefits and technical highlights of the product.

**Key Features**

Let us list some of the key features:

**User Friendly Fault Minimizing Interface**

- **Graphical representation of the data** to gain a better understanding.
- **A handy Launcher** to easily find and run the required tasks.
- **Comprehensive wizards** to simplify even the most complex operations.
- **Resize partitions directly on the Disk Map** with the drag-and-drop technique.
- **A context sensitive hint system** for all functions of the program.
- **Previewing the resulting layout of hard disks before actually executing operations** (so-called virtual operations).

**Backup Facilities**

- **Archive Database** to help the user easily manage backup images (get properties, add, delete, mount, etc.).

This feature is only available for the Windows installation of the program.

- **Support of all present day techniques to store backup images:**
  - **Backup to local mounted/unmounted (without drive letter assigned) partitions**;
  - **Backup to an external mounted storage** to provide for a higher level of data protection and system independence;
  - **Backup to a special secured place on the hard disk called the Backup Capsule** that has an independent system layout (e.g. a separate partition) and will stay operable should the active file system be damaged. To avoid an accidental removing or unauthorized access of the backup data, this partition is hidden and thus cannot be mounted in the operating system;
  - **Backup to external media (CD/DVD)** to guarantee a high level of data protection as long as the backup media is kept secure;
  - **Backup to a network drive** to stand a better chance of success in case of a hard disk failure;
Backup to an FTP server to provide a new level of system and data protection.

- **Smart Backup Wizard** to secure system and data with the minimal efforts possible. With a unique intelligent work algorithm and a highly intuitive user interface, you can easily back up exactly what you need - the whole system, e-mail databases (MS Outlook, Express, Windows Mail) media files or office documents of the My Documents folder, or any other files and folders.

- **Sector backup** to save not only all on-disk information but also the system service structures. It is ideal for making a backup image of an entire hard disk or system partitions to guarantee the operating system’s working capability.

- **Differential backup** to a sector image to only archive changes since the last full sector-based image, thus considerably saving the backup storage space. To restore this kind of backup you will require a full image and one of its differentials.

- **File backup** to save information you really need. If you only care about safety of your e-mail database or particular documents and are not willing to waste the backup storage space, this very feature will suit you at most. Besides an advanced system of filters will help you automate the process of building up contents of the future backup image.

- **Incremental backup** to a file image to only archive changes since the last full or incremental file-based image. An incremental image is smaller and takes less time to create, but you will require the initial full image and all of its incrementals to restore the latest point of this kind of backup.

- **File backup to a sector image**. It is a unique technology on the market so far that bridges two principally different approaches of the data backup: the file-based backup and the disk imaging backup. With its help you can now create a sector-based backup of your system to get it back on track in minutes in case of a virus attack or a hardware malfunction and then just make file-based incremental images to the previously created sector-based backup to keep updated only information that is critical for you. Thus you will considerably save your system resources.

- **Cyclic backup** to automate the backup of separate partitions. It is an ideal option if you want to establish a self-acting data protection system.

**Cyclic Backup is only available for the Windows installation of the program.**

- **Synthetic backup** to change any property (merge a given differential image with its full image, split/un-split, compress/de-compress, etc.) of an existing backup image without carrying out a physical backup operation.

- **Bootable Backup Capsule** to get the choice to launch the Linux or PTS DOS recovery environment every time you start up the computer. With its help you will be able to run utilities under Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes.

**This feature is only available for the Windows installation of the program.**

**Restore Facilities**

- **Restore an entire disk, separate partitions** or **only files you need** from the previously created backup image.
• **Restore with Shrink** to restore a backup image to a free block of smaller size taking into account only the amount of actual data of the image.

• **Adaptive Restore** to successfully migrate a Win2K+ physical system to a different hardware platform (P2P) by allowing automatic injection of all required drivers and the other actions crucial for a migration of this kind.

**Virtualization Facilities**

• **Connect VD** to connect a virtual disk as if it’s an ordinary physical disk, thus opening up all functionality available for physical disks to virtual.

• **P2V Copy** to migrate a Win2K+ physical system to a virtual environment in the online mode.

• **P2V Restore** to migrate a Win2K+ physical system backed up with a Paragon disaster recovery tool to a virtual environment.

• **P2V Adjust** to recover the startup ability after unsuccessful virtualization with a 3rd party tool.

---

Virtualization is the latest trend in the system migration, protection, and evaluation.

---

**Copy Facilities**

• **One Button Copy Wizard** to carry out such a technically complicated operation as cloning of hard disks just by pressing one button.

• **Partition/hard disk copy** to successfully transfer all on-disk information including standard bootstrap code and other system service structures, thus maintaining the operating system’s working capability.

---

Copy functionality can also be used as an alternative way of data protection.

---

**Boot Management Facilities**

• **Boot Manager Setup Wizard** to easily manage several operating systems on one computer.

**Partition/Hard Disk Management Facilities**

• **Basic functions for initializing, partitioning and formatting hard disks** (create, format, delete). Instead of the standard Windows disk tools, the program supports all popular file systems.

• **Express Create Partition Wizard** to create a new partition in the most appropriate place of a hard disk, format it to NTFS and then make it available in the system by assigning a drive letter.

• **Merge Partitions Wizard** to consolidate the disk space, which originally belongs to two adjacent partitions (NTFS, FAT16/FAT32), into a single, larger partition.

• **Redistribute Free Space Wizard** to increase free space on one partition by up-taking the on-disk unallocated space and the unused space of other partitions.

• **Express Resize Partitions Wizard** to increase free space on one partition by up-taking the unused space of an adjacent partition of a hard disk (including partitions of Apple Boot Camp).
• **NTFS hot resize upward** to enlarge an NTFS partition (system, locked) without rebooting Windows and interrupting its work.

• **Convert a file system** (FAT16/32, NTFS, Ext2/Ext3) without reformatting.

• **Mount a partition** (assign a drive letter) of any file system type to make it available for your operating system.

• **Modify file system parameters** (make active/inactive, hide/unhide, change serial number, partition ID, volume label, etc.).

• **Install New OS Wizard** to make a system ready to install a new operating system.

• **Undelete Partitions Wizard** to recover an accidentally deleted partition.

File System Optimization Facilities

• **27 defragmentation strategies** available to defragment FAT and NTFS file systems.

• **MFT defragmentation and shrinking** to improve performance of NTFS.

• **Safe Defragmentation Mode** to guarantee data loss free defragmentation of any version of NTFS and FAT.

• **Low free space defragmentation** (less than 1% of the free space required) to successfully defragment almost full disks.

---

Defragmentation is accomplished with a separate component called Paragon Total Defrag. To know more on the subject, please consult its help.

---

Wipe Facilities

• **Data wiping** to successfully destroy all on-disk information including the standard bootstrap code and other system service structures.

• **Free space clearing** to destroy any remnants of deleted files/directories left on disk without affecting the used data.

Automatization Facilities

• **Task scheduling** to automate routine operations. It can be particularly effective when you have to repeat a sequence of actions on a regular basis.

---

Scheduling is only available for the Windows installation of the program.

---

• **Scripting** to make the program create a script of any set of operations you need. Besides support of all operations available in the interactive mode, the unattended mode provides some additional features, such as conditional execution, subroutines, repeatable iterations, disk/partition properties analysis, errors management, etc.

Auxiliary Facilities

• **File Transfer Wizard** to make such operations as transferring of files/directories or burning of them to CD/DVD as easy and convenient as possible. Providing access to Paragon backups as regular folders, it may also help to replace corrupted data from a previously created image in case of an operating system failure.
• **Volume Explorer** is a handy tool when you have different file systems on the disk, whether they contain an operating system or just data. Volume Explorer will let you explore a file system of any type and provide access to the necessary files and directories regardless of their security attributes.

• **Recovery Media Builder** to create a bootable recovery media based on Linux/DOS or WinPE 2.1 on a CD, DVD disc, or flash memory, which can later be used to boot and recover your computer in case of an operating system failure. Moreover, with its help you can save data from partitions of your hard disk directly to compact discs or burn ISO-images. The utility supports various formats of laser discs: CD-R/RW, DVD-R/RW, DVD+R/RW, DVD-R, DVD+R double layer, Blu-ray and can handle multi-session burning.

• **Network Configuration Wizard** to establish a network connection under Linux or WinPE either to save a backup of a partition/hard disk or just several files on a network computer or retrieve a previously made backup from a network computer for recovery purposes.

• **Boot Corrector** to fix most of the system boot problems that can be a result of a human factor, program error or a boot virus activity.

> **Boot Corrector is only available for the WinPE 2.1 or Linux/DOS bootable recovery environment.**

---

**Supported Technologies**

Along with using innovative technologies from outside, Paragon has developed a number of its own original technologies that make its products unique and attractive for customers:

• **Paragon Hot Backup™** technology to back up locked partitions and hard disks under Windows NT+ family operating systems providing both high operating efficiency as well as low hardware requirements.

• **Paragon Adaptive Restore™** technology to successfully migrate a Win2K+ physical system to a different hardware platform (P2P).

• **Paragon Power Shield™** technology to provide data consistency in case of a hardware malfunction, power outages or an operating system failure.

• **Paragon UFSD™** technology to browse partitions of any file system including hidden and unmounted, modify and copy files and folders, etc.

• **Paragon Hot Resize™** technology to enlarge NTFS partitions (system, locked) without rebooting Windows and interrupting its work.

• **Paragon Restore with Shrink™** technology to restore a backup image to a free block of smaller size taking into account only the amount of actual data of the image.

• **Paragon Smart Partition™** technology to securely perform hard disk partitioning operations of any complexity.

• **Paragon BTE™** technology to set tasks for execution in the Windows blue screen mode, thus saving from the need to use a bootable media when modifying system partitions.

• **Paragon VIM™** (Virtual Image Management) technology that enables Paragon products work with virtual disks as though they are physical hard disks.
- **Microsoft Volume Shadow Copy Service** (VSS) to provide the copy/backup infrastructure for the Microsoft Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the leading copy/backup solution vendors on the market, it is based on a snapshot technology concept.

- **Microsoft Dynamic Disk** (simple, spanned, striped, mirrored, RAID-5) to offer more management flexibility without the partition limitation of basic disks. Dynamic storage can be particularly beneficial for large-scale businesses when dealing with many physical hard disks involving complex setup.

- **GUID Partition Table** (GPT). It is the next generation of a hard disk partitioning scheme developed to lift restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and Linux.

**Supported Virtual Machines**
- Microsoft Virtual PC;
- Microsoft Virtual Server;
- Microsoft Hyper-V;
- VMware Workstation;
- VMware Fusion;
- VMware ESX Server;

**For Connect VD only**
- MS Windows Vista/7 backup;
- XenServer (.vhd only).

**Supported File Systems**
- Full read/write access to FAT16/FAT32 partitions.
- Full read/write access to NTFS (Basic and all five types of Dynamic Disks) under Windows 95/98/ME, Linux and PTS DOS. Compressed NTFS files are also supported.
- Full read/write access to Ext2FS/Ext3FS/Ext4FS partitions under all versions of Windows, DOS 5.0 and later.
- Limited read/write access to Apple HFS+ partitions.

---

**Unofficially, support of non-Roman characters for the HFS+ file system is unavailable at the moment. The company is about to implement it in the nearest future.**

**Supported Media**
- Support of both MBR and GPT hard disks (up to 1,5 TB tested)
- IDE, SCSI and SATA hard disks
- FireWire (i.e. IEEE1394), USB 1.0, USB 2.0 hard disks
• PC card storage devices (MBR and GPT flash memory, etc.)

**Getting Started**

In this chapter you will find all the information necessary to get the product ready to use.

**Distribution**

Paragon Hard Disk Manager is distributed in two ways:

• Boxed package from Paragon Technology GmbH and resellers

• Downloadable package over the Internet at the company’s web-site

**Distributive CD**

The boxed package includes a distributive CD that is in fact a bootable Linux/DOS recovery environment with auto-run of the Windows installation, thus it can be used as a ready-made solution (see Booting from the Linux/DOS Recovery Media). But if you’re going to run the Windows components, you need to install them first (see Installation).

If you want to download an update/upgrade of the product, it will be in form of the downloadable installation package as described in Online Distribution).

⚠️ The WinPE recovery environment can only be obtained through the company’s web service. You will get the required download link after the product has been purchased.

**Online Distribution**

Hard Disk Manager purchased over the Internet will be in form of an MSI package. After installing the product you can launch the Recovery Media Builder to build the Linux/DOS or WinPE recovery media.

⚠️ The WinPE recovery environment can only be obtained through the company's web service. You will get the required download link after the product has been purchased.

**Registration**

Paragon Technology GmbH provides a wide range of online services through its web-portal - www.paragon-software.com/support/:

• Registration of new users;

• Registration of purchased products for registered users;

• Available around-the-clock downloading center, where registered users can get product updates/upgrades as well as all the necessary documentation;

• Downloadable free demo versions and open documentation for all users.

⚠️ It is recommended to use Internet Explorer 5+ or any compatible browser.

**To register as a new user**

To register as a new user, please do the following:
1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

2. Click Create of the Create a Paragon Account section;

3. Fill out a registration form;

4. Click Register.

The most important field in the form is an E-mail address, as it serves as a login to enter the system. Besides your access password will be sent to this address as well.

**To register a new product**

If you are a registered user and would like to register Hard Disk Manager, please do the following:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

2. In the Email field of the Authorization section, enter an E-mail used for registration;

3. In the Password field enter a password received after registration;

4. Click Sign in;

5. If the user name and password are valid, you will get to your account;

6. Click Register new product of the Products section;

7. Enter your product serial number in the Serial Number field. You can find it in the product box or obtain from your reseller. Click Next;

8. On the next page you will be asked to provide some additional data. Also you will need to decide whether you want to get confirmation on registering the product by E-mail or not. Click Next, and then click Finish.

That is all. The product is now registered.

**How to Download Updates/Upgrades**

Downloading of updates/upgrades can be fulfilled in the following way:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

2. In the Email field of the Authorization section, enter an E-mail used for registration;

3. In the Password field enter a password received after registration;

4. Click Sign in;

5. If the user name and password are valid, you will get to your account;

6. Select My Downloads of the Products section to see what updates are available for you;

7. Select the desired update and click Download.

**Contacting Paragon Technology GmbH**

If you have any questions about the company products, please do not hesitate to contact Paragon Technology GmbH.
System Requirements

Windows based set of utilities
To use the Windows utilities, you should install them first. But before that, please make sure your computer meets the following minimum system requirements:

- Internet Explorer 5.0 or higher
- Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
- 128 MB of RAM (256+ recommended)
- Hard disk drive with 100 MB of available space
- SVGA video adapter and monitor
- Mouse

Linux/DOS based recovery environment
To use the Linux/DOS recovery environment on your computer (it doesn’t matter what operating system is installed), please make sure that it meets the following minimum system requirements:

- IBM AT compatible computer with i486 or higher CPU
- 256 MB of RAM
- SVGA-compatible monitor
- Mouse (recommended)

WinPE based recovery environment
To use the WinPE based recovery environment on your computer, (it doesn’t matter what operating system is installed), please make sure that it meets the following minimum system requirements:

- Intel Pentium III CPU or its equivalent, with 1000 MHz processor clock speed
- At least 512 MB of RAM
- SVGA-compatible monitor
• Mouse (recommended)

**Additional requirements**
There may be additional requirements if you want to use advanced features:

• Network card to send/retrieve data to/from a network computer
• Recordable CD/DVD drive to burn data to compact discs
• External USB hard drive to store backup data.

**Installation**
As we have already mentioned only Windows components of the product require installation. So to install Paragon Hard Disk Manager under Windows, please do the following:

1. **Run Setup Application.** Click on the *.MSI file. This application will guide you through the process of the program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard user interface and set of installation steps.

   In case there is some previous version of the program installed on the computer, the program will offer the user to uninstall it first.

2. **Starting Setup.** The Welcome page informs that the application is being installed. Click the Next button to continue.

3. **Confirm License Agreement.** The License Agreement page displays the Paragon License Agreement. Read the agreement and then select the appropriate option to accept. If you do not agree with any conditions stated there, the installation process will be interrupted. By clicking the Print button, the License Agreement may also be printed out.

4. **Provide Registration Information.** On the Registration page you are to provide your product key and serial number.

5. **Provide Customer Information.** On the Customer Information page you are to provide the standard information, i.e. a user name and an organization. Besides you need to decide whether to make the program available for all users of this computer (if several) or only for the current one.

6. **Select an Installation Folder.** The Destination Folder page allows you to choose a folder where the program will be installed. By default, the installation folder will be created as:

   C:\Program Files\Paragon Software\Paragon Hard Disk Manager. To select another folder, click the Change... button.

   After you have selected the required folder, click the Next button to continue.

   Do not install the program on network drives. Do not use Terminal Server sessions to install and run the program. In both cases, the program functionality will be limited.

7. **Confirm Installation.** On the Ready to Install the Program page click the Install button to start the installation or the Back button to return to any of the previous pages and modify the installation settings.
8. **Copying Files.** The Copying Files page shows the overall progress of the installation. Click the Cancel button to abort the setup.

9. **Finishing the Installation.** The Final page reports the end of the setup process. Click the Finish button to complete the wizard.

---

To accomplish online backup/copy of locked partitions/hard disks the program uses a kernel mode hotcore driver, thus the system reboot is required to complete the installation procedure.

---

**First Start**

To start Paragon Hard Disk Manager under Windows, please click the Windows Start button and then select **Programs > Paragon Hard Disk Manager™ > Paragon Hard Disk Manager™**.

The program provides wide opportunities in the field of hard disk structure modification, so just to be on the safe side, please make a backup of your data before carrying out any operation.

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular basis. With its help you can also start up the traditional launcher, the help system or go to the program’s home page.
Building Recovery Media
Recovery Media Builder can help you accomplish the following operations:

- Prepare the Linux/DOS recovery environment (included in the installation package) on external media (CD, DVD, or flash memory) to boot and run utilities under Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes (strongly recommended);
- Prepare a custom Linux/DOS recovery environment by adding any data you like to the standard image;
- Prepare a bootable recovery environment from any ISO image, including our WinPE 2.1 image (strongly recommended);
- Create from the master CD the Linux/DOS or WinPE recovery environment on a CD/DVD disc, or flash memory.

Below you can find how to build our WinPE 2.1 based recovery environment on a thumb drive:

1. Plug in a thumb drive of at least 250 MBs in size. Please note all data on that drive will be deleted.
2. Launch the Recovery Media Builder. There are several ways to do it:
   - In the Main Menu: select Tools > Recovery Media Builder…
   - On the Common Tasks Bar: click the Recovery Media Builder item of the Wizards menu.
3. On the Wizard's Welcome page, click the Next button.
4. Select the Flash Memory option.
5. Select the User specified CD/DVD image (.iso file) option, then browse for an ISO image of our WinPE 2.1 recovery environment or manually type in a full path to it. By selecting the Typical option you can build our Linux/DOS recovery environment, which we highly recommend you to do as well.
6. Select the required thumb drive from the list of flash memory devices available in the system at the moment (if several).

7. You will have to confirm the operation.

Booting from the Linux/DOS Recovery Media

The Linux/DOS recovery environment can be used to boot your computer into Linux or PTS DOS to get access to your hard disk for maintenance or recovery purposes. It also has the PTS DOS safe mode, which may help in a number of non-standard situations such as interfering hardware settings or serious problems on the hardware level. In this case, only basic files and drivers (such as hard disk drivers, a monitor driver, and a keyboard driver) will be loaded.

Startup

To start working with the Linux/DOS recovery environment, please take the following steps:

1. Start up the computer from our Linux/DOS recovery media.

**Recovery Media Builder** can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

By default the Normal Mode will be automatically initiated after a 10 second idle period.
3. Click on the required operation to start. Hints on the selected at the moment item will help you make the right choice.

4. Consult the help system by pressing **ALT+F1** to know more on the subject.

**Boot menu**
The Boot menu contains the following commands:

- **Normal Mode**. Boot into the Linux normal mode. This mode uses the full set of drivers (recommended);
- **Safe Mode**. Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux normal mode if it fails to work properly;
- **Low-Graphics Safe Mode**. Boot into the PTS DOS safe mode. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu;
- **Floppy Disk**. Reboot the computer from a system floppy disk;
- **Hard Disk 0**. Boot from the primary hard disk;
- **Find OS(s) on your hard disks**. The program will scan hard disks of your computer to find any bootable operating system.

To move within the menu, please use the arrow keys of the computer keyboard.

While working with the recovery environment you might experience some inconvenience caused by possible video artifacts. It is just a result of changing video modes and in no way will affect the program functionality. If this is the case, please wait a bit and everything will be OK.

**Normal Mode**
When the Normal mode is selected, the Linux launch menu appears:
- **Hard Disk Manager** (enables to copy and back up separate partitions or entire hard disks, carry out partitioning operations, etc.);

- **Simple Restore Wizard** (allows restoring hard disks and partitions);

- **One Button Copy Wizard** (helps to carry out such a technically complicated operation as cloning of hard disks just by pressing one button);

- **Wipe Wizard** (enables to destroy all on-disk information or only remnants of deleted files/directories);

- **Express Resize Wizard** (enables to increase free space on one partition by up-taking the unused space of an adjacent partition);

- **File Transfer Wizard** (allows coping files/folders to another disk or a partition as well as recording them to CD/DVD);

- **Boot Corrector** (helps to correct the Windows System Registry without Windows being loaded);

- **Network Configurator** (enables to establish a network connection under Linux);

If you are going to use network resources, first launch the **Network Configuration Wizard** to establish a network connection.

- **Log Saver** (helps to collect and send the necessary log files to the Technical Support);

- **View the mounted partitions** (the list of all mounted partitions will be displayed);

The Linux/DOS recovery environment assigns drive letters to partitions the way it is done in DOS, i.e. one after another, primary partitions at first. Thus mounted partitions may have different drive letters from Windows.

- **Eject CD/DVD**;

- **Command Line** (allows experienced users to execute any operation);
• Reboot the computer;
• Power off the computer.

To move within the menu, please use the arrow keys of the computer keyboard.

**Safe Mode**
When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as for the Normal mode except the **Network Configurator** and **Log Saver** commands. Besides due to certain limitations of the PTS DOS environment, there is no possibility to burn CD/DVD discs.

**Low Graphics Safe Mode**
When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same functionality and looks similar to the Safe mode but graphically simpler.

![PTS DOS launch menu](image)

**Booting from the WinPE Recovery Media**
The WinPE recovery environment can be a real alternative to the Linux/DOS recovery environment. Providing nearly the same level of functionality it offers an excellent hardware support and the same interface as the Windows version does.

**Startup**
To start working with the WinPE recovery environment, please take the following steps:

1. Start up the computer from our WinPE recovery media.

   **Recovery Media Builder** can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

   To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. Once it has been loaded, you will see the License Agreement. Read the agreement and then mark the appropriate checkbox to accept. If you do not agree with any conditions stated there, you won’t be able to use the program.
3. Once you accept the agreement, you will see the Universal Application Launcher. In general it enables to run components of the product, load drivers for undefined hardware or establish a network connection.

4. Click on the required operation to start. Hints on the selected at the moment item will help you make the right choice.

5. Consult the help system by pressing ALT+F1 to know more on the subject.

⚠️ Our WinPE 2.1 based recovery environment offers excellent hardware support. However in case it doesn’t have a driver for your disk controller, your hard disks will be unavailable.
Please consult the [Adding specific drivers](#) scenario to know how to tackle this issue.

**Basic Concepts**
This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general notion of the operation performance and makes it easier for the user to operate the program.

**System and Data Protection**
The data protection issue is a growing cause of worrying for more and more people today. Indeed, it is hardly to find a person who will be particularly happy when all precious information on the hard disk is irreversible lost as a result of its malfunction. So how this tragedy can be prevented?

**File Backup versus Sector Backup**
Since the advent of the computer age people were in the search of ways to guarantee data safety. As a result we’ve got now two principal approaches: the file-based backup and the sector-based backup. The main difference between the two lies in the way data is treated.

A sector-based backup operates with an image (or a snapshot) of the whole disk system or its separate partitions. It not only includes the contents of all user-made files, but additionally contains the exact structure of directories, information about file allocation, file attributes and other related data. Thus it enables to successfully process system or encrypted partitions of any file system type, no matter what kind of information they contain.

In contrast, a file-based backup takes into account a file system structure and only functions on a file or folder level. So it is very efficient when archiving separate files or folders, but in no way will help you back up a system partition.

You should understand pretty well that each of the two approaches is only good when properly chosen. In the comparison table below you can see when this or that approach will suit you at most.

<table>
<thead>
<tr>
<th>Sector-Based Backup</th>
<th>File-Based Backup</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Merits</strong></td>
<td></td>
</tr>
<tr>
<td>It does not dependent on a particular file system. Thus it can successfully process system or encrypted partitions of any file system type, no matter what kind of information they contain.</td>
<td>Functioning on a file/folder level, it is ideal for archiving separate files or folders.</td>
</tr>
<tr>
<td>It can create an exact image of a partition, including its service data. Thus it is ideal for a backup/restore of a system partition or a fast deployment to a bunch of identical computers.</td>
<td>It enables to automatically build up contents of the future backup image by using an advanced system of filters.</td>
</tr>
<tr>
<td>It allows archiving data of the same volume with different backup policies.</td>
<td></td>
</tr>
<tr>
<td>It is easy and efficient when creating backup chains.</td>
<td></td>
</tr>
</tbody>
</table>

**Demerits**
Backup Types
At the present moment the market is offering various types of backup imaging to meet the needs of any user. Besides supporting them all, our program offers a unique backup type, called File Increment to a Sector Backup.

**Full and Differential Sector Backups**
A full sector-based backup image includes all contents of a partition or a hard disk at the moment of its creation. If you roll back your system to the initial state on a regular basis, that’s exactly what you’re looking for. But if you want to have multiple backup archives of the same partition reflecting certain time stamps, unchanged data will inevitable be duplicated in all archives and take additional space on backup media. To tackle this issue there has been developed a supplementary technique called Differential Sector Backup.

A differential archive only contains data changed since the time of creating a full archive, which forms a base (or a parental image) in this case, thus considerably saving your system resources. It is realized by the exact bit-wise comparison of the previous partition’s data (saved in the parental image) with the current data (that is actually the partition itself). To restore this kind of backup you will require a full image and one of its differentials, what is very convenient.

![Differential Base to a Sector Backup](image)

**Warning:** This function is only available for single primary and logical partitions.

**Full and Incremental File Backups**
A full file-based archive only contains files and folders. It is really efficient when backing up an e-mail database or particular documents, as no redundant data is processed. But if you care about maintaining a files history, you can benefit from one more supplementary technique called Incremental File Backup.
An incremental archive only contains data changed since the time of creating a full or incremental file-based archive. It is smaller and takes less time to create, but you will require the initial full image and all of its increments to restore the latest point of this kind of backup.

**Incremental Chain to a File Backup**

<table>
<thead>
<tr>
<th>Sunday</th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
<th>Saturday</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base File Backup</td>
<td>Increment #1</td>
<td>Increment #2</td>
<td>...</td>
<td>...</td>
<td>Increment #n</td>
<td></td>
</tr>
</tbody>
</table>

**File Increment to a Sector Backup**

File Increment to a Sector Backup is a unique technology on the market so far that bridges two principally different approaches of the data backup: the file-based backup and the sector-based backup. With its help you can now create a sector-based backup of your system to get it back on track in minutes in case of a virus attack or a hardware malfunction and then just make file-based incremental images to the previously created sector-based backup to keep updated only information that is critical for you. Thus you will considerably save your system resources.

**Backup Storage**

Our program supports all present day techniques of storing backup images. Let’s take a closer look at them all to understand what kind of storage is able to provide better security:

- You can place a backup image to a local mounted or unmounted (without drive letter assigned) partition. Despite the fact that it is the most convenient way, try not to use it. You can delete your backup just by accident or lose it as a result of a hardware malfunction, or a virus attack;

- You can place a backup image to an external mounted storage to provide for a higher level of data protection and system independence;

- You can place a backup image to a special secured place on the hard disk called the Backup Capsule that has an independent system layout (e.g. a separate partition) and will stay operable should the active file system be damaged. To avoid an accidental removing or unauthorized access of the backup data, this partition is hidden and thus cannot be mounted in the operating system. However it won’t help you in case of a hardware malfunction;

- You can place a backup image to external media (CD/DVD) to guarantee a high level of data protection as long as the backup media is kept secure;

- You can place a backup image to a network drive to stand a better chance of success in case of a hard disk failure. Moreover, by storing it on a special-purpose server you may be pretty sure nothing will happen to it;

- Finally you can place a backup image to an FTP server to provide a new level of system and data protection.
Known Issues on FTP

1. You need to check out yourself Windows Firewall or programs of this kind let our program work with the required port (21 by default).

2. File backup and restore to/from FTP, including the selective restore functionality are not available.

3. SSL login/password encryption is not supported.

4. You can browse an FTP server in the passive mode only.

5. Parallel access to several FTP servers is limited - only one password for all servers is available.

Adaptive Restore

Windows family operating systems are notorious for their excessive sensibility to hardware, especially when it turns to replacement of such a crucial device as HDD controller or motherboard – actually Windows will most likely fail to boot as a result of this operation.

With our technology (available in the P2P Adjust OS Wizard) you can make your Windows bootable on some other computer by allowing automatic injection of all required drivers and the other actions crucial for a migration of this kind. Actually, this operation for Windows 2000/XP/Server 2003 and Windows Vista/7/Server 2008 differs a bit, so does the wizard’s work algorithm.


It actually implies three operations:

- **Providing the ability to change the Windows kernel settings** to the most suitable for your new configuration. The program will automatically add all available Windows HAL and kernels to the boot menu (the boot.ini file) to choose the required platform in case your system fails to boot (Uniprocessor, Multiprocessor, or Old legacy PC without ACPI). You can later remove them from the menu either under Windows or with Boot Corrector.

  If you’ve got a 64-bit operating system, no options will be added to the boot menu.

- **Automatic replacement of the boot critical drivers** (HDD controller, PS/2 and USB mouse and keyboard) to the default Windows drivers to provide the maximum level of compatibility. Once your Windows starts up, it will initiate reconfiguration of all Plug’n’Play devices, so we do recommend you to provide the latest drivers for your motherboard and processor at this step, as it can considerably improve the overall performance of your system.

- **The option to inject 3rd party drivers** to guarantee your system will start up on the new hardware. Actually you’ve got two options, either provide a path to your own driver repository (collection of all drivers to your hardware devices located in one folder) for the program automatically pick and install only those drivers required for your OS (recommended), or manually specify drivers critical for the guaranteed startup of your system on the new hardware.

Adaptive Restore for Windows Vista/7/Server 2008

It is based on the fact that these operating systems do not delete their distributive driver repositories after the setup, but simply make them inactive in the Windows Registry. So thanks to our technology these driver repositories can be made available during the restore procedure to let Windows Vista/7 or 2008 Server automatically find and install any lacking driver with no action from your side required, what is very convenient.
Anyway, not all drivers can be found in the built-in driver repositories, especially when you’ve got to do with specific SCSI or Serial ATA controllers. For situations of this kind you’ve got the option to inject any 3rd party driver, either by providing a path to your own driver repository (collection of all drivers to your hardware devices located in one folder) for the program automatically pick and install only those drivers required for your OS (recommended), or manually specifying drivers critical for the guaranteed startup of your system on the new hardware.

**Adaptive Restore Application**

Let’s consider a number of situations when the Adaptive Restore feature can help you out:

- If you need to upgrade to newer hardware while keeping all your programs and settings intact;
- If you need to replace failed hardware and cannot find an exact match for your original system specifications.

**Known Issues**

1. After transferring Microsoft Vista and later versions to different hardware, you will need to re-activate license of the system. It’s normal behavior as these systems keep tracking any change of hardware. Re-activation is legally justified in this case, as you transfer your system to another PC.
2. If you’ve installed several operating systems on one partition, we can only add drivers to the latest version of OS. Microsoft highly recommends that you install an operating system on a separate partition.
3. Please note drivers are not cached during selection. That’s why if you select a driver to add to the system, but it’s already unavailable during the operation, the program will end the operation with an error.

**System Virtualization**

With new powerful x86 computers, system virtualization has become extremely popular. It’s a software technology that enables to run several virtual machines on one physical machine, providing resources of that single computer are shared across several environments. As a result one and the same physical computer can have multiple OSs and applications operating simultaneously, thus opening up enormous opportunities for both, business and home users, exactly:

- Avoid underutilization of up-to-date powerful computers;
- Increase flexibility of a physical infrastructure;
- Provide for increased availability of hardware and applications;
- Cut expenses on hardware and energy;
- Guarantee smooth and cost saving system migration;
- Enjoy working with old applications you can’t launch on your current PC;
- Take advantage of having multiple operating systems on one Windows PC, including Linux, Mac OS X, etc.;
- Forget about hunting for replacement of the failed hardware, and many more…

**Known Issues**

1. You should install integration services (e.g. VMware Tools) on the virtual system yourself. We only guarantee its smooth startup.
2. At the startup, a virtual machine (e.g. VMware Workstation) might notify you that the used virtual disks are of old format and require update. You can update your disks, since this procedure involves change of a version only, nothing else. This is done on purpose not to lose compatibility with the older versions of VMware.

3. After transferring Microsoft Vista and later versions to a virtual disk, you will need to re-activate license of the system. It’s normal behavior as these systems keep tracking any change of hardware. Re-activation is legally justified in this case, as you transfer your system to another PC.

4. If you prefer to create a SCSI HDD when converting to a virtual disk of VMware Workstation or VMware ESX Server, we pick a driver for the HDD controller just the way VMware does, i.e. according to the found OS:
   - Windows 2000/Windows XP – Buslogic;
   - Windows 2003 (all editions including WinXP x64) and later versions – LSI Logic.

   Thus if you will then connect the created virtual disk to a virtual machine with another type of the adapter, the system won’t start up. Please use our P2P Adjust Wizard to install the required driver.

5. If you convert a partition/hard disk with Windows XP to a SCSI virtual disk of VMware Workstation or VMware ESX, it’s required to add the VMware SCSI driver from outside, since Windows XP doesn’t have it. To do that we try to find an installed version of VMware Workstation on your computer to extract the necessary driver. If failed to find, we will ask you to provide a path to the VMware Tools ISO image.

6. We can smoothly convert a hard disk with several operating systems. But according to Issue 4, when converting to a SCSI virtual disk of VMware Workstation or VMware ESX Server, for different versions of OS, different controller drivers will be installed. VMware however cannot emulate different hardware for each operating system of one virtual machine. To tackle this issue, please use our P2P Adjust Wizard to install the LSI Logic driver under Windows 2000/Windows XP, then select the LSI SCSI controller for your virtual machine.

Paragon Hot Processing & Volume Shadow Copy Service

Offline versus Online Data Processing

In the course of time there have been developed various methods of data processing. Despite different work concept, all of them can be divided into two principal groups: offline (cold) and online (hot) data processing techniques.

As the name infers, offline data processing can only be accomplished when the data is in consistent state (the operating system and all the applications are completely shut down). Actually it is the most preferable way of image creation or data cloning, since software can obtain an exclusive right to process data that guaranties high level of operating efficiency. However, the offline data processing is absolutely out of question when dealing with 24/7 production environments.

In contrast, online data processing enables to create a consistent snapshot even as the data is currently modified. It is particularly useful for systems with high availability requirements, but it won’t be accomplished until all active transactions are complete. The point is to provide a coherent state of all open files and databases involved in a process, taking into account that applications may still keep writing to disks. As a result an online data processing cannot boast high operating speed.

Our program supports both offline and online methods of data processing. As far as online method is concerned it offers its own hot processing algorithm together with the possibility to use snapshot technologies provided by the Microsoft VSS framework.
Paragon Hot Processing Technology
Paragon Hot Processing is an online copy/backup technology for Windows NT+ family operating systems. Developed back in 2001, nowadays it is integrated with all copy/backup solutions offered by the company.

Paragon Hot Processing is not exactly a snapshot technology, though it has much in common with it. During an online copy/backup, the program uses the kernel mode driver HOTCORE.SYS to intercept and control disk write activity of applications and the operating system. The hotcore driver as an integral part of the program is installed during the setup procedure (that’s why the system reboot is required to complete the setup procedure). For the most part the driver is in the idle mode until it is activated with the program. While in this mode it bypasses any calls having no effect on the overall system performance, but a few kilobytes of the system memory.

Paragon Hot Processing technology offers copy/backup of locked partitions and hard disks under Windows NT+ family operating systems providing both high operating efficiency as well as low hardware requirements.

⚠️ It is not recommended to use Paragon Hot Processing with active SQL Server, Exchange or Oracle databases since the backup image contents may be corrupted.

Volume Shadow Copy Service
Microsoft Volume Shadow Copy Service (VSS) is designed to provide the copy/backup infrastructure for the Microsoft Windows XP/Vista/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the leading copy/backup solution vendors on the market, it is based on a snapshot technology concept.

Initiated by a VSS aware copy/backup utility, VSS creates snapshots for the selected volumes and represents them as virtual read-only devices, called volume shadow copies. Once the shadow copies are created, the copy/backup utility starts processing the data while applications keep writing to original volumes.

Unlike Paragon Hot Processing the VSS technology provides a unique possibility to make a synchronous snapshot of multiple volumes. This very feature can be particularly beneficial when backing up active SQL Server 2003, Exchange 2003 or Oracle databases located on multiple volumes the way it is recommended by Microsoft to improve the level of database performance and reliability, thus providing 100-percent data consistency.

⚠️ To use VSS it is necessary to have a mounted 300 MB+ NTFS partition.

Dynamic Disks
As you probably know, MS-DOS, Microsoft Windows 95/98/Me/NT/2000/XP/Vista/Server 2003/2008 support four primary partitions per physical hard disk, one of which can be extended. Certainly there is the possibility to create logical drives within the extended partition. Such types of disks are called basic. Windows XP Professional, Windows 2000, Windows Vista and Windows Server 2003/2008 follow the same strategy: You can have a maximum of four primary partitions, one of which can be an extended partition with logical drives. However, these operating systems also introduce a new disk configuration type - dynamic disk - which must be understood to effectively configure and manage hard disks.

Dynamic disk is a physical disk that doesn't use partitions or logical drives. Instead, it contains only dynamic volumes. Regardless of what format you use for the file system, only Win2K computers can access dynamic volumes directly. However, computers that aren’t running Win2K can access the dynamic volumes remotely when connected to the shared folders over the network.
Dynamic disks can co-exist on a system with basic disks. The only limitation is that you cannot mix Basic and Dynamic disks on the same hard drive.

There are five types of dynamic volumes: simple (uses free space from a single disk), spanned (created from free disk space that is linked together from multiple disks), striped (a volume the data of which is interleaved across two or more physical disks), mirrored (a fault-tolerant volume the data of which is duplicated on two physical disks), and RAID-5 volumes (a fault-tolerant volume the data of which is striped across an array of three or more disks).

With dynamic storage, you can perform disk and volume management without the need to restart Windows.

Limitations:

- Dynamic disks are not supported on portable computers.
- Dynamic disks are not supported on Windows XP Home Edition-based computers.

Thus, the dynamic disk is a new way of looking at hard disk configuration. Dynamic disks offer you more management flexibility without the partition limitation of basic disks. Dynamic disks can contain an unlimited number of volumes, but they cannot contain partitions or logical drives. Dynamic storage can be particularly beneficial for large-scale businesses when dealing with many physical hard disks involving complex setup.

**GPT versus MBR**

GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift restrictions of the old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to replace the outdated PC BIOS, it offers a number of crucial benefits:

- Up to 128 primary partitions for the Windows implementation (only 4 in MBR);
- The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR);
- More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition table;
- A well defined and fully self-identifying partition format (data critical to the platform operation is located in partitions, but not in un-partitioned or hidden sectors as this is the case with MBR).

**Apple Boot Camp**

Boot Camp is a special utility to help you set up a dual boot system (Mac OS X and 32-bit Windows XP/Vista) on Intel-based Macs. It enables to securely re-partition your hard disk (resize an existing HFS+ partition to create a separate partition for Windows) and then launch the installation process. With Boot Camp all the necessary drivers will be at your disposal. Moreover after Windows has been installed it will serve as a boot manager to choose what operating system to start up.

---

It is strongly recommended not to modify the hard disk configuration with Windows Disk Manager. Otherwise it may lead to unexpected consequences, right up to BSOD and inability to boot in Windows XP/Vista. Please use our program to correctly update both MBR and GPT.

---

Copyright © 1994-2010 Paragon Software Group. All rights reserved.
64-bit Support
The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end user. However that is not the case when dealing with servers processing large amounts of data with complex calculations of very large numbers. That is where 64-bit architecture comes into play.

It can boast improved scalability for business applications that enables to support more customer databases and more simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such as memory allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than a 32-bit processor. With these resources, even a very large database can be cached in memory.

Although many business applications run without problems on 32-bit systems, others have grown so complex that they use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer memory resources are available to meet memory needs. On a 64-bit server, most queries are able to perform in the buffers available to the database.

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, system-level utilities and programs that provide direct hardware access are likely to fail. Our program offers a full-fledged support of the 64-bit architecture providing fault-tolerant work for such system dependent modules as Hot Processing.

Copy Operations
Hard drive duplication nowadays is becoming highly popular among PC users. That is due to some definite advantages it can offer. First of all, many people clone hard disks just to back up data for security reasons. The present day copy utilities enable to successfully transfer all on-disk information including standard bootstrap code and other system service structures, thus maintaining the operating system’s working capability. In case of a system malfunction, the user can get the system back on track in minutes. No additional configuration is required, what is very convenient.

The second possible application is the upgrade of a hard disk to a new one. The capacity of a modern hard drive doubles every two years, thus opening up new possibilities for software developers. As a result programs become more complicated and require considerable amount of free space. One day the user realizes that there is no more free space left on the hard disk and the only way out is to upgrade. Usually that means that besides purchasing a new hard disk, the user is to face a large re-installation procedure spanning several days of tedious work. But all of this can be avoided just by copying the contents of the old hard disk to a new one proportionally resizing the partitions.

And the last but not least is the copying of hard disks for cloning purposes. It may be of great use when setting up similar computers. There is no need for a system administrator to install an operating system from scratch on every one of them. It is enough just to configure one and then clone it to the others.

Drive Partitioning
As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data until it is carved up and space is set aside for an operating system. Until recently most PCs used to have just one partition, which filled the entire hard disk and contained an OS. The situation has changed however, thanks to new cost-effective high capacity hard drives, thus opening up numerous possibilities for PC users, such as editing video, archiving music, backing up CD images, etc. Huge increase in space is great, but it poses a number of problems, most important of which are effective data organization and speed.

Large drives are always going to take longer to search than smaller volumes, and an operating system is going to have its work cut out both finding and organizing files. It is for this reason that many people decide to invest in multiple hard drives, but there is an easy solution – drive partitioning. Partitioning lets you divide a single physical drive into a number of logical drives, each of which servers as a container with its own drive letter and volume label, thus enabling the
operating system to process data more efficiently. Besides partitioning makes it possible to organize data so that it is easy to find and manage. You can set aside, for instance, 40 GB of a 160 GB hard drive for the OS, 70 GB for storing video and another 50 GB for your favorite music collections to provide transparent data storage.

It is also worth mentioning that with a hard drive properly partitioned, such routine operations as files de-frAGMENTation or consistency check will not be that annoying and time-consuming any more.

By detaching the OS from the rest of the data you can tackle one more crucial issue – in case of a system malfunction, you can get the system back on track in minutes by recovering it from a backup image located on the other partition of the hard drive.

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while browsing the Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a necessity. In order to run several OSs on a single hard drive you are to create a corresponding number of partitions to effectively delineate the boundaries of each OS.

Data Sanitization
Data security is a two-sided problem. It is to be made clear, that providing confidentiality implies not only information to be stored properly, but also be destroyed according to certain rules. The first step to protecting yourself is to know exactly which security precautions work and which do not.

Many people believe the misconception that repartitioning a disk will result in complete destruction of its contents. Actually that is not quite so. Repartitioning the drive only alters references to partitions in the Partition Table, leaving all file data intact. In fact, there are a number of programs available to successfully recover previously deleted partitions.

Formatting a drive also does not guarantee data destruction. Formatting procedure implies modification of the Master File Table (MFT) that keeps track of where file contents are stored on the disk and verification of each sector for consistency. Even a low-level format does not actually erase the file contents for good, since they can still be resurrected from their deleted state with minimal effort by using the popular today Magnetic Force Microscopy technology.

The only way to make sure that all the data has been erased from a hard drive is to overwrite all on-disk sectors with random patterns of ones and zeros. Although this sounds complex, there is an easy way to do this.

The process of deliberately, irreversibly removing or destroying the data stored on a memory device (magnetic disks, flash memory drives, etc.) is generally known as Data Sanitization. A device that has been sanitized has no usable residual data and even advanced forensic tools should not ever be able to recover it, thus providing maximum level of security.

Scheduling
The automation of operations is particularly effective when you have to repeat a sequence of actions on a regular basis. For example, developing a specific project on a day-to-day basis and having to make a backup every evening so as not to lose the valuable data, you will really appreciate, when this kind of routine operations will be carried out automatically without your participation.

Another aspect of any automation process is that it allows an optimization of your computer’s work-load. This is especially important when operations require a considerable amount of computer resources – processor time, memory and more. A number of tasks, which can decrease the performance, can be run during the night or whenever the computer has the least work-load to perform.
The program has a special tool for scheduling. You can set out a timetable for any operation and it will start at a specified time without interrupting your current activity.

**Windows Components**
In the given section you can find all the information necessary to successfully work with the Windows version of the product.

**Interface Overview**
This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program can be tackled by reading this very chapter.

**General Layout**
When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration.

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and functionality:
1. **Main Menu**
2. **Tool Bar**
3. **Virtual Operations Bar**
4. **Common Tasks Bar**
5. **Explorer Bar**
6. **Disk Map**
7. **Partition List**
8. **Properties Bar**
A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them to simplify the interface management.

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout.

**Main Menu**
The Main Menu provides access to the entire functionality of the program. The available functions are as listed below:

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tools</strong></td>
<td></td>
</tr>
<tr>
<td>View Log Files</td>
<td>View logs on the carried out operations</td>
</tr>
<tr>
<td>Send Log Files</td>
<td>Compress and send the log to the Paragon Support Team</td>
</tr>
<tr>
<td>Setup Boot Manager…</td>
<td></td>
</tr>
<tr>
<td>Recovery Media Builder…</td>
<td>Restore the system even when the current operating system cannot boot anymore</td>
</tr>
<tr>
<td>Check Recovery Disks…</td>
<td>Verify the recovery media for integrity and ability to boot from</td>
</tr>
<tr>
<td>File Transfer Wizard…</td>
<td>Transfer data from any media</td>
</tr>
<tr>
<td>Settings...</td>
<td>Edit the general settings of the program</td>
</tr>
<tr>
<td>Exit</td>
<td>Exit the program</td>
</tr>
<tr>
<td><strong>Changes</strong></td>
<td></td>
</tr>
<tr>
<td>Generate Script...</td>
<td>Generate a script for the task</td>
</tr>
<tr>
<td>Save to Scheduler...</td>
<td>Schedule pending operations</td>
</tr>
<tr>
<td>Undo <code>the last virtual operation</code></td>
<td>Cancel the last virtual operation on the List of Pending Operations</td>
</tr>
<tr>
<td>Redo <code>the last virtual operation</code></td>
<td>Cancel the last undo virtual operation on the List of Pending Operations</td>
</tr>
<tr>
<td>View Changes...</td>
<td>Display the List of Pending Operations</td>
</tr>
<tr>
<td>Apply Changes</td>
<td>Launch the real execution of virtual operations</td>
</tr>
<tr>
<td>Discard All Changes</td>
<td>Cancel all virtual operations on the List of Pending Operations</td>
</tr>
<tr>
<td>Reload Disk Info</td>
<td>Refresh the current information about disks</td>
</tr>
</tbody>
</table>

Copyright© 1994-2010 Paragon Software Group. All rights reserved.
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Express Create Partition</strong></td>
<td>Create an NTFS partition and make it ready for work</td>
</tr>
<tr>
<td><strong>Create Partition</strong></td>
<td>Create a partition of any file system</td>
</tr>
<tr>
<td><strong>Format Partition</strong></td>
<td>Format a partition of any file system</td>
</tr>
<tr>
<td><strong>Delete Partition</strong></td>
<td>Delete a partition of any file system</td>
</tr>
<tr>
<td><strong>Wipe Hard Disk or Partition</strong></td>
<td>Destroy all on-disk information or only remnants of deleted files/directories</td>
</tr>
<tr>
<td><strong>Express Resize Partitions</strong></td>
<td>Increase free space on one partition by up-taking the unused space of an adjacent partition</td>
</tr>
<tr>
<td><strong>Undelete Partitions</strong></td>
<td>Recover an accidentally deleted partition</td>
</tr>
<tr>
<td><strong>Merge Partitions</strong></td>
<td>Merge adjacent partitions of NTFS, FAT or FAT32 file systems</td>
</tr>
<tr>
<td><strong>Redistribute Free Space</strong></td>
<td>Redistribute available disk space of existed partitions</td>
</tr>
<tr>
<td><strong>Install New OS</strong></td>
<td>Make your system ready to install a new operating system</td>
</tr>
<tr>
<td><strong>Smart Backup</strong></td>
<td>Back up exactly what you need - the whole system, e-mail databases (MS Outlook, Express, Windows Mail) media files or office documents of the My Documents folder, or any other files and folders</td>
</tr>
<tr>
<td><strong>Back up Disk or Partition</strong></td>
<td>Create a sector-based archive of an entire hard disk or separate partitions</td>
</tr>
<tr>
<td><strong>Schedule Backup</strong></td>
<td>Set a timetable for a disk or partition backup</td>
</tr>
<tr>
<td><strong>Differential Backup</strong></td>
<td>Create a differential to a partition backup</td>
</tr>
<tr>
<td><strong>Create a File Complement</strong></td>
<td>Create an increment to a full partition backup</td>
</tr>
<tr>
<td><strong>Back up Files</strong></td>
<td>Create a file-based archive of your files and folders</td>
</tr>
<tr>
<td><strong>Schedule File Backup</strong></td>
<td>Set a timetable for a file backup</td>
</tr>
<tr>
<td><strong>Create a File Increment</strong></td>
<td>Create an increment to a file backup</td>
</tr>
<tr>
<td><strong>Restore</strong></td>
<td>Restore an entire hard disk, separate partitions, or files from the backup image</td>
</tr>
<tr>
<td><strong>P2P Adjust OS</strong></td>
<td>Make your system bootable on different hardware</td>
</tr>
<tr>
<td><strong>Synthetic Backup</strong></td>
<td>Change any property (merge a given differential image with its full image, split/un-split, compress/de-compress, etc.) of an existing backup image without carrying out a physical backup operation</td>
</tr>
<tr>
<td><strong>Manage Backup Capsule</strong></td>
<td>Create and manage the backup capsule</td>
</tr>
<tr>
<td><strong>Check Archive Integrity</strong></td>
<td>Perform integrity check for the required backup image</td>
</tr>
<tr>
<td><strong>Cyclic Backup</strong></td>
<td>Automate a partition backup</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>P2V Copy…</strong></td>
<td>Migrate a Win2K+ physical system to a virtual environment in the online mode.</td>
</tr>
<tr>
<td><strong>P2V Restore…</strong></td>
<td>Migrate a Win2K+ physical system backed up with a Paragon disaster recovery</td>
</tr>
<tr>
<td></td>
<td>tool to a virtual environment.</td>
</tr>
<tr>
<td><strong>P2V Adjust…</strong></td>
<td>Recover the startup ability after unsuccessful virtualization with a 3rd</td>
</tr>
<tr>
<td></td>
<td>party tool.</td>
</tr>
<tr>
<td><strong>One Button Copy Wizard</strong></td>
<td>Create a hard disk copy just by pressing one button.</td>
</tr>
<tr>
<td><strong>Copy Hard Disk…</strong></td>
<td>Create a hard disk copy.</td>
</tr>
<tr>
<td><strong>Schedule Hard Disk Copy…</strong></td>
<td>Set a timetable for a hard disk copy.</td>
</tr>
<tr>
<td><strong>Copy Partition…</strong></td>
<td>Create a partition copy.</td>
</tr>
<tr>
<td><strong>Schedule Partition Copy…</strong></td>
<td>Set a timetable for a partition copy.</td>
</tr>
</tbody>
</table>

**Hard Disk**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Back Up Hard Disk…</strong></td>
<td>Create a backup archive of the selected hard disk</td>
</tr>
<tr>
<td><strong>Burn Hard Disk to CD or DVD…</strong></td>
<td>Back up the selected hard disk and burn the resulted image to CD/DVD</td>
</tr>
<tr>
<td><strong>Restore Hard Disk…</strong></td>
<td>Restore the selected hard disk from a backup image</td>
</tr>
<tr>
<td><strong>Convert to Basic…</strong></td>
<td>Convert a dynamic MBR disk containing simple volume(s) into a basic MBR disk</td>
</tr>
<tr>
<td><strong>Convert to Basic MBR…</strong></td>
<td>Convert a basic or a dynamic GPT disk containing simple volume(s) into a basic MBR disk</td>
</tr>
<tr>
<td><strong>Update MBR</strong></td>
<td>Update MBR (Master Boot Record) of the selected hard disk</td>
</tr>
<tr>
<td><strong>Change Primary Slots…</strong></td>
<td>Modify the primary partitions enumeration for the selected hard disk</td>
</tr>
<tr>
<td><strong>Copy Hard Disk…</strong></td>
<td>Create a copy of the selected hard disk</td>
</tr>
<tr>
<td><strong>Wipe Hard Disk…</strong></td>
<td>Irreversibly destroy all on-disk information</td>
</tr>
<tr>
<td><strong>Edit/View Sectors…</strong></td>
<td>View/edit sectors of the selected hard disk</td>
</tr>
<tr>
<td><strong>Connect a Virtual Disk</strong></td>
<td>Connect a virtual disk to work with it as if it’s a physical disk</td>
</tr>
<tr>
<td><strong>Disconnect a Virtual Disk</strong></td>
<td>Disconnect a virtual disk</td>
</tr>
<tr>
<td><strong>Properties…</strong></td>
<td>Get in-depth information on the properties of selected hard disk</td>
</tr>
</tbody>
</table>

**Partition**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Partition…</strong></td>
<td>Create a partition</td>
</tr>
<tr>
<td><strong>Format Partition…</strong></td>
<td>Format a partition</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delete Partition...</td>
<td>Delete a partition</td>
</tr>
<tr>
<td>Back Up Partition...</td>
<td>Create a backup archive of the selected partition</td>
</tr>
<tr>
<td>Burn Partition to CD or DVD</td>
<td>Back up the selected partition and burn the resulted image to CD/DVD</td>
</tr>
<tr>
<td>Restore Partition...</td>
<td>Restore the selected partition from a backup image</td>
</tr>
<tr>
<td>Move/Resize...</td>
<td>Move/Resize the selected partition</td>
</tr>
<tr>
<td>Convert File System...</td>
<td>Convert file system of the selected partition</td>
</tr>
<tr>
<td>Assign Drive Letter...</td>
<td>Assign drive letter to the selected partition</td>
</tr>
<tr>
<td>Remove Drive Letter...</td>
<td>Remove drive letter for the selected partition</td>
</tr>
<tr>
<td>Hide Partition...</td>
<td>Make the selected partition unavailable for the operating system</td>
</tr>
<tr>
<td>Unhide Partition...</td>
<td>Make the selected partition available for the operating system</td>
</tr>
<tr>
<td>Mark Partition as Active</td>
<td>Make the selected partition bootable by default</td>
</tr>
<tr>
<td>Mark Partition as Inactive</td>
<td>Make the selected partition non-bootable by default</td>
</tr>
<tr>
<td>Change Cluster Size...</td>
<td>Change cluster size of the selected partition</td>
</tr>
<tr>
<td>Change Volume Label...</td>
<td>Change volume label of the selected partition</td>
</tr>
<tr>
<td>Change Serial Number...</td>
<td>Change serial number of the selected partition</td>
</tr>
<tr>
<td>Downgrade NTFS version...</td>
<td>Decrease version of the selected NTFS partition</td>
</tr>
<tr>
<td>Change Partition ID...</td>
<td>Change identifier of the selected partition</td>
</tr>
<tr>
<td>Make Partition Primary...</td>
<td>Make the selected partition Primary</td>
</tr>
<tr>
<td>Make Partition Logical...</td>
<td>Make the selected partition Logical</td>
</tr>
<tr>
<td>Wipe Partition...</td>
<td>Irreversibly destroy all on-partition information</td>
</tr>
<tr>
<td>Clear Free Space...</td>
<td>Destroy any remnants of deleted files/directories left on disk</td>
</tr>
<tr>
<td>Test Surface...</td>
<td>Test surface of the selected partition/block of free space</td>
</tr>
<tr>
<td>Check File System Integrity</td>
<td>Check the selected partition for possible file system errors</td>
</tr>
<tr>
<td>Edit/View Sectors...</td>
<td>View/edit sectors of the selected partition</td>
</tr>
<tr>
<td>Properties...</td>
<td>Get in-depth information on the properties of selected partition</td>
</tr>
<tr>
<td>View</td>
<td></td>
</tr>
<tr>
<td>Layouts</td>
<td>Manage the Launcher layout with several predefined profiles</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Manage the Tool Bar representation: show / hide standard and navigation buttons, text labels and large icons</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Display the Status Bar</td>
</tr>
<tr>
<td>Common Tasks Bar</td>
<td>Display the Common Tasks Bar</td>
</tr>
<tr>
<td>Disk Map Legend</td>
<td>Display the Disk Map legend</td>
</tr>
<tr>
<td>Properties and Commands</td>
<td>Display the Explorer Bar</td>
</tr>
<tr>
<td>Disk Map Location</td>
<td>Select whether the Disk Map will be located on the top of the main window or at the bottom</td>
</tr>
<tr>
<td>Help</td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td>Open the Help system (you can also do it by pressing F1)</td>
</tr>
<tr>
<td>About</td>
<td>Open the dialog with information about the program</td>
</tr>
</tbody>
</table>

⚠️ The Main Menu contents available at the moment may vary depending on the selected object.

**Tool Bar**
The Toolbar provides fast access to the most frequently used operations:

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image]</td>
<td>Back up a hard disk or partition</td>
</tr>
<tr>
<td>![Image]</td>
<td>Back up files</td>
</tr>
<tr>
<td>![Image]</td>
<td>Restore a disk, partition, or files</td>
</tr>
<tr>
<td>![Image]</td>
<td>Create an NTFS partition and make it ready for work</td>
</tr>
<tr>
<td>![Image]</td>
<td>Increase free space on one partition by up-taking the unused space of an adjacent partition</td>
</tr>
<tr>
<td>![Image]</td>
<td>Copy a hard disk</td>
</tr>
</tbody>
</table>
Virtual Operations Bar
The program supports previewing the resulting layout of hard disks before actually executing operations (so-called virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations immediately, but places them on the List of Pending Operations for later execution.

The Virtual Operations Bar enables to manage pending operations.

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cancel the last virtual operation on the List of Pending Operations</td>
</tr>
<tr>
<td></td>
<td>Cancel the last undo virtual operation on the List of Pending Operations</td>
</tr>
<tr>
<td></td>
<td>Display the List of Pending Operations</td>
</tr>
<tr>
<td></td>
<td>Launch the real execution of virtual operations</td>
</tr>
<tr>
<td></td>
<td>Cancel all virtual operations on the List of Pending Operations</td>
</tr>
</tbody>
</table>

Virtual mode is an effective way of protection from any troubles, since no operations will be executed until clicking the Apply button for confirmation, thus giving a second chance to weigh all pros and cons of this or that particular operation. The program politely reminds the user that there are unsaved changes by showing the following window:

Common Tasks Bar
The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program’s wizards.

The bar contains several tabs named Basic Partitioning Tasks, Advanced Partitioning Tasks, Copy Tasks, Backup Tasks, Virtualization Tasks, Tools and News and Documentation. Each of these contains a separate button bar which can be folded by clicking it.

Basic Partitioning Tasks
Starting the Express Create Partition Wizard to create an NTFS partition and make it ready for work.

Starting the Create Partition Wizard to create a partition of any file system.

Starting the Format Partition Wizard to format an existing partition to one of the file systems supported by the program.

Starting the Delete Partition Wizard to delete a partition of any file system.

Advanced Partitioning Tasks

Starting the Express Resize Partitions Wizard to redistribute free space between two adjacent partitions.

Starting the Merge Partitions Wizard to merge adjacent partitions of NTFS, FAT, FAT32 file systems.

Starting the Redistribute Free Space Wizard to redistribute available disk space of existing partitions.

Starting the Undelete Partitions Wizard to recover accidentally deleted partitions.

Starting the Wipe Wizard to help destroy all on-disk information or only remnants of deleted files/directories

Copy Tasks

Starting the One Button Copy Wizard to clone a hard disk with one click.

Starting the Copy Hard Disk Wizard to copy a hard disk.

Starting the Copy Partition Wizard to copy a partition.

Backup Tasks

Starting the Sector Backup Wizard to create an archive of a hard disk or separate partitions.

Starting the File Backup Wizard to create an archive of particular files and folders.

Starting the Manage Backup Capsule Wizard to create, resize or delete the backup capsule.

Starting the Restore Wizard to restore a hard disk, separate partition, or files from the backup image.
### Virtualization Tasks

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="P2P Adjust OS" /></td>
<td>Starting the P2P Adjust OS Wizard to make your system bootable on different hardware</td>
</tr>
<tr>
<td><img src="image" alt="P2V Copy" /></td>
<td>Starting the P2V Copy Wizard to migrate a Win2K+ physical system to a virtual environment in the online mode.</td>
</tr>
<tr>
<td><img src="image" alt="P2V Restore" /></td>
<td>Starting the P2V Restore Wizard to migrate a Win2K+ physical system backed up with a Paragon disaster recovery tool to a virtual environment.</td>
</tr>
<tr>
<td><img src="image" alt="P2V Adjust OS" /></td>
<td>Starting the P2V Adjust OS Wizard to recover the startup ability after unsuccessful virtualization with a 3rd party tool.</td>
</tr>
</tbody>
</table>

### Tools

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="File Transfer Wizard" /></td>
<td>Starting the File Transfer Wizard to transfer data from any media. Besides it provides access to Paragon backups as regular folders to browse through their contents or copy required files.</td>
</tr>
<tr>
<td><img src="image" alt="Boot Manager Wizard" /></td>
<td>Starting the Boot Manager Setup Wizard to easily manage several operating systems on one computer.</td>
</tr>
<tr>
<td><img src="image" alt="Install new OS wizard" /></td>
<td>Starting the Install New OS Wizard to install a new operating system.</td>
</tr>
</tbody>
</table>

### News and Documentation

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Hard Disk Manager™ Help" /></td>
<td>Launching the help system (you can also do it by pressing F1).</td>
</tr>
<tr>
<td><img src="image" alt="About Hard Disk Manager™" /></td>
<td>Opening the page which contains information about the program. This page will be displayed in the Explorer Bar.</td>
</tr>
<tr>
<td><img src="image" alt="Script Manual" /></td>
<td>Opening a brief review on the Paragon Scripting Language.</td>
</tr>
</tbody>
</table>

### Disk Map

The Disk Map is displayed in the [Explorer Bar](image) when the Disk View tab is selected. It is located either at the top or at the bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map Location).

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the file system of the appropriate partition.

![Disk Map](image)

Large-sized bars display the following information about physical disks:
Small-sized bars display the following information about logical disks:

- Serial number,
- Drive letter,
- Total size,
- File system.

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The program offers to choose from several types of the disk layout scaling. It’s done especially to increase the program usability. For instance, if you’ve got a high capacity hard drive containing both very large (more than 100 GB) and rather small (less than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the linear type) you won’t be able to see small partitions at all, but thing strips. On the other hand, if the proportional disk layout is critical for you, the linear type is exactly what you need.

Nevertheless there’s a compromise solution – linear scaling with the minimal limit to small partitions. So if a partition is too small it will remain readable.

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type.

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will automatically display detailed information on it.

⚠️ The drag-and-drop functionality is not available when the logarithmic type of the disk layout is selected.

**Explorer Bar**

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays reference information including:

- The help system;
- General information on the product including its name, version and a list of helpful links;
- Detailed information about disks selected on the** Disk Map**;
- List of scheduled operations;
- List of scripts;
• List of archives;
• Volume Explorer utility;
• Disk Editor utility.

According to these categories the Explorer Bar has several tabs:

• **Disk View**, which offers the user the following options:
  - *Partition List* to get a clear-cut picture of the current state of the system hard disks/partitions;
  - *Disk Editor* to view/edit sectors of the selected partition/hard disk;
  - *Volume Explorer* to browse and export contents of the selected partition/hard disk;
  - *Properties* to view detailed information on the selected partition/hard disk in the bright graphical form.

You can switch between these three components by clicking tabs on the left side of the Explorer Bar.

• **Scheduled Tasks**, which gives the user the possibility of browsing and editing scheduled operations and the program scripts.

• **Archives**, which enables to manage the Archive Database.

• **Help**, which contains the program help and general information on the product.

You can access the desired information by clicking on the appropriate tab.

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the company’s website to look through important technical notes or download the latest updates without having to close the program.

The program help is also HTML-oriented. You can read it and follow external links from to get additional information.
To easily navigate through browsed pages, the program provides the following functionality:

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Left Arrow]</td>
<td>Return to the previously browsed page</td>
</tr>
<tr>
<td>![Right Arrow]</td>
<td>Open the next browsed page</td>
</tr>
<tr>
<td>![Stop]</td>
<td>Stop loading the current page</td>
</tr>
<tr>
<td>![Refresh]</td>
<td>Refresh the contents of the current page</td>
</tr>
</tbody>
</table>

**Partition List**

The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state of the system hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the possibility to call the context-sensitive popup menu with available operations. Besides, the program provides detailed information on all hard disks/partitions found in the system including the following properties:

- Name,
- Volume label (if exists),
- Partition type (Primary/Extended /Logical),
- File system type,
- Size,
- Amount of used and unused (free) space,
- Start/End cylinder,
- Start/End head,
- Start/End sector
- Free size in sectors/bytes
- Active/Inactive attribute
- Hidden/Unhidden attribute

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of the panel.

By marking a checkbox opposite the required item you can choose whether to display it or not. Besides, you can change its order by pressing the Move up or Move down buttons.

If you don’t need the Disk Map, please click the shown below icon to disable it:
Properties Bar
The Properties Bar provides information on the selected at the moment partition/hard disk:

For a hard disk

- Model,
- Serial number,
- Type of hard disk (basic or dynamic),
- Total size (in GB),
- Information on geometry of the disk (amount of sectors per track, heads and cylinders).

For a partition

- Drive letter assigned to the disk,
- Volume label (if available),
- Type of the logical disk,
- File system (represented by the color of the graph and the selected bar),
- Total size, used space and free space (in GB or MB).

Besides you can modify practically any partition property by clicking on the required value.

Legend Bar
The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the Explorer Bar.

The program distinguishes between the following types of known file systems:

- FAT16/32,
- NTFS,
- Linux Ext2/3/4,
- Linux ReiserFS,
- Apple HFS.

Status Bar
This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to.

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar.
Settings Overview
The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections, which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By selecting a section from the list, you can open a set of options.

⚠️ To get a detailed description to any setting, control, or field of the program just click the hint button and then the object you need.

General Options

This section contains a set of general options that will be taken into account during any operation carried out with the program:

- **Enable data loss protection.** Mark the checkbox to make the program work in the fail-safe mode (also referred to as the data-loss protection mode), which ensures reliability for operations by maintaining a special journal. In case of a hardware malfunction, power outage or an OS failure happened in the middle of a data-sensitive operation (resize, move, merge, redistribute, change cluster size, etc.), the program will ask to insert the bootable recovery media and automatically complete the interrupted operation, thus reviving the corrupted partition.

⚠️ It is strongly recommended to enable this option.
Backup Image Options

This section contains a set of options that will be taken into account during backup/restore operations:

- **Control archive integrity.** Mark the checkbox to guarantee that all backup images created with the program are 100 percent flawless. If you decided not to control the archive integrity, the backup operation would take about 3-5% less time.

- **Set image file names automatically.** Mark the checkbox to make the program automatically set a file name for every volume of a complex backup image. Otherwise you will need to do it manually during the backup operation.

- **Compression level.** From the pull-down list you can select the desired compression level for backup images that will be used by default.

- **Enable image splitting.** Mark the checkbox to automatically split every backup image to volumes of a particular size.

  **Warning:** Splitting images enables to tackle problems caused by a maximum file size limitation of some file systems.

- **Maximum split size.** With the spinner control you can specify a maximum size for backup volumes.
Partitioning Options

This section contains a set of options that will be taken into account during partitioning operations:

- **Enable 64 KB cluster size for FAT16.** Mark the checkbox to enable 64KB clusters for FAT16 partitions. Thus you will be able to create FAT16 partitions up to 4GB in size.

  Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, FAT16 partitions larger than 2GB are not reliably accessible under these operating systems.

- **Request confirmation before partition deletion.** Mark the checkbox to activate an additional security mechanism. Thus when going to delete a partition you will be automatically requested to enter its label.

- **Request confirmation when converting FAT16 to FAT32.** Mark the checkbox to automatically request confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition operation involving an extra upsizing.
This section contains a set of options that will be taken into account during copy and backup operations:

- **HDD raw processing.** Mark the checkbox to copy/back up a hard disk in the sector-by-sector mode, thus ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will be processed as well). This can help to avoid problems with hidden data created by certain applications or the system administrator. However, it will take more time to accomplish the operation.

- **Partition raw processing.** Mark the checkbox to copy a partition in the sector-by-sector mode to successfully process unknown file systems. However it is not recommended to enable this option when working with supported file systems as it takes more time to accomplish the operation.

- **Perform incremental copy.** Mark the checkbox to only copy changes on the hard disk from the moment of the last copy operation. The program will perform comparison between a previous copy of the hard disk and its current state. Only sectors that are different will be updated, thus considerably decreasing the amount of data to write.

- **Skip OS auxiliary files.** Mark the checkbox to skip OS auxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus reducing the operation time and the resulted size of the backup image.

- **Skip archive files stored in archive library.** Mark the checkbox to skip backup images registered in the archive database, thus reducing the operation time and the resulted size of the backup image.

⚠️ By clicking the link at the bottom of the window you can jump to the Copy/Backup Exclude Options.
This section contains a set of options that will be taken into account during CD/DVD burn operations:

- **Burn every CD/DVD to the end.** By default, the program does not create ISO 9660 compliant burning sessions, as it processes data on-the-fly and can only estimate the resulted session size. That’s why no third party tool will get access to the recorded data. To tackle the issue, mark the checkbox to make the program create a standard Disk-at-Once session. It may slow down the burning process, as every CD/DVD will be recorded up to the end, no matter how much actual information to contain.

- **Recording speed.** The user may define how fast a CD/DVD will be recorded (minimum, normal and maximum). Besides there is an automatic mode when the program will set the most appropriate speed for every CD/DVD.

- **Bootable ISO image.** That’s the image to be placed together with the backup data. By default, the program offers its own bootable ISO image, which contains a Linux/DOS recovery environment. However, the user is free to use any bootable ISO image.

- **CD/DVD boot capability.** The program enables to choose whether any recorded CD/DVD will be bootable, or only the first one for a session, or without that function at all.

- **Folder where the ISO image is to be placed.** When the user decides not to physically burn a CD/DVD, but create an ISO image file, this very folder will be used to contain these images.
Hot Processing Options

In this section you may configure the hot processing mode:

- **Enable hot processing.** Mark the checkbox to enable the so called hot data processing mode that is specially designed to process data without restarting your operating system.

- **Hot processing technology.** From the pull-down list you can select the required hot processing technology.

- **Always use hot processing.** Select the option to process partitions without making them locked. Thus you will be able to keep working with them as usual.

- **Use hot processing only when partition is locked.** Select the option to use the hot processing only when partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that once you start any operation on a partition in this mode, it will automatically be locked by the program, thus you won't be able to keep working with it as usual.

- **Hot processing temporary drive.** Here you can select a disk drive that will be used to store the temporary hot backup data (by default – C:).

- **Attempts to start VSS.** Here you can set how many attempts to start Microsoft VSS the program is to do before automatically rebooting the system and accomplishing the operation in a special boot-up mode.

- **Timeout between attempts (in seconds).** Here you can set a time period between different attempts to start Microsoft VSS.

- **Switch between hot processing technologies.** Mark the checkbox to automatically switch between Paragon Hot Processing and Microsoft VSS if one of them is unavailable at the moment.
Run during Backup Options

In this section you can specify external applications to execute at various phases of the backup process. It can be particularly useful when imaging systems with high availability requirements (MS SQL, MS Exchange, etc.), since it enables to create a consistent snapshot even as the data is currently modified. The point is to provide a coherent state of all open files and databases involved in a backup, taking into account that applications may still keep writing to disks.

Actually the backup process consists of two phases: the preparation phase (snapshot) and the data-copying phase. There are three points of the backup when external commands/programs can be launched:

- **Execute at the beginning of the backup process before taking a snapshot.** Here you can specify an executable file that will help you to prepare running applications for taking a snapshot. It may contain specific commands/programs to delete unnecessary files, suspend services, flush transactions or caches, etc. Everything depends on the used applications.

- **Execute after taking a snapshot.** Here you can specify an executable file that will run just after taking a snapshot. It may contain specific commands/programs, e.g. to resume the previously suspended services, etc. Everything depends on the used applications.

- **Execute after finishing the backup process.** Here you can specify an executable file that will run after the backup process has been accomplished. It may include commands/programs that will move the backup image to a particular location, etc.
By clicking the link at the bottom of the window you can jump to the **Hot Processing Options**.

By clicking the Browse button you can get into the browser-like window to choose an executable file.

The program provides the ability to work with three types of executable files (.exe, .bat, .cmd). It is up to the user to write batch files to safely prepare applications for backup. There are some certain general requirements for that:

- All programs and commands must execute sequentially and finish before the .bat file completes its work.

- It is recommended to use external commands/programs in the following format - `Start/wait program.exe`. The `wait` option will help to start an application and wait until it completes its work. This will guarantee that all included commands/programs complete their execution before the batch file does.

This function is only available when the Hot Processing mode is enabled.

The program enables to set parameters for an executable file directly from the line. However, if the file path contains word gaps it is necessary to enclose it in quotes in order to make the program distinguish between the path and the used parameters.

By clicking the link at the bottom of the window you can jump to the **Hot Processing Options**.
This section contains a set of options that will be taken into account during the Send log files and Send e-mail notification operations:

- **Outgoing mail server (SMTP).** To send messages by using the built-in mail client, it is necessary to have access to a computer running an SMTP (Simple Mail Transfer Protocol) server. All outgoing messages are first sent to the SMTP server, which in its turn delivers them to the required recipients. The address may be represented as a traditional Internet host name (e.g.: mail.com) or as an IP numeric address (e.g. xxx.xxx.xxx.xx).

- **User e-mail address.** Specify an e-mail address that has been assigned by the Internet Service Provider or organization's e-mail administrator.

- **My outgoing server requires authentication.** Activate the option to allow the program to make authentication on the server before sending messages.
  - User name. Enter the name that will be used to log in to the e-mail account.
  - Password. Enter the password that will be used to access the mail server.

- **Send e-mail notification on apply.** Specify an e-mail to send notifications on the carried out operations.
  - Send mail in HTML format. Activate the option to create messages in the HTML format instead of plain text.
  - Send complete report after applying operations. Activate the option to create an in-depth report on the carried out operations and send it after performing the last operation.
- **Send graphical view of the disk sub-system before and after apply.** Activate the option to allow the program to attach two pictures of the disk layout made before and after the operation is completed.

⚠️ By clicking the link at the bottom of the window you can jump to the [Operation Dependency Options](#).

### Operation Dependency Options

![Operation Dependency Options](image)

This section contains a set of options that will be taken into account when the Send e-mail notification on apply function is enabled. By marking/unmarking a checkbox opposite the required operation you can choose whether to receive an e-mail notification on its completion or not.

⚠️ **You won’t be notified if an operation requires the system restart.**
In this section you may configure the virtual mode:

- **Allow virtual mode.** Mark the checkbox to enable the virtual mode. It is an effective way of protection from any troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all pros and cons of this or that particular operation.

  **We strongly recommend you to enable this mode.**

- **Close progress dialog automatically.** Mark the checkbox to automatically close the progress dialog after accomplishing operations.
File System Conversion Options

This section contains a set of options that will be taken into account when converting FAT and NTFS file systems. By default, the program takes locale (regional) settings from the system. Problems might occur however because of different standards for file names and file time stamps (Created, Modified and Last Access Time) of NTFS and FATxx file systems.

To tackle problems of that kind you can manually set:

- **Time zone** to use during the convert operation. NTFS keeps file timestamps in GMT (Greenwich Mean Time) while FAT uses a fixed local date and time. The program takes proper account of these differences and enables to adjust timestamp values.

  An incorrectly chosen time zone might lead to inability to launch certain software.

- **Language for file names** to use during the convert operation. NTFS stores file names in Unicode while FAT/FAT32 uses ANSI to save short file names (also called the DOS aliases). The codepage information is required for the correct conversion of non-English file names from Unicode to ANSI and vice versa.

  An incorrectly chosen codepage will certainly result in corruption of non-English file names.

- **Request confirmation of settings before NTFS < - > FAT/FAT32 conversion.** Mark the checkbox to automatically display the local settings dialog to check and modify (if necessary) the default parameters before launching the convert file system operation.
Copy/Backup Exclude Options

In this section the program enables to specify what data should be automatically ignored during copy and sector-based backup operations. You can filter certain files or folders either by the manual selection or by creating masks, what is more preferable. Thus you will be able to effectively manage contents of your backup images or partition/hard disk copies.

By default, there are no available filters. To create a filter, please click the Add Category... button.

In the opened dialog the program allows the user to define the following parameters:

- **Name.** Give to the filter any name you like, but try to use an informative one;

- **Filter.** Press the Browse button to select files or folders you would like to be excluded or specify a filter mask by using * or ? wildcards;

- **Description.** Add a short description to the filter not to miss it up later.
Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox opposite its name you can choose whether to use it or not.

⚠️ By clicking the link at the bottom of the window you can jump to the General Copy and Backup Options.

**File Backup Exclude Options**

In this section you can find a lot of ready-made exclude filters to effectively control contents of your file-based backup images. Please note, by selecting certain filters you specify what data will be ignored during file-based backup operations, thus you specify the data you’d like not to be added to the resulted archives.

Anyway you’ve got the option to create your own filter by clicking the Add category... button.

In the opened dialog the program allows the user to define the following parameters:

- **Name.** Give to the filter any name you like, but try to use an informative one;
- **Filter.** Press the Browse button to select files or folders you would like to be excluded or specify a filter mask by using * or ? wildcards;

- **Description.** Add a short description to the filter not to miss it up later.

Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox opposite its name you can choose whether to use it or not.

### File Backup Include Options

In this section you can find a lot of ready-made include filters to effectively control contents of your file-based backup images. Please note, by selecting certain filters you specify what data will be processed during file-based backup operations, thus you automatically ignore files that do not match, so they won’t be added to the resulted archives.

Anyway you’ve got the option to create your own filter by clicking the Add category... button.

In the opened dialog the program allows the user to define the following parameters:
- **Name.** Give to the filter any name you like, but try to use an informative one;

- **Filter.** Press the Browse button to select files or folders you would like to be excluded or specify a filter mask by using * or ? wildcards;

- **Description.** Add a short description to the filter not to miss it up later.

Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox opposite its name you can choose whether to use it or not.

**Log Files Options**

![Log Files Options](image)

In this section you can specify a storage life span for the `stubact.log file`:

- **Infinite** not to empty the file ever;

- **Minimal** to have the file emptied all the time;

- **Custom** to set a certain storage life span for the file. Please note, once the defined period has been expired, the file will be emptied.

---

**⚠️ We strongly recommend you not to choose the Minimal option, as in case of having problems with the program, our Support Team won't be able to study operation logs, thus help you out.**

---

Copyright © 1994-2010 Paragon Software Group. All rights reserved.
Wipe Options

Here you can set a specific data erasure algorithm that will be used by default during wipe operations.

⚠️ The current version of the program provides support of one military standard, i.e. US DoD 5220.22-M.

Getting Information on Disks and Backup Images
The program provides some helpful tools to get information on the properties of disks and peculiarities of existing backup images.

Viewing Disk Properties
The main tool to view in-depth information on the properties of hard disks is the Disk Map. It represents the actual state of the computer’s hard disks.

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. The small-sized bars represent logical disks (partitions). When you select a large-sized bar, the Explorer Bar displays information about the disk in a bright, graphical form.
The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you may see a table, which contains the following information:

- Type of hard disk (basic or dynamic),
- Total size (in GB),
- Information on geometry of the disk (amount of sectors per track, heads and cylinders).

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard will be started. All default values for the operation parameters will correspond to the disk’s settings. The list of wizards contains a detailed description of tasks that can be performed by the wizard. This nullifies the possibility of selecting the wrong wizard.

When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information on it as well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in accordance with the volume ratio of the used space to the free space (the light colored sector). The table on the right will contain the following information:
• Volume label (if available),
• Type of the logical disk,
• File system (represented by the color of the graph and the selected bar),
• Total size, used space and free space (in GB or MB).

Below there is a list of wizards, which may be called for this disk. All default values of parameters will correspond to the disk settings.

Viewing Image Properties
General information on backup archives can be obtained either with the help of the Restore Wizard or the Archive Database:

Using the Restore Wizard
There are several ways to launch the Restore Wizard:

• In the Main menu: select Wizards > Restore...
• In Common Tasks bar: click the Restore item of the Wizards menu
• Select a hard disk/partition and then click the Restore an image of the entire disk/Restore the logical disk from an image link on the Explorer Bar page.

At first, the wizard displays the Welcome page – simply click the Next button at the foot of the dialog window.

The next page refers to Browse for Archive. By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive Database (if any).
To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description, including:

- Information on a type of the archive contents (whether it is sector-based or file-based),
- Whether the archive is compressed or not,
- Whether the archive is password protected or not,
- The date, when the archive was created.

In addition, there are some special graphical flags to indicate crucial properties:

<table>
<thead>
<tr>
<th>FLAG</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐</td>
<td>Disk archive</td>
</tr>
<tr>
<td>☐</td>
<td>Partition archive</td>
</tr>
<tr>
<td>☐</td>
<td>File archive</td>
</tr>
<tr>
<td>☐</td>
<td>MBR archive</td>
</tr>
<tr>
<td>☐</td>
<td>System archive</td>
</tr>
<tr>
<td>☐</td>
<td>Encrypted archive</td>
</tr>
<tr>
<td>☐</td>
<td>Compressed archive</td>
</tr>
<tr>
<td>☐</td>
<td>Complex archive</td>
</tr>
<tr>
<td>☐</td>
<td>Filtered archive</td>
</tr>
<tr>
<td>☐</td>
<td>Differential archive</td>
</tr>
<tr>
<td>☐</td>
<td>Incremental archive</td>
</tr>
<tr>
<td>☐</td>
<td>File increment to a partition archive</td>
</tr>
</tbody>
</table>

To easily manage images in the Archive Database, the program provides the following functionality:

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐</td>
<td>Refresh the contents of the database</td>
</tr>
<tr>
<td>☐</td>
<td>Show only existing archives</td>
</tr>
<tr>
<td>☐</td>
<td>Add the selected archive to the database</td>
</tr>
<tr>
<td>☐</td>
<td>Delete the selected archive from the database</td>
</tr>
</tbody>
</table>
Besides you may filter backup archives to decide whether to show only file, partition or hard disk archives. To do that, please select the required filter in the left top corner of the page.

By clicking the **Switch to File View** link, you can find the required image in the browser-like window.

The section below (i.e. Archive File Details) displays a short description of the selected image, including:

- Information on a type of the archive contents (whether it is sector-based or file-based),
- Whether the archive is compressed or not,
- Whether the archive is password protected or not,
- The date, when the archive was created.

Moreover, on this page you've got the possibility to create new folders, delete existing files/folders or map network drives by clicking the appropriate buttons.
The next page (i.e. What to restore) displays detailed information about the contents of the archive.

If you want to restore the image contents, click the Next button. In order to cancel, click the Cancel button.

*Using the Archive Database*

To open the Archive Database, click the appropriate tab in the Explorer Bar. The database window can be conditionally subdivided into several sections that differ in their purpose and functionality:
1. **Explorer Bar** that displays properties of the selected image.

2. **Volume Explorer** that enables to access the selected image as a regular folder to explorer its contents or to retrieve certain files.

3. **Archive List** that displays a list of images contained in the Archive Database (if any). Besides the program provides all the necessary functionality to manage backup images in the database (add, delete, mount, refresh, etc.)

---

**Data Backup and Rescue**

In this chapter you will find all the information necessary to establish a reliable data protection system.

**Creating Backup Images**

We have already mentioned that the most prevalent way to protect valuable data is to create backup copies (backup images in terms of the program) of it. Depending on a type of information you need to protect and the way this information should be processed, the program offers a number of handy backup wizards and dialogs.
Wizard Work Algorithm

To make your job with the program as easy and convenient as possible, all backup wizards share similar work algorithm. So let us just take as an example the Sector Backup Wizard to describe it in detail.

By going through steps of the wizard, you configure all the necessary settings to launch the backup operation. To minimize the possibility of making any mistake, the wizard provides auxiliary information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.

Startup

There are several ways to start the Sector Backup Wizard:

Express Launcher

- Click the Backup and Recovery button and then select Backup.

Launcher

- In the Main Menu: select Wizards > Back up a Disk or Partition...
- On the Common Tasks Bar: click the Back up a Disk or Partition item of the Wizards menu.
- In the Toolbar: click the Back up a Disk or Partition button.

Setup

The wizard offers the following steps to accomplish the backup operation:

- **The object to back up.** You can back up either an entire disk or separate partitions of the disk (primary, extended or logical). In case of backing up an entire disk, you’ve got the possibility to include into the image such disk elements as the Master Boot Record (MBR) and the first track of the hard disk. This can be very helpful for serious disk recovery procedures.

  ![Disk Structure Diagram]

- **Backup destination.** The wizard allows saving backup archives to local or network drives, to physical partitions (without drive letters assigned), to FTP Servers, the Backup Capsule or burning them to CD/DVDs. You need to select a destination, taking the estimated archive size and available space on the backup destination into account.

  ![Backup Destination Options]

Copyright © 1994-2010 Paragon Software Group. All rights reserved.
• **Name and location of the resulted image.** Provide a file name for the new image and its exact location. The program automatically offers an easy to understand name containing the date and the time of the archive creation, which can anyway be modified.

![](image)

The program automatically calculates size of the future archive and informs the user about space available on the selected destination.

- **Archive Comment.** You can add some additional description to the archive that will later help to distinguish it from the others.

![](image)

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). To activate the advance mode, you need to mark the appropriate option on the second page of the wizard. When it is marked, the next page enables to define:

- Whether the archive integrity will be controlled.

  Checking archive integrity enables to guarantee that all backup images created with the program are 100 percent flawless. Nevertheless if you decided not to control the archive integrity, the backup operation would take about 3-5% less time.

- Whether image file names will be set automatically in complex archives.

- Compression level for the backup image (including the No compression variant).

- Whether the archive will be split (if yes, you can set the maximum size for the archive files).

  Splitting images enables to tackle issues caused by a file size limitation of some file systems.

- Whether the archive will be protected by password.
- Whether the selected disk (or the selected partition) will be copied in the sector-to-sector mode (including unused sectors as well).
- Whether the OS auxiliary files (pagefile.sys, hyberfil.sys) will be included in the backup image.
- Whether backup images stored in the Archive Database will be processed during the backup operation.

Skipping backups of the Archive Database may considerably decrease the resulted image file and time to carry out the operation.

- Recording speed when the user wants to burn the backup image onto CD/DVDs.
- ISO image folder where the archive that is to be recorded on a disc, is placed.
- Whether the operation will be performed without rebooting the system. The program needs to reboot the system in order to have exclusive access to processing data. In a Windows environment this is difficult to achieve because even when all the other applications are closed, the system service programs are still running. However, there is a way to avoid rebooting. The mode of processing the backup operation without rebooting is named Hot Processing. You can also define specific parameters for the Hot Processing mode.
- The data to be automatically excluded from the resulted backup.

By default the program will take into account exclude filters set in the Settings dialog.

Result
After the backup operation is completed you receive an image of the selected disk (or the selected partition). This image is placed into the specified destination, its features defined by the wizard.

Dialog Work Algorithm
All backup dialogs share similar work algorithm as well. Unlike wizards, settings of a backup dialog concentrate on a single page. That’s why it cannot boast high level of the self-descriptiveness. Anyway with the context sensitive hint system you can get an in-depth description to any setting, control, or field of the dialog just by clicking the hint button and then the object you need.

We recommend the program’s dialogs for experienced users mostly.

So let us just take as an example the Partition Backup Dialog to describe its work algorithm.

Startup
In order to start the operation you should take the following steps:

1. Select a partition on the Disk Map;
2. Call the Partition Backup Dialog to set up the operation. There are several ways to do it:
   - Select in the Main menu: Partition > Back Up Partition.
   - Call the popup menu for the selected partition (right click of the mouse button) then select the menu item: Back Up Partition...
Setup
Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Backup button to confirm the operation.

- **Archive Name.** The program automatically offers an easy to understand name containing the date and the time of the archive creation, which can anyway be modified.

- **Archive Description.** You can add some additional description to the archive that will later help to distinguish it from the others.

- **Compression Level.** From the pull-down list you can select the desired compression level for the backup image (including the No compression variant).

- **Archive Destination.** Here you can manually enter a path where to place the future backup image to or press the Browse button to find the required location.

- **Password Protection.** By setting a password you can protect contents of the archive against unauthorized access.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). To activate the advance mode, you need to click the More options button at the foot of the dialog page, so you will be able to define:
• Whether the operation will be performed without rebooting the system. The program needs to reboot the system in order to have exclusive access to processing data. In a Windows environment this is difficult to achieve because even when all the other applications are closed, the system service programs are still running. However, there is a way to avoid rebooting. The mode of processing the backup operation without rebooting is named Hot Processing. You can also define specific parameters for the Hot Processing mode.

• Whether the archive will be split (if yes, you can set the maximum size for the archive files).

**Splitting images enables to tackle problems caused by a maximum file size limitation of some file systems.**

• Whether image file names will be set automatically in complex archives.

• Whether the OS auxiliary files (pagefile.sys, hyberfil.sys) will be included in the backup image.

• Whether the selected partition will be copied in the sector-to-sector mode (including unused sectors as well).

• Whether backup images stored in the Archive Database will be processed during the backup operation.

**Skipping backups of the Archive Database may considerably decrease the resulted image file and time to carry out the operation.**

By default the program will take into account exclude filters set in the Settings dialog. You've got no option to change them directly from this dialog.

Result
After the backup operation is completed you receive an image of the selected partition. This image is placed into the specified destination, its features defined by the dialog.

Available operation scenarios:

• **Back up a hard disk or partition to the Backup Capsule**

• **Back up a hard disk or partition to external media (CD/DVD)**

• **Back up a hard disk or partition to a network drive**

• **Back up a hard disk or partition to an FTP server**

• **Back up a dual boot Mac to an external USB drive**

• **Back up files to a local mounted/unmounted (without drive letter assigned) partition**

• **Creating a differential to a full partition backup**

• **Creating an increment to a full partition backup**

• **Creating an increment to a full file backup**

• **Back up with Smart Backup Wizard**

• **Creating a cyclic partition backup**
• Merging a full partition backup with one of its differentials

Restoring System and Data
The program includes a convenient and reliable restore wizard. With its help you can restore all types of backup images created with the program. It provides easy to understand instructions to configure and perform all the necessary settings. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.

Startup
There are several ways to start the Restore Wizard:

Express Launcher

• Click the Backup and Recovery button and then select Restore.

Launcher

• In the Main Menu: select Wizards > Restore...

• On the Common Tasks Bar: click the Restore item of the Wizards menu.

• In the Toolbar: click the Restore Wizard button.

Setup
The wizard offers the following steps to accomplish the restore operation:

• A backup image to be restored. The Browse for Archive page enables to find a backup image you need.

  By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive Database (if any).

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description.

To know more on the subject, please consult the Viewing Image Properties chapter.

By clicking the Switch to File View link, you can find the required image in the browser-like window. The section below (i.e. Archive File Details) will also display a short description of the selected image.
Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or map network drives by clicking the appropriate buttons.

⚠️ To know more on the subject, please consult the Viewing Image Properties chapter.

File Backup Restore

- **Data to restore.** You’ve got the option to restore not only the entire archive, but separate items of it (the so called selective restore functionality) by marking checkboxes next to the data items you need.

- **A place to restore.** From the pull-down list you can choose whether to restore contents of the backup image to its original location or specify some other one.
Besides if you select the Original location option, you can additionally define whether to replace already existing files during the restore operation (good for recovering presumably corrupted files) or leave them intact (good for recovering accidentally deleted files).

**Sector Backup Restore**

- **Data to restore.** You’ve got the option to restore not only the entire archive, but separate items of it (the so-called selective restore functionality) by marking checkboxes next to the data items you need.

If you select separate files or folders to restore, the wizard will continue working as though you’ve got to do with a file backup.

- **A place to restore.** Selecting the destination, please note - all contents on the disk selected for restoring purposes will be deleted during the operation.

To help you get a clear-cut picture of the operation outcome, the program allows inspecting the resulted disk layout.

**Restoring Partition:**

- **Size of the restored volume and free space before and after it on the disk.**
• **Drive letter assignment after restore.** The pull-down list contains vacant drive letters that can be associated with the restored partition.

### Restoring Hard Disk:

• **Copy data and resize partitions proportionally.** If this option is activated, the program proportionally changes the size of partitions keeping their relative order intact. The option can be useful when restoring to a larger hard disk.

• **Perform surface test.** Define whether the surface test will be accomplished during the operation or not.

---

⚠️ **All contents on the disk selected for restoring purposes will be deleted during the operation.**

---

### Result

The wizard will restore the archived data, and make it available to use in the operating system.

⚠️ **To make a Win2K+ operating system bootable on different hardware, please additionally complete the P2P Adjust OS Wizard.**

### Available operation scenarios:

- **Restoring a hard disk from the bootable Backup Capsule**
- **Restoring a system partition from external media (CD/DVD)**
- **Restoring a system partition from a network drive**
- **Restoring a system partition from a local drive**
- **Restoring a dual boot Mac from an external USB drive**

---

Copyright © 1994-2010 Paragon Software Group. All rights reserved.
Copy Tasks
In this chapter you will find all the information necessary to make a copy of a hard disk or a separate partition.

Cloning Hard Disks
You can clone a hard disk of any file system. During the hard disk copying process, the program moves controlling records of used partitioning scheme, the bootstrap code and on-disk partitions. That’s why this operation cannot be substituted by simply copying all on-disk partitions.

The program offers two wizards that can help to clone a hard disk, i.e. the Copy Hard Disk Wizard and the One Button Copy Wizard. Both wizards provide nearly identical functionality, but different in the work concept.

Copy Hard Disk Wizard
The Copy Hard Disk Wizard is a traditional-like wizard. By going through its steps, you configure all the necessary settings to launch the copy operation. To minimize the possibility of making any mistake, the wizard provides auxiliary information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.

⚠️ You need at least two hard disks to carry out this operation.

Startup
There are several ways to start the Copy Hard Disk Wizard:

Express Launcher

- Click the Copying and Migration button and then select Hard Disk Migration.

Launcher

- In the Main Menu: select Wizards > Copy Hard Disk...
- On the Common Tasks Bar: click the Copy Hard Disk item of the Wizards menu.
- In the Toolbar: click the Copy Hard Disk button.

Setup
The wizard offers the following steps to accomplish the copy hard disk operation:

- The hard disk to copy. Select a hard disk you want to copy.
The target hard disk. Select a hard disk (if several) where all data of the source disk will be copied to.

Copy parameters. The wizard enables to specify the following options:

Copy options

- **HDD raw copy** to copy the hard disk in the sector-by-sector mode, thus ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will be processed as well). This can help to avoid problems with hidden data created by certain applications or the system administrator. However, it will take more time to accomplish the operation.

- **Partition raw copy** to copy the on-disk partitions in the sector-by-sector mode to successfully process unknown file systems. However it is not recommended to enable this option when working with supported file systems as it takes more time to accomplish the operation.

- **Perform incremental copy** to only copy changes on the hard disk from the moment of the last copy operation. The program will perform comparison between a previous copy of the hard disk and its current state. Only sectors that are different will be updated, thus considerably decreasing the amount of data to write.
- **Change masks for files to exclude from copy** to manage contents of the resulted duplicate. By default the program will take into account exclude filters set in the Settings dialog. If you need to change them, please mark the checkbox and specify additional filters on the next page of the wizard.

**Resize options**

- **Remove free blocks between partitions** not to keep blocks of free space between partitions on the targeted hard disk.

- **Copy data and resize partitions proportionally** to make the program proportionally change the size of partitions keeping their relative order intact. The option can be useful when upgrading the hard disk to a larger one.

**Verification options**

This section allows you to define whether the **Surface** and/or the **Writing verification** tests will be accomplished during the operation.

**Result**

After the operation is completed, you receive a fully functional duplicate of the existing hard disk.

---

To make a Win2K+ operating system bootable on different hardware, please additionally complete the [P2P Adjust OS Wizard](#).

**Available operation scenarios:**

- Migrating system to another hard disk (Clone HDD)

**One Button Copy Wizard**

The One Button Copy Wizard is a new approach of accomplishing such a technically complicated operation as cloning of a hard disk. In fact with its help you can do it just by pressing one button.

**Restrictions**

So to successfully accomplish the operation your system should meet the following requirements:

- At least two hard disks, one of which should contain data and the other is empty

- The destination hard disk should have enough space to take contents of at least first partition of the source disk

**Startup**

There are several ways to start the One Button Copy Wizard:

**Launcher**

- In the Main Menu: select Wizards > One Button Copy Wizard...

- On the Common Tasks Bar: click the One Button Copy Wizard item of the Wizards menu.

**Setup**

If your system meets the mentioned above requirements, the wizard will automatically accomplish the copy operation after a ten-second pause.
There are a number of options you can modify:

- **HDD raw copy** to copy the hard disk in the sector-by-sector mode, thus ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will be processed as well). This can help to avoid problems with hidden data created by certain applications or the system administrator. However, it will take more time to accomplish the operation.

- **Partition raw copy** to copy the on-disk partitions in the sector-by-sector mode to successfully process unknown file systems. However it is not recommended to enable this option when working with supported file systems as it takes more time to accomplish the operation.

- **Perform incremental copy** to only copy changes on the hard disk from the moment of the last copy operation. The program will perform comparison between a previous copy of the hard disk and its current state. Only sectors that are different will be updated, thus considerably decreasing the amount of data to write.

- **Change masks for files to exclude from copy** to manage contents of the resulted duplicate. By default the program will take into account exclude filters set in the Settings dialog. If you need to change them, please mark the checkbox and specify additional filters on the next page of the wizard.

- **Copy without free space blocks** to arrange partitions one after another.

- **Resize proportionally** to proportionally change the size of partitions keeping their relative order intact.

To do that, press the Pause button, to continue execution press Start. To interrupt the operation, press the Cancel button.
Result
After the operation is completed, you receive a fully functional duplicate of the existing hard disk.

To make a Win2K+ operating system bootable on different hardware, please additionally complete the P2P Adjust OS Wizard.

**Cloning Partitions**
You can duplicate partitions to protect oneself from downtime in case of a system malfunction or for cloning sample partitions. The program enables to duplicate all partition data including files, the exact structure of directories and file system metadata (location of files, security information, access quotas, etc.).

The Copy Partition Wizard will help you copy a partition of any file system. To minimize the possibility of making any mistake, the wizard provides auxiliary information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.

**Startup**
There are several ways to start the Copy Partition Wizard:

**Express Launcher**

- Click the **Copying and Migration** button and then select **Copy Partition**.

**Launcher**

- In the Main Menu: select **Wizards > Copy Partition**...
- On the Common Tasks Bar: click the **Copy Partition** item of the Wizards menu.
- In the Toolbar: click the **Copy Partition** button.

**Setup**
The wizard offers the following steps to accomplish the copy partition operation:

- **The partition to copy.** Select a partition you want to copy.

- **Destination disk.** Select a hard disk with enough unallocated space to perform the operation.
The program enables to copy a partition to a block of free space, which is smaller than the partition itself, taking into account only actual amount of data.

- **Copy parameters.** The wizard enables to specify the following options:

  - **Partition size.** Define the size (in Mb) of the copied partition.
  
  - **Free space before.** Define the position (in Mb) of the copied partition relative to the beginning of the available range of disk space.
  
  - **Free space after.** Define the amount of trailing free space (in Mb) at the end of the available range of disk space.

Partition size and position may also be defined by using the drag-and-drop technique. To do that, just carry out the required operation on the Disk Map.

**Result**

After the operation is completed you receive a fully functional duplicate of the existing partition.

To make a Win2K+ operating system bootable on different hardware, please additionally complete the P2P Adjust OS Wizard.

**Boot Management**

Our program enables to easily manage several operating systems on one computer with the help of the Boot Manager Setup Wizard. Among the key features of the wizard the following should be mentioned:

- Up to 16 operating systems on one PC;
- Secure adding/removing of the Boot Manager startup record to/from the MBR;
- Auto Boot option to automatically start up the previously chosen OS after a certain time period;
• Hiding of any primary partition except selected at the moment.

**Startup**

**Express Launcher**

• Click the Boot Management button and then select Boot Manager.

**Launcher**

• In the Main menu: select Tools > Setup Boot Manager...
• On the Common Tasks Bar: click the Boot Manager Wizard item of the Wizards menu.

**Setup**

The wizard offers the following steps to accomplish the operation:

• **Hiding other primary partitions.** By marking this checkbox the program will automatically assign the hidden flag to all primary partitions of the hard disk(s) except the one selected to boot. This will help to avoid any problems when dealing with different operating systems or different versions of one and the same OS, as they will be unaware of each other.

• **Boot menu options.** In this section you can switch between the following modes:
  - **Normal mode.** Choose this mode to display the boot menu every time the computer starts up and define a timeout on the expiry of which the program will automatically select the previously chosen item of the menu.
  - **Hidden mode.** Choose this mode not to display the boot menu until pressing a hot key. For this mode you should define a hot key used to enable the Boot Manager and a time period in seconds the startup message will be displayed.

• **Deactivating/Configuring the Boot Manager.** These two options will only be available once the wizard has been completed and launched again. Select the Deactivate option to remove the Boot Manager from the MBR (Master Boot Record) or Configure to modify the previously set parameters of the startup process.

**Result**

After the Boot Manager Setup Wizard is completed the program updates the original record in the MBR to get control of the booting process and to be able to display the boot menu.

**Available operation scenarios:**
Partition Management
In this chapter you will find all the information necessary to carry out partitioning operations supported by the program.

Basic Partitioning Operations
Here you can learn how to accomplish basic partitioning operations (create, format, delete).

Creating Partitions
The program provides the ability to create a new partition by using the DOS partitioning scheme. This operation can be accomplished either with the Create Partition Wizard or the Create Partition Dialog.

Besides there's the Express Create Partition Wizard that will analyze your disk subsystem to help you create an NTFS partition in the most appropriate place of your hard disk by up-taking all the unallocated disk space (if any) and/or an innocuous slice of the unused space of an adjacent partition, and then make it available in the system by assigning a drive letter.

Restrictions

1. Do not use the Create Partition function in order to undelete the last deleted partition.

2. The program cannot create new partitions on Dynamic Disks. The current version of the program supports only hard disks that use the DOS partitioning scheme (in Windows 2000 and XP these disks are named Basic Disks).

3. According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot be created:
   - Two Extended Partitions on one hard disk
   - Five or more Primary partitions on one hard disk
   - If there is an Extended Partition on the disk, only three Primary partitions are allowed

4. The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free space on an existing partition to a new partition.

Express Create Partition Wizard Startup
There are several ways to start the Express Create Partition Wizard:

Launcher

- In the Main menu: select Wizards > Express Create Partition...
- On the Common Tasks bar: click the Express Create item of the Wizards menu.

Create Partition Wizard Startup
There are several ways to start the Create Partition Wizard:

Express Launcher

- Click the Partitioning button and then select Create Partition.
• In the Main menu: select **Wizards > Create Partition**...

• On the Common Tasks bar: click the **Create Partition** item of the Wizards menu.

**Dialog Startup**
In order to start the operation you should take the following steps:

**Launcher**

1. Select a block of free space on the Disk Map;

2. Call the Create Partition Dialog to set up the operation. There are several ways to do it:

   • Select in the Main Menu: **Partition > Create Partition**.

   • Call the popup menu for the block of free space (right click of the mouse button) then select the menu item: **Create Partition**.

**Express Create Partition Wizard Setup**

Thanks to a highly intelligent work algorithm, the wizard requires minimal involvement in the operation, thus you only need to choose a method you find the most suitable to create the partition (if several available), which actually differ in the amount of space to allocate. For easy perception, you can see the resulted disk layout on the disk map by selecting this or that mode.

The number of available methods depends on your disk layout.

To learn more on the way the wizard works, please click the corresponding link on the first page of the wizard.

**Create Partition Wizard Setup**

The wizard offers the following steps to accomplish the operation:

• **Partition destination.** Select a hard disk (if the computer has several hard disks) and then choose position for the future partition on the disk: at the end (preferable), at the beginning or somewhere in the middle between other partitions.
By default, the program allows you to create a new partition only as the last primary or as the last logical drive within the extended partition. However, by activating the advance mode on the first page of the wizard you can remove this restriction that in its turn might result in some boot problems.

- **Partition size.** There is no restriction on size of the future partition, merely depending on space available on the hard disk.

If there is not enough free space in one block, the wizard enables to redistribute free space, joining all free space blocks together into one united block and moving partitions when necessary. If the total amount of free space is still not enough, it is possible to split a fragment of space from one of the existing partitions, thus resizing it.

If a partition to resize is locked and cannot be processed, the wizard makes the system reboot to create the partition and then automatically boots the system again. (The rebooting mechanism is different for different versions of Windows.)

You can also choose whether the future partition will be primary or logical by marking the appropriate checkbox.

- **Partition properties.** On the next page of the wizard you can set a number of additional parameters:
- **Partition type.** From the pull-down list select a file system the newly created partition will be formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use).

- **Volume label.** Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually used for drive identification.

- **Surface test level.** Define the level of the surface check to make the program find bad and unstable sectors and mark them unusable in the file system metadata.

**Dialog Setup**

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes button to confirm the operation.

- **Define whether the partition will be Primary, Extended or Logical.** You can choose the desired partition type from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on the selected block of free space - within the Logical free space, only Logical partitions can be created; Within the Primary free space, both Primary partitions or the Extended Partition can be created.

- **Partition Size.** Define the size (in Mb) of the new partition.

- **Free space before.** Define the position (in Mb) of the new partition relative to the beginning of the block of free space.
• **Free space after.** Define the amount of trailing free space (in Mb) at the end of the new partition.

| Partition size and position may also be defined by using the drag-and-drop technique. To do that, just carry out the required operation on the Disk Map. The virtual operations are to be available. |

| File system for new partition. From the pull-down list select a file system the newly created partition will be formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use). |

| Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually used for drive identification. |

| Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly formatted partition. |

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on the chosen file system, the following options become available:

| Use OS built-in routine. Mark the option to restrict the available values according to the used OS. |

| Whether the surface test will be performed. Define the level of the surface check to make the program find bad and unstable sectors and mark them unusable in the file system metadata. |

| The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set the number of sectors to be reserved for the boot area on the partition with this spinner control. |

| The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum amount of files/directories to be placed in the Root Directory on the FAT16 partition. |

| The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control. |

Number of available options depends on the selected file system type.

Result
After the operation is completed you receive a fully functional partition.

Available operation scenarios:

• [Creating a new partition to detach operating system from the rest of data](#)
**Formatting Partitions**

Any partition should contain some file system to be used for keeping data. The process of installing a file system is commonly known as formatting. A huge variety of file systems have been developed these days.

**Supported File Systems**

The program provides the ability to format partitions of the following file systems:

- FAT12 & FAT16
- FAT32
- NTFS
- Ext2
- Ext3
- Ext4
- Linux Swap v. 2

This operation can be accomplished either with the Format Partition Wizard or the Format Partition Dialog.

**Wizard Startup**

There are several ways to start the Format Partition Wizard:

**Express Launcher**

- Click the **Partitioning** button and then select **Format Partition**.

**Launcher**

- In the Main menu: select **Wizards > Format Partition**...
- On the Common Tasks bar: click the **Format Partition** item of the Wizards menu.

**Dialog Startup**

In order to start the operation you should take the following steps:

**Launcher**

1. Select a partition on the Disk Map;
2. Call the Format Partition Dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: **Partition > Format Partition**.
   - Call the popup menu for the selected partition (right click of the mouse button) then select the menu item: **Format Partition**.

**Wizard Setup**

The wizard offers the following steps to accomplish the operation:

- **Partition to format**. Select a hard disk (if the computer has several hard disks) and then the required partition to format.
As a result of this operation contents of the selected partition will be lost.

- **Partition properties.** On the next page of the wizard you can set the following partition parameters:

  - **Partition type.** From the pull-down list select the desired file system type. In fact, the program displays only those file systems that can correctly be placed to the selected partition, taking its capacity into account.

  - **Volume label.** Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually used for drive identification.

  - **Drive letter assignment.** The pull-down list contains vacant drive letters that can be associated with the newly formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). To activate the advance mode, you need to mark the appropriate option at the foot of the page. When it is marked, the next page enables to define:

  - **Use OS built-in routine.** Mark the checkbox to restrict the available values according to the used OS.

  - **Whether the surface test will be performed.** Define the level of the surface check to make the program find bad and unstable sectors and mark them unusable in the file system metadata.

  - **The amount of sectors per boot.** This parameter is available exclusively for FAT16 and FAT32 file systems. Set the number of sectors to be reserved for the boot area on the partition with this spinner control.
• **The amount of root entries.** This parameter is available exclusively for FAT16 file system. Set the maximum amount of files/directories to be placed in the Root Directory on the FAT16 partition.

• **The amount of sectors per cluster.** Define the Cluster Size for the formatted partition with this spinner control.

⚠️ Number of available options depends on the selected file system type.

### Dialog Setup
Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Format button to confirm the operation.

- **File system.** From the pull-down list select the desired file system type. In fact, the program displays only those file systems that can correctly be placed to the selected partition, taking its capacity into account.

- **Volume label.** Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually used for drive identification.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on the chosen file system, the following options become available:

- **Use OS built-in routine.** Mark the checkbox to restrict the available values according to the used OS.

- **Whether the surface test will be performed.** Define the level of the surface check to make the program find bad and unstable sectors and mark them unusable in the file system metadata.

- **The amount of sectors per boot.** This parameter is available exclusively for FAT16 and FAT32 file systems. Set the number of sectors to be reserved for the boot area on the partition with this spinner control.

- **The amount of root entries.** This parameter is available exclusively for FAT16 file system. Set the maximum amount of files/directories to be placed in the Root Directory on the FAT16 partition.

- **The amount of sectors per cluster.** Define the Cluster Size for the formatted partition with this spinner control.
Result
After the operation is completed you receive a fully functional partition formatted to the specified file system.

Deleting Partitions
With the Delete Partition Wizard or the Delete Partition Dialog you can delete a partition on a hard disk partitioned with the DOS partitioning scheme. Unlike the majority of other utilities (Windows Disk Manager included), the program can not only remove references to the deleted partition from the Partition Table, thus making it unavailable for the operating system, but also enables to irreversibly destroy its data. This feature will guarantee security of your personal information.

Wizard Startup
There are several ways to start the Delete Partition Wizard:

Express Launcher
- Click the Partitioning button and then select Delete Partition.

Launcher
- In the Main menu: select Wizards > Delete Partition...
- On the Common Tasks bar: click the Delete Partition item of the Wizards menu.

Dialog Startup
In order to start the operation you should take the following steps:

Launcher
1. Select a partition on the Disk Map;
2. Call the Delete Partition Dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: Partition > Delete Partition.
   - Call the popup menu for the selected partition (right click of the mouse button) then select the menu item: Delete Partition.

Wizard Setup
The wizard offers the following steps to accomplish the operation:

- **Partition to delete.** Select a hard disk (if the computer has several hard disks) and then the required partition to delete.
As a result of this operation contents of the selected partition will be lost.

- Merge free blocks. As a result of the operation you may get several blocks of the unallocated space on the hard disk. So choose whether to merge them all and place at the beginning of the disk or at the end by selecting the required operation from the pull-down list.

Dialog Setup
Initially the program suggests you just to remove references to the selected partition from the Partition Table.

- Enter the volume label to confirm deleting. To confirm deletion of the selected partition, enter its Volume Label. The current volume label is displayed above.

- Do not ask volume label next time. Mark the option to inhibit confirmation next time you start the dialog.

Result
By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the modification of the disk layout.

Advanced Partitioning Operations
Here you can learn how to accomplish advanced partitioning operations (merge, redistribute free space, undelete, etc.).
**Merging Partitions**

The Merge Partitions Wizard enables to consolidate the disk space, which originally belongs to two adjacent partitions, into a single, larger partition. The order, in which two partitions have been chosen, is important since all contents of the second selected partition will be placed in a folder on the resulted joined partition.

The program provides the ability to merge only NTFS, FAT16 or FAT32 partitions.

**Startup**

There are several ways to start the Merge Partitions Wizard:

**Express Launcher**

- Click the Partitioning button and then select Merge Partitions.

**Launcher**

- In the Main menu: select Wizards > Merge Partitions...
- On the Common Tasks bar: click the Merge Partitions item of the Wizards menu.

**Setup**

The wizard offers the following steps to accomplish the operation:

- **The partition to expand.** Select a partition, the size of which you need to increase by up-taking contents of an adjacent partition.

![Partition to expand](image1)

- **The partition to merge with.** Choose the second partition for the merge operation, the contents of which will be placed in a folder on the resulted joined partition. By default, the program offers an easy-to-understand folder name to store files of the second partition, which however can be customized.

![Partition to merge with](image2)
Be particularly careful when selecting system partitions to process, since the incorrect order, in which two partitions have been chosen, will result in inability to boot the operating system.

Result
After the operation is completed the disk space of the two adjacent partitions will be consolidated.

Redistributing Unused Space between Partitions
This operation can be accomplished either with the Express Resize Partitions Wizard or the Redistribute Free Space Wizard.

Express Resize Partitions Wizard
The Express Resize Partitions Wizard enables to easily increase free space on one partition by up-taking the unused space of an adjacent partition of your hard disk.

Startup
There are several ways to start the Express Resize Partitions Wizard:

Express Launcher
- Click the Partitioning button and then select Resize Partitions.

Launcher
- In the Main menu: select Wizards > Express Resize Partitions...
- On the Common Tasks Bar: click the Express Resize item of the Wizards menu.

Setup
The wizard offers the following steps to accomplish the operation:

- **Adjacent partitions to resize.** Click on the left partition of the pair of partitions you need to redistribute the unused space between, as the right one will be selected automatically.

- **Resulted size of partitions.** Redistribute the unused space between the partitions with the slider or manually by entering the required value.
Result
After the operation is completed the unused space between the specified partitions will be redistributed according to your needs.

Available operation scenarios:

- Increasing size of a system partition by taking unused space of an adjacent partition
- Resizing partitions of Apple Boot Camp

Redistribute Free Space Wizard
The Redistribute Free Space Wizard helps to increase free space on one partition by up-taking the on-disk unallocated space and the unused space of other partitions. By default, the wizard adds to the target partition all existing blocks of the free space. Besides you can specify partitions to act as a space donor. The wizard will automatically recalculate positions of the partitions and move their contents to new locations.

Startup
There are several ways to start the Redistribute Free Space Wizard:

Launcher

- In the Main menu: select Wizards > Redistribute Free Space…
- On the Common Tasks bar: click the Redistribute Free Space item of the Wizards menu.

Setup
The wizard offers the following steps to accomplish the operation:

- **Partition to enlarge.** Select a partition, the size of which will be increased at the expense of other partitions. Blocks of the free space (if any) will be automatically added to the target partition.
• **Partition to donate.** Choose any partition(s) (not only adjacent) to donate free space.

• **Partition size.** By default, the program leaves 50% of the unused space on a partition and removes another 50% to add it to the target partition. However, the size to take can be customized by moving the slider or by manually entering the exact value.

**Result**
After the operation is completed free space of the specified partition will be increased by up-taking the on-disk unallocated space and the unused space of other partitions.

**Undeleting Partitions**
When simply deleting a partition (without additional wiping) disk management software only removes references to it in the Partition Table, thus leaving the possibility to recover it later.
The program enables to find and recover these partitions. A restored partition will be fully functional, as long as other partitions were not created, moved or exceeded the disk space occupied by that partition. That is why the program offers this function only for blocks of free space.

The operation can be accomplished with the Undelete Partition Wizard.

**Startup**

There are several ways to start the Undelete Partition Wizard:

- In the Main Menu: select **Wizards > Undelete Partitions**…
- On the Common Tasks Bar: click the **Undelete Partition** item of the Wizards menu.
- Select a block of free space on the Disk Map and click the **Recover Lost Partitions** item on the page that appears in the Explorer Bar.
- Call the popup menu for the block of free space (right click of the mouse button) then select the menu item: **Recover Lost Partitions**…

**Setup**

The wizard offers the following steps to accomplish the undelete partition operation:

- **Free blocks to scan for lost partitions.** Choose a free block from a tree-like list of available hard disks.

![Image of the Disk Map showing various hard disks and a selected free space]

- **Search method.** By default, the wizard selects the fastest search method for your operating system. In most cases that will do to find any accidentally deleted partition. However if you’re under Windows XP for instance (the Conventional Search option is selected), but the deleted partition you're looking for has been created with the Disk Management utility under Vista, the wizard won’t be able to find this partition, unless you manually select the appropriate option (Quick Search for Partitions Created by Vista or Later OS). Moreover if the wizard still fails to find the partition you need, you can select the Thorough Search option to scan every single sector in the specified search area to get the most accurate results.

![Image of the wizard's search method options]

Copyright© 1994-2010 Paragon Software Group. All rights reserved.
To know more on the available search methods, please use the context sensitive hint system.

- **File system filter.** By default, the wizard will search for all known file systems. However, by clicking on the appropriate option on the second page of the wizard, you can specify only those file systems you need.

- **A partition to undelete** (if several). By default, the program searches records of any deleted partition ever existed on the selected block of free space. So you can get several partitions to choose from.

Most likely the required partition will be found first. If so, you may abort the search operation by pressing the Stop search button.

**Result**
After the operation is completed you receive a fully functional partition.

**Installing a New Operating System**
Getting your computer ready to install a new operating system, especially when it is going to be an additional OS in the system, is a rather complicated task that implies quite a number of operations, from allocating space to create a new partition (resize, redistribution of free space) to formatting of the newly created partition to a particular file system and checking its surface for bad sectors to avoid possible data loss. Operating systems today are being supplied with basic tools of partitioning that only enable to create a partition (in case there is enough unallocated space on the disk) and then format it to the specified file system type. Our program offers a handy Install New OS Wizard to easily carry out all the necessary operations to install a new operating system.

**Startup**
There are several ways to start the Install New OS Wizard:

**Express Launcher**
• Click the **Boot Management** button and then select **Install New OS**.

**Launcher**

• In the Main menu: select **Wizards > Install New OS...**

• On the Common Tasks bar: click the **Install New OS** item of the Wizards menu.

**Setup**

The wizard offers the following steps to accomplish the operation:

• **Partition to install a new operating system.** The program offers two ways of installing a new OS, i.e. to create a new primary partition for it or use an existing one.

Only primary partitions can be used to install an operating system.

- In case the first option has been marked, the wizard enables to specify:

**A hard disk (if several) where a new partition will be created.** Thanks to an advanced program engine it is possible to use unallocated space of the disk (if any) and unused space of existing partitions to create a new partition;

To avoid any possible problems, the new partition will in no way be created as the first partition of the disk which already contains at least one partition.

**And its size.** If there are blocks of the free space on the disk, the wizard will merge them all and allocate the resulted space for a new partition in the first place. If not, it will take 50% of the unused space of an adjacent partition. However, the size to take can be customized by moving the slider.
- In case the second option has been marked, the wizard enables to choose an existing primary partition to install a new operating system.

Your computer may fail if any other OS has already been installed on the selected partition.

- **Partition properties.**

  - **Partition type.** From the pull-down list select the desired file system type. In fact, the program displays only file systems that can be correctly placed to the selected partition, taking its capacity into account.

  - **Drive letter assignment.** The pull-down list contains vacant drive letters that can be associated with the newly formatted partition.

  - **Surface test level.** Define the level of the surface check to make the program find bad and unstable sectors and mark them unusable in the file system metadata.

- **OS Label.** Enter a label for the selected partition in the textual field. It will later be used for the drive identification.
**Result**
As the final step the wizard will offer you to insert a distributive CD/DVD of the new operating system and restart the computer to launch the installation procedure.

---

⚠️ **The program will update your MBR, so most likely you won’t be able to start up any of the previously installed operating systems. Please launch the Boot Manager Setup Wizard after the installation has been completed to fix this issue.**

---

**Available operation scenarios:**

- [Creating Dual Boot Systems](#)

---

**Moving/Resizing Partition**
The Move/Resize Partition function allows you to resize or change location of any partition without destroying its data.

In order to move/resize a partition you should take the following steps:

**Launcher**

1. Select a partition on the Disk Map.

2. Call the Move/Resize Partition dialog to set up the operation. There are several ways to do it:
   - Select in the Main menu: **Partition > Move/Resize Partition...**
   - On the Explorer bar: click on the current total size value.
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or on the Partition List, then select the menu item: **Move/Resize Partition...**

3. Define parameters of the operation.

   - **Volume size.** Define size (in Mb) of the modified partition.
• **Free space before.** Define the partition position (in Mb) relative to the beginning of the available range of disk space.

• **Free space after.** Define the amount of trailing free space (in Mb) at the end of the available range of disk space.

• **Sector to sector move.** Mark the checkbox to move the partition in the sector-by-sector mode to process its unused space as well. This can help to avoid problems with hidden data created by certain applications or the system administrator. However, it will take more time to accomplish the operation.

Partition size and position may also be defined by using the drag-and-drop technique. To do that, just carry out the required operation on the Disk Map. The virtual operations are to be available.

When resizing a FAT16 partition beyond the 2GB limit (maximum file system size), the partition will automatically be converted to FAT32.

The program enables to enlarge NTFS partitions (system, locked) without rebooting Windows and interrupting its work, providing 100 percent guarantee that your data is kept intact.

4. The operation will be performed immediately after confirmation.

Available operation scenarios:

• **Increasing size of a system partition by taking unused space from any other**

• **Shrinking a system partition to increase size of a data partition**

**Converting File System**

With our program you can change type of the used file system without destroying its data. While performing the operation, it first checks the current file system for consistency and then verifies whether the on-partition data meet the requirements of the desired file system or not. After having passed the testing, the program re-organizes the file system metadata and user files.

The program enables to convert the following file system types:

- FAT16 > NTFS, FAT32
- FAT32 > NTFS, FAT16
- NTFS > FAT16, FAT32
- Ext2 > Ext3

In order to convert a file system you should take the following steps:

**Launcher**

1. Select a partition on the Disk Map.

2. Call the Convert File System of Partition dialog to set up the operation. There are several ways to do it:
Select in the Main menu: **Partition > Convert file system...**

On the Explorer bar: click on the current file system type.

Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or on the Partition List, then select the menu item: **Convert File System...**

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Convert button to confirm the operation.

![Conversion dialog](image)

- **New file system.** From the pull-down list choose a file system you would like to convert to. Actually the program only displays variants available for the operation, taking into account the current parameters of the selected partition and limitations of the used file system.

- **New cluster size.** Define the cluster size for the partition. This parameter can have a profound effect on the overall performance. In a nutshell, larger clusters waste more space, but generally provide for slightly better performance, because of less fragmentation. So be particularly careful with it.

The cluster size value is expressed in sectors per cluster. To get it in Kbytes, please divide it into half.

You may only decrease the current cluster size.

- **Surface test level.** Define the level of the surface check to make the program find bad and unstable sectors and mark them unusable in the file system metadata.

4. The operation will be performed immediately after confirmation.

**Changing Cluster Size**

Cluster size is one of the crucial parameters of any file system. Its value implicitly affects the performance of the files input-output activity since it defines the size of the file system metadata. Besides, the so-called waste space factor also depends on the cluster size.

In order to change the cluster size of a partition you should take the following steps:

**Launcher**

1. Select a partition on the Disk Map.

2. Call the Change Cluster Size dialog to set up the operation. There are several ways to do it:

   - Select in the Main menu: **Partition > Modify > Change Cluster Size...**
113

- On the Explorer bar: click on the current sectors per cluster value.

3. Define the cluster size for the partition. This parameter can have a profound effect on the overall performance. In a nutshell, larger clusters waste more space, but generally provide for slightly better performance, because of less fragmentation. So be particularly careful with it.

![Cluster Size dialog](image)

- The Cluster Size value is expressed in Sectors Per Cluster. To get the Cluster Size in Kbytes, divide it into half.

4. The operation will be performed immediately after confirmation.

Making Logical/Primary

The program allows you to include a primary partition in the extended partition, or exclude a logical partition from the extended partition, without partition duplication.

In order to change a partition type you should take the following steps:

Launcher

1. Select a primary or logical partition on the Disk Map.

2. Call the Make Partition Logical/Primary dialog to set up the operation. There are several ways to do it:

   - Select in the Main menu: **Partition > Modify > Make Partition Logical/Primary**.
   - On the Explorer bar: click on the current partition type.

![Make Logical/Primary dialog](image)

- The Make Primary > Logical option is only available when the selected partition is adjacent to the extended partition and vice versa.

- The Make Primary > Logical option of the system partition will result in inability to boot the operating system.

The operation will be performed immediately after confirmation.
Changing Partition Attributes
This chapter explains how you can change partition attributes (Active flag, Hidden flag, Partition ID, Volume Label, etc.).

Mark Partition Active/Inactive
The program enables to set an active/inactive flag for primary partitions of a hard disk. By default, an operating system will boot only if its partition is active or bootable.

In order to mark a partition active/inactive you should take the following steps:

Launcher

1. Select a primary partition on the Disk Map.
2. Call the Mark Partition Active/Inactive Dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: Partition > Mark Partition as Active/Inactive.
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select the menu item: Mark Partition as Active/Inactive.
3. The operation will be performed immediately after confirmation.

There can only be one active partition on a hard disk, otherwise your operating system will fail to boot.

Hide/Unhide Partition
The program allows you to hide/unhide primary and logical partitions. By default, an operating system does not mount hidden partitions, thus preventing access to their contents.

In order to hide/unhide a partition you should take the following steps:

Launcher

1. Select a partition on the Disk Map.
2. Call the Hide/Unhide Partition Dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: Partition > Hide/Unhide Partition.
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select the menu item: Hide/Unhide Partition.
3. The operation will be performed immediately after confirmation.
It is strongly recommended not to hide the system partition. Otherwise your operating system will fail to boot.

Set Label of a Partition
The Partition Label is a small textual field (up to 11 characters) that is located in the partition’s boot sector. It is detectable by any partitioning tool and is used for notification purposes only.

In order to change a partition label you should take the following steps:

Launcher

1. Select a partition on the Disk Map.
2. Call the Change Volume Label dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: Partition > Modify > Change Volume Label.
   - On the Explorer Bar: click on the current volume label.
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select the menu item: Change Volume Label.
3. Enter a label for the selected partition.
4. The operation will be performed immediately after confirmation.

Change Partition ID
Partition ID is a file system identifier. It is saved in the Partition Table and is used to quickly detect a partition of the supported type. By manually changing its value, you can manipulate accessibility of partitions.

In order to change a partition ID you should take the following steps:

Launcher

1. Select a partition on the Disk Map.
2. Call the Change Partition ID dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: Partition > Modify > Change Partition ID...
   - On the Explorer Bar: click on the current partition ID.
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select the menu item: Change Partition ID...
3. Set a new ID for the selected partition.

- **Predefined ID.** Select from the pull-down list the required ID.
- **Enter ID manually.** With the spinner control set the required ID value. It has to be a 1-2 digit hexadecimal number.

4. The operation will be performed immediately after confirmation.

**Change Serial Number of a Partition**

FAT16, FAT32, and NTFS file systems include the Serial Number parameter. A partition's serial number is saved in the boot sector. Its value is generated while formatting.

The program enables to modify the serial number parameter for FAT16, FAT32, or NTFS partitions without re-formatting.

In order to change a serial number you should take the following steps:

**Launcher**

1. Select a partition on the Disk Map.

2. Call the Change Partition Serial Number dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: **Partition > Modify > Change Serial Number**.
   - On the Explorer Bar: click on the current serial number.

3. Enter a new serial number for the selected partition. It should contain 8 hexadecimal figures (0..9 or A..F). The operation cannot proceed until you enter all 8 symbols.
4. The operation will be performed immediately after confirmation.

**Hard Disk Management**

In this chapter you will find all the information necessary to carry hard disk operations supported by the program (Update MBR, Convert to Basic, Change Primary Slot).

**Updating MBR**

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or a malfunction of boot management software.

In order to update MBR of a hard disk you should take the following steps:

**Launcher**

1. Select a hard disk on the Disk Map.

2. Call the Update MBR dialog to set up the operation. There are several ways to do it:

   - Select in the Main Menu: **Hard Disk > Update MBR**.

   - Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, then select the menu item: **Update MBR**.

3. The operation will be performed immediately after confirmation.

**Converting Dynamic MBR to Basic**

The program allows you to convert a dynamic MBR disk containing simple volumes into a basic one while keeping its contents intact.

In order to convert a dynamic MBR disk into basic you should take the following steps:

**Launcher**

1. Select a dynamic MBR disk containing simple volumes on the Disk Map.

2. Call the Convert to Basic dialog selecting in the Main Menu: **Hard Disk > Convert to Basic...**

3. Set the required number of primary partitions if necessary. According to the DOS partitioning scheme a hard disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three primary partitions are allowed. That is why if a dynamic disk contains several simple volumes the program enables to choose the number of primary partitions. The rest of them if any will automatically be converted to logical disks within the Extended partition.
The program can only process dynamic disks containing solid simple volumes (without extension).

Converting GPT to Basic MBR
The program allows you to convert a basic or a dynamic GPT disk containing simple volumes into a basic MBR disk while keeping its contents intact.

In order to convert a basic or a dynamic GPT disk into a basic MBR disk you should take the following steps:

Launcher

1. Select a basic or a dynamic GPT disk containing simple volumes on the Disk Map.

2. Call the Convert to Basic MBR Hard Disk dialog selecting in the Main Menu: Hard Disk > Convert to Basic MBR Hard Disk...

3. Set the required number of primary partitions if necessary. According to the DOS partitioning scheme a hard disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three primary partitions are allowed. That is why if a GPT disk contains several volumes the program enables to choose the number of primary partitions. The rest of them if any will automatically be converted to logical disks within the Extended partition.
The program can only process dynamic GPT disks containing solid simple volumes (without extension).

Changing Primary Slot
Different operating systems apply different approaches to enumeration of the primary partitions.

In Linux:
In Linux, every partition has a special symbolic name that encodes a hard disk containing a partition, and a partition itself. Partitions are addressed and accessed by using their symbolic names. Symbolic names are automatically generated by Linux in accordance with the order of hard disks in BIOS and the order of partition records in the Partition Table. Thus changing enumeration of the primary partitions can lead to changing of paths to some important resources.

In DOS:
The last versions of MS-DOS use a rather sophisticated algorithm for a drive letter assignment. A drive letter, which is assigned to a partition, depends on the order of records in the Partition Table. Thus changing enumeration of the primary partitions affects the drive letters assignment. In early versions of MS-DOS, it could even lead to the unavailability of a partition.

The program provides the ability to change enumeration of the primary partitions. This feature will allow you to fix problems concerning an inappropriate order of partitions.

In order to modify enumeration of the primary partitions you should take the following steps:

Launcher

1. Select a hard disk on the Disk Map.
2. Call the Change Primary Slot dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: Hard Disk > Change Primary Slot.
   - Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, then select the menu item: Change Primary Slot.
3. In the opened dialog you can see the current enumeration of the primary partitions of the selected hard disk in the Partition Table. To help you distinguish partitions from one another, the program provides the following parameters for every partition:

- Slot
- Volume
- Partition type
- File system
- Partition size
- Volume label

There are two buttons on the right to move the selected partition up and down within the primary part of the Partition Table.

4. The operation will be performed immediately after confirmation.

**Wipe Tasks**

In this chapter you will find all the information necessary to wipe a hard disk/partition of any file system or only destroy any remnants of deleted files/directories left on disk without affecting the used data, thus providing high level of security.

The operation can be accomplished with the Wipe Wizard or corresponding dialogs.

**Wizard Startup**

**Express Launcher**

- Click the **Security and Optimization** button and then select **Wipe**.
• In the Main Menu: select Wizards > Wipe Hard Disk or Partition...

Wizard Setup
The wizard offers the following steps to accomplish the operation:

• **The hard disk/partition to wipe.** Select a hard disk/partition the data of which you want to destroy.

![Image of hard disk/partition options]

- **Wipe mode.** This section enables to switch between two options:
  - **Wipe out all data.** Select the option to irreversibly destroy all on-disk data of the selected object.
  - **Clear (wipe) free space.** Select the option to destroy any remnants of deleted files/directories left on disk without affecting the used data.

**The Clear Free Space operation is available only for Logical and Primary partitions of known file systems.**

• **Wipe method.** Here you can select a specific data erasure algorithm or create a customized method by marking the appropriate option.

![Image of specific algorithm options]

- In case you preferred to use a specific algorithm, the next page of the wizard enables to get detailed information on the selected algorithm, choose whether to carry out residual data verification or not specifying the percentage of sectors to check and estimate the time required to accomplish the operation.
The current version of the program provides support of one military standard, i.e. US DoD 5220.22-M.

- In case you preferred to create a customized algorithm, the next page of the wizard enables to define up to 4 wiping patterns, number of passes for each wiping pattern and for the group of patterns. The Mask spinner control allows you to set a two-figure hexadecimal character value ("00" by default). The available range is from "00" to "FF". You can also choose whether to carry out residual data verification or not specifying the percentage of sectors to check.

- Revise your changes. This page informs on all the actions to be made in the wizard in a bright, graphical form.

Wizard Result
After the operation is completed you can see a well informative summary page, providing structurally divided in-depth information on all the actions made in the wizard.
The program also enables to store the resulted report. To do that, just press the Save button and choose the exact location in the opened dialog.

To make sure that all on-disk data is irreversibly destroyed call the Disk Viewer dialog by clicking the appropriate tab and see it for yourself.

⚠️ The Summary page will be available only when the Virtual operations are disabled.

Available operation scenarios:

- Hard Disk Utilization

Task Scheduling

Automation of operations can really help you out when you’ve got to accomplish certain routine operations on a regular basis as it enables to execute them without your involvement while optimizing your computer’s work-load.
Setting a Timetable

Thanks to the embedded Scheduler, you can set a timetable for execution of any operation. It has two categories for time settings (these correspond to appropriate items in the Schedule type menu):

- **Initiating the operation by an event:**
  - One time only (i.e. the Once item)
  - When the system starts (i.e. the At System Startup item)
  - When the user logs on (i.e. the At Logon item).

- **Initiating the operation periodically (i.e. Daily, Weekly, Monthly).**

You need to select one of the variants. Depending on your choice, the scheduler displays a form that enables to set a timetable.

To run the task in the log-off mode, please specify administering login info by following the appropriate link in the left lower corner of the page.

⚠️ **The Shutdown System on Complete option enables to automatically switch off the computer on the successful accomplishment of the operation.**

Managing Tasks

All scheduled tasks are placed in a separate list, which can be retrieved by clicking the Scheduled Tasks tab in the Explorer Bar:
On every task you can get in-depth information, including:

- The task name
- The full path to the generated script of the task
- Scheduled time of launch
- Statistics on the last launch
- Scheduled time of the next launch
- Used account information
- Comments to the task

To easily manage tasks, the program enables to arrange them according to a certain characteristic just by clicking on the required property.

This feature can be particularly beneficial when the Scheduled Tasks list contains too many items.

You can also enable/disable, rename, delete, refresh or modify properties of the selected task.

**Task Editor**
With the Task Editor you can easily modify properties of scheduled tasks. To do that, you should take the following steps:

**Launcher**

1. Select a task on the Scheduled Tasks list.

2. Call the Task Editor dialog. There are several ways to do it:
   - Click the **Properties** button on the Scheduled Tasks list.
   - Call the popup menu for the selected task (right click of the mouse button), then select the menu item: **Properties**.
3. In the opened dialog window you can see two tabs - General and Schedule. Click the General tab to modify:

- Full path to the macro-command program-interpreter, which describes the scheduled task;
- Command line for starting the interpreter (i.e. the task described in macro-language)
- Comments referring to the task
- The option of enabling/disabling the task.

By clicking the Schedule tab you can modify the task timetable.

In order to apply the changes, you need to click the Apply button at the foot of the dialog.

Creating a Scheduled Task
You can set a timetable for execution of any operation. For backup and copy operations the program offers handy wizards, while all the others can be scheduled with the Save to Scheduler dialog.

To create a scheduled task you should take the following steps:

Launcher

1. Make sure the virtual mode of execution is enabled;
2. Carry out with the program all operations you need to schedule;
3. Call the Save to Scheduler dialog in the Main Menu: Tools > Save to Scheduler...;
4. In the opened dialog enter the required task name and specify the task timetable;

5. The operation will be performed immediately after confirmation.

⚠️ This command is unavailable if there are no operations on the List of Pending Operations.

**Scripting**

The program actions can also be represented in form of a script. The script describes the appropriate operation with macro-language commands. There is an interpreter utility - SCRIPTS.exe, which is included in the program installation package. This utility works in the unattended mode, which enables to automate operations.

**Startup**

You have no need to write a script since the program has a convenient interface for such a task. In order to generate a script on the base of the entered parameters of the required operation, you should take the following steps:

**Launcher**

1. Make sure the virtual mode of execution is enabled;

2. Carry out with the program all operations you need to be scripted;

3. Call the Generate Script dialog in the Main Menu: **Tools > Generate Script**....

**Setup**

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Generate button to confirm the operation.
• **Script file name and location.** By default, the program offers to add the script to the Task List with a name containing its creation date and time. Unmark the Add to Task List checkbox to define an exact location and a filename for the script file. The default file extension that is reserved for scripting files is .psl, which however can be modified.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). To activate the advance mode, you need to click the More options button at the foot of the dialog page, so you will be able to define:

- **Interaction with the user.** Mark the option to pause the script interpreter during the execution to prompt the user’s confirmation or other input. Otherwise the program will not stop using default values for parameters if needed.

- **Commit after each operation.** Mark the option to commit changes after each operation.

- **Check for errors after each operation.** Mark the option to insert a special code in script, which checks the status of the last executed operation and stops the script processing if there are errors of any kind.

- **Discard all operations on close.** Mark the option to empty the List of Pending Operations after generating the script.

**Result**

After the operation is completed you receive a new script file. It is placed into the specified destination, its features defined in the dialog.

---

**This command is unavailable if there are no operations on the List of Pending Operations.**

To learn more about scripts please consult the Paragon Scripting Language manual.

---

Copyright © 1994-2010 Paragon Software Group. All rights reserved.
Extra Functionality
This chapter describes the supplementary functionality available in the program.

View Partition/Hard Disk Properties
The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the general information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geometry, cluster size, exact partition location, etc.

There are several ways to get properties on a partition/hard disk:

Launcher

1. Choose a partition/hard disk on the Disk Map, then select in the Main Menu: Partition/Hard Disk > Properties…;

2. Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk Map, then select the menu item: Properties…

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get information you need.

Volume Explorer
Volume Explorer is a special tool to browse and export contents of the local mounted/unmounted volumes formatted to FAT16, FAT32, NTFS, Ext2FS, Ext3FS, ReiserFS file systems. Besides it enables to access Paragon backups as regular folders to explorer their contents or to retrieve certain files.

Launcher
To launch the Volume Explorer you should click **Disk View** tab in the Explorer Bar and then choose **Volume Explorer**: 

![Disk View](image)

Call the popup menu for the selected file/folder (right click of the mouse button) to export it to some other location (local or network drive, etc.). 

![Select a destination folder for the export operation](image)

**Available operation scenarios:**

- **Restoring separate files and folders from a backup**

**File Transfer Wizard**

File Transfer Wizard is designed to make such operations as copying of separate files/directories or burning of them to CD/DVD as easy and convenient as possible. It may be of particular use in case of a system malfunction, caused either by a virus attack or files corruption, in order to get the system back on track again. Besides it provides access to Paragon backups as regular folders to browse through their contents or copy required files.

**Startup**

There are several ways to start the File Transfer Wizard:

**Express Launcher**

Copyright © 1994-2010 Paragon Software Group. All rights reserved.
Click the **Backup and Recovery** button and then select **Transfer Files**.

**Launcher**

- Select in the Main Menu: **Tools > File Transfer Wizard**.
- Select the **Transfer Files** item of the Wizards menu on the Common Tasks Bar.

**Setup**

The wizard offers the following steps to accomplish the transfer operation:

- **Place to look for files/directories**. Select a source disk from the pull-down list in the left pane of the page. The program enables to process both mounted and unmounted (without drive letter assigned) partitions. Besides it is possible to map a network drive.

- **Object(s) of operation**. Choose files/directories you want to copy and place them to Clipboard by pressing the Add button. To delete a file/directory from the Clipboard, select it in the Clipboard pane and press the Remove button. You can also create a new folder, rename or irreversibly delete existing files/directories of the left pane by pressing the appropriate buttons.

Files/directories deleted from the Clipboard remain intact on source disks.

- **Destination to store the object(s)**. The File Transfer Wizard allows copying data to local or network drives, to physical partitions (without drive letters assigned), or burning them to CD/DVDs. Choose the way the data will be stored.
Revision of changes. The Transfer Summary page provides structurally divided information on all the actions made in the wizard. Check the changes and come back to any step of the wizard (if necessary) by following the required hyperlink.

Result
After the operation is completed the required data will be placed into the specified destination.

Available operation scenarios:

- Copying of data from the corrupted system disk to another hard disk
- Burning of data from the corrupted system disk to CD/DVD
- Copying of data from a backup to the corrupted system partition
- Restoring separate files and folders from a backup

Mount Partition
The program enables to assign or remove drive letters of existing formatted partitions.

Assign Drive Letter
In order to mount a partition you should take the following steps:

Launcher

1. Select a partition on the Disk Map.
2. Call the Add Drive Letter dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: Partition > Assign Drive Letter...
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select the menu item: Assign Drive Letter...
3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this parameter. So you may just press the Yes button to confirm the operation.
However you can manually define the required letter by selecting it from the pull-down list of available drive letters.

4. The operation will be performed immediately after confirmation.

**Remove Drive Letter**

In order to un-mount a partition you should take the following steps:

**Launcher**

1. Select a partition on the Disk Map.

2. Call the Remove Drive Letter dialog to define appropriate settings. There are several ways to do it:
   - Select in the Main Menu: **Partition > Remove Drive Letter**.
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select the menu item: **Remove Drive Letter**.

3. The operation will be performed immediately after confirmation.

---

**Modifying drive letter of the system partition will result in inability to boot the operating system.**

---

**After having processed partitions with installed software, some programs may not run properly.**

---

**Downgrade NTFS Version**

With our program you can decrease version of an existing NTFS partition. This feature can be particularly useful when, for instance, dealing with different versions of the Windows NT family operating systems.

In order to start the operation you should take the following steps:

**Launcher**

1. Select a partition on the Disk Map.

2. Call the Downgrade NTFS Version dialog to set up the operation. There are several ways to do it:
   - Select in the Main menu: **Partition > Modify > Downgrade NTFS Version**...
   - On the Explorer bar: click on the current NTFS version.
• Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map or on the Partition List, then select the menu item: **Downgrade NTFS Version**...

3. Decrease version of the selected NTFS partition by selecting the one you need from the pull-down list.

![Downgrade NTFS Version](image)

4. The operation will be performed immediately after confirmation.

**Mount Archive**
The program provides the ability to assign a drive letter to a partition backup image. As a result of the operation you will get a new read-only partition in the system to easily browse through its contents and copy the required information even with the standard Windows tools.

**Assign Drive Letter**
In order to mount an archive you should take the following steps:

**Launcher**

1. Select a backup image in the Archive Database.

2. Call the Mount Archive dialog to set up the operation. There are several ways to do it:

   - Select in the Main Menu: **Archives > Mount the Selected Archive**.
   
   - On the Explorer bar: select the **Mount Archive** item.
   
   - Call the popup menu for the selected image (right click of the mouse button), then select the menu item: **Mount the Selected Archive**...

3. Specify a drive letter for the selected backup image. Initially the program suggests some consistent value for this parameter. So you may just press the Yes button to confirm the operation.

![Assign Drive Letter](image)

However you can manually define the required letter by selecting it from the pull-down list of available drive letters.

4. The operation will be performed immediately after confirmation.
The current version of the program allows the user to mount archives of separate partitions only.

There is no possibility to mount archives located on physical (unmounted) partitions or in the bootable capsule.

Archives will only be mounted for the current session and won't be available after the system restart.

It is strongly recommended not to un-mount backup images with Windows Disk Manager or other third side software.

**Remove Drive Letter**
In order to un-mount a backup image you should take the following steps:

**Launcher**

1. Select a backup image in the Archive Database.

2. Call the Unmount Archive dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: **Archives > Unmount the Selected Archive.**
   - On the Explorer bar: select the **Unmount Archive** item.
   - Call the popup menu for the selected image (right click of the mouse button), then select the menu item: **Unmount the Selected Archive...**

3. The operation will be performed immediately after confirmation.

**Test Surface**
The program enables to test surface of existing partitions and blocks of free space for bad or unstable sectors. If found any it automatically marks them unusable in the file system metadata, thus minimizing the risk of data loss.

In order to start the surface test you should take the following steps:

**Launcher**

1. Select a partition or a block of free space on the Disk Map.

2. Call the Test Surface dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: **Partition > Test Surface...**
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select the menu item: **Test Surface...**

3. From the pull-down list choose the level of the surface check.
4. The operation will be performed immediately after confirmation.

**Check File System Integrity**
The program allows you to check integrity of a file system. It can be used to detect possible file system errors before performing any operation on a partition.

To start the system integrity check you should take the following steps:

**Launcher**

1. Select a partition on the Disk Map

2. Call the Check File System Integrity dialog to set up the operation. There are several ways to do it:
   - Select in the Main Menu: **Partition > Check File System Integrity**
   - Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select the menu item: **Check File System Integrity**.

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes button to confirm the operation.

   - **Scan for and attempt to recover bad sectors.** Mark the checkbox to additionally process sectors marked bad in the file system metadata for the purpose of their possible recovery.

4. The operation will be performed immediately after confirmation.

**Check Archive Integrity**
The program provides the ability to check integrity of a backup image. The function allows distinguishing between valid and corrupted images before using them. The Check Archive Integrity Wizard will help you do that.

**Startup**
There are several ways to start the Check Archive Integrity Wizard:

**Launcher**

Copyright© 1994-2010 Paragon Software Group. All rights reserved.
• In the Main Menu: select Wizards > Backup Utilities > Check Archive Integrity...

• On the Common Tasks Bar: click the Check Archive Integrity item of the Wizards menu.

• Select a backup image in the Archive Database, then call the popup menu for it and choose the menu item: Check Archive Integrity...

**Setup**
The wizard offers the following steps to accomplish the operation:

• **An archive to verify.** The Browse for Archive page enables to find a backup image you need.

  By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive Database (if any).

![Image of Archive Database]

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description.

![Image of Archive File Details]

**To know more on the subject, please consult the Viewing Image Properties chapter.**

By clicking the Switch to File View link, you can find the required image in the browser-like window. The section below (i.e. Archive File Details) will also display a short description of the selected image.
Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or map network drives by clicking the appropriate buttons.

⚠️ To know more on the subject, please consult the Viewing Image Properties chapter.

Result
After the operation is completed you can see results of the check.

Check Recovery Discs
You’ve got the ability to check whether backup media created with the program is 100 percent error-free and ready to use. The Check Recovery Disc Wizard will help you do that.

Startup
There are several ways to start the Check Recovery Disc Wizard:

Launcher

- In the Main Menu: select Tools > Check Recovery Discs…
- On the Common Tasks Bar: click the Check Recovery Discs item of the Wizards menu.

Result
After the operation is completed you can see results of the check.
Edit/View Sectors

With the built-in Edit/View Sectors tool the program enables to view/edit sectors on existing partitions/hard disks providing the possibility to directly access and modify sectors, save and restore sectors from specified files, navigate through the system metadata, etc.

In order to edit/view sectors of a hard disk/partition you should take the following steps:

Launcher


2. Call the Edit/View Sectors dialog to set up the operation. There are several ways to do it:
   - Click the Disk View tab and then choose Disk Editor.
   - Select in the Main Menu: Partition/Hard Disk > Edit/View Sectors.
   - Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk Map, then select the menu item: Edit/View Sectors.
Careless use of the Edit Sectors function may result in the irreversible data corruption.

Send Log Files
The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of having difficulties with handling the program, you, with the help of this very function, can address the company support engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in order to tackle the encountered problem. Information of that kind is stored in Log files.

In order to send log files to the Paragon Support Team you should take the following steps:

Express Launcher

- Click the Partitioning button and then select Log Saver.

Launcher

1. Call the Send Log Files dialog in the Main Menu: Tools > Send Log Files;
2. Provide a customer name and a product serial number;

By clicking the Send button the built-in mail client will generate a template request with attached compressed log files and then send it to the Paragon Support Team.

Log Files
Log files are simple textual files that can be opened by any text editor. There are several log files automatically generated by the program:

<table>
<thead>
<tr>
<th>Log File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stubact.log</td>
<td>Contains in-depth information on parameters and performance of all operations carried out by the program</td>
</tr>
<tr>
<td>Pwlog.txt</td>
<td>Besides brief overview on operations it also contains detailed information about the state of all hard disks</td>
</tr>
</tbody>
</table>

Copyright © 1994-2010 Paragon Software Group. All rights reserved.
<table>
<thead>
<tr>
<th>Cdb.log</th>
<th>Contains low-level information on the CD/DVD devices used in the system</th>
</tr>
</thead>
<tbody>
<tr>
<td>BioNTlog.txt</td>
<td>It is an OS-dependent supplementary log file derived from Bioxx.dll. It may contain valuable information on Windows family operating systems</td>
</tr>
</tbody>
</table>

Log files do not contain any confidential information on the operating system settings or the user documents.

⚠️ The Send Log Files function is only available when outgoing mail server (SMTP) and the user e-mail address are properly set. To learn more about it please consult the Settings Overview chapter.

**View Logs**

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possible, all the information is structurally divided, besides there is the possibility to see the disk layout before and after an operation, what is very convenient.

In order to view logs on carried out operations call the View Logs dialog in the Main Menu: **Tools > View Log Files**
Typical Scenarios
This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You can find here useful recommendations and descriptions of operations.

Backup Scenarios

Creating the Backup Capsule
Let us take a computer of a rank and file user who is most likely to have only one hard disk with only one partition (the only partition is always system). Suppose that there is enough free space on the hard disk to create the backup capsule as well. It can be created with the Manage Backup Capsule Wizard:

Launcher

1. Click the Manage Backup Capsule item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Wizard's Welcome page, click the Next button.

3. Select a place on the disk where the backup capsule will be created. It can be created as a primary partition or as a logical drive within an extended partition. It can be inserted into any place on the hard disk: at the end (preferable), at the beginning or somewhere in the middle between other partitions.

4. Set the size for the backup capsule. It will be created at the expense of free space of the selected disk.

By default, the program allows the user to create the backup capsule only as the last primary or as the last logical drive within the extended partition. However, by activating the advance mode on the first page of the wizard you can remove this restriction that in its turn might result in some boot problems.

There is no restriction on the size of the backup capsule, merely depending on the available space of the hard disk and the capacity needed for the backup.

If the wizard cannot find enough free space in one block, it will redistribute free space, joining all free space blocks together into one united block and moving partitions if necessary. If the total amount of free space is still not enough, it is possible to split a fragment of space from one of the existing partitions, thus resizing it.
If the partition is locked and cannot be resized, the wizard makes the system reboot to create the backup capsule and automatically boots the system again. (The rebooting mechanism is different for different versions of Windows).

5. Activate the bootable recovery environment if needed. With its help you will get the choice to boot directly from the backup capsule for maintenance or recovery purposes every time you start up the computer.

This operation will result in overwriting of the current MBR, thus in case of having a third side boot manager, it will be removed. To avoid that you can save the current MBR with the help of the Edit/View Sectors tool.

The backup capsule can only be bootable if it is located on the bootable device (assigned in the BIOS).

6. Start the operation (by clicking the Next button) or return to correct the settings.

After the operation is completed you can place backup archives into the created backup capsule.

This operation can also be accomplished with the WinPE recovery environment.

Backing up a hard disk or partition to the Backup Capsule

To back up an entire hard disk or a separate partition and then place the resulted image into the backup capsule, please do the following:

Launcher

1. Create the backup capsule with the Manage Backup Capsule Wizard.

2. Click the Back up a Disk or Partition item of the Wizards menu (any of the ways described earlier can also be used here).

3. On the Wizard's Welcome page, click the Next button.

4. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a partition’s name depending on the chosen task.
You've got the option to modify the default backup settings by marking the appropriate checkbox on this page.

By default the program will take into account exclude filters set in the Settings dialog.

5. On the Backup Destination page, select the Save data to the Backup Capsule option.

6. Edit the archive name if necessary.

Please take into account values of the parameters Estimated archive size and Space available on backup destination - if the archive size exceeds the available space, delete outdated backups from the Backup Capsule or resize it with the Manage Backup Capsule Wizard.

7. Add comments to your backup describing its contents.

8. Choose whether to accomplish the operation immediately, set a time table for it, or generate a script.
9. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

This operation can also be accomplished with the Linux/DOS or WinPE recovery environments.

Backing up a hard disk or partition to external media (CD/DVD)

To back up an entire hard disk or a separate partition and then burn the resulted image to CD/DVD, please do the following:

Launcher

1. Click the Back up a Disk or Partition item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Wizard’s Welcome page, click the Next button.

3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a partition’s name depending on the chosen task.

You’ve got the option to modify the default backup settings by marking the appropriate checkbox on this page.

By default the program will take into account exclude filters set in the Settings dialog.

4. On the Backup Destination page, select the Burn the data to CD or DVD option.

5. Select a recordable device on the list of available CD/DVD devices and edit the archive name, if necessary.
Please take into account the Estimated archive size value. It can give you a hint about the number of CD/DVD discs required for the operation.

6. Add comments to your backup describing its contents.

7. Choose whether to accomplish the operation immediately, or generate a script.

8. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

This operation can also be accomplished with the Linux/DOS or WinPE recovery environments.

Backing up a hard disk or partition to a network drive
To back up an entire hard disk or a separate partition and then place the resulted image to a network share, please do the following:

Launcher

1. Click the Back up a Disk or Partition item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Wizard’s Welcome page, click the Next button.

3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a partition’s name depending on the chosen task.
You’ve got the option to modify the default backup settings by marking the appropriate checkbox on this page.

By default the program will take into account exclude filters set in the Settings dialog.

4. On the Backup Destination page, select the **Save data to local/network drives** option.

5. Map a network disk to place your backup image to:
   - Call the Map Network Drive dialog by clicking the appropriate button;
   - Click the standard browse button [...] to browse for the required network share or manually enter a path to it;
   - Define a letter from the pull-down list of available drive letters;
- Mark the checkbox to make this connection permanent. Otherwise it will only be available for the current Windows session;
- Click the Connect as user button at the foot of the dialog page to specify a user name and password to access the selected network share if necessary.

6. Edit the archive name if necessary.

```
Please specify the archive name. Archive name will be used as a sub-folder where backup data files will be stored.

Archive name: arc_030909071001085
Estimated archive size: 4.4 GB
Space available on backup destination: 38 GB
```

*Please take into account values of the parameters Estimated archive size and Space available on backup destination - if the archive size exceeds the available space, another network drive needs to be selected.*

7. Add comments to your backup describing its contents.

```
Please enter a short comment to describe the archive.
```

8. Choose whether to accomplish the operation immediately, set a time table for it, or generate a script.

9. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

*This operation can also be accomplished with the Linux/DOS or WinPE recovery environments.*

**Backing up a hard disk or partition to an FTP server**

To back up an entire hard disk or a separate partition and then place the resulted image to an FTP server, please do the following:

**Launcher**

1. Click the **Back up a Disk or Partition** item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Wizard’s Welcome page, click the Next button.

3. On the What to back up page, mark the appropriate option opposite a hard disk’s name or a partition’s name depending on the chosen task.
You’ve got the option to modify the default backup settings by marking the appropriate checkbox on this page.

By default the program will take into account exclude filters set in the **Settings** dialog.

4. On the Backup Destination page, select the **Save data to FTP locations** option.

5. Set up parameters for the required FTP location.

   - **Archive location.** Type in a full path to the required FTP location;
   - **Name.** Set a name for the FTP server (optional);
   - **Login.** Enter a login to access the FTP server;
   - **Password.** Enter a password to access the FTP server. Click **Remember password** to save it next time you back up to this location;
   - **Port.** Specify the required port (21 by default) and click **Use Active Mode** if necessary;
When ready, click the arrow button opposite the archive location field to check out you’ve got access to the FTP location.

---

**⚠️ You need to check out yourself Windows Firewall or programs of this kind let our program work with the required port (21 by default).**

6. If yes, you’ll get a new item on the list named after the selected FTP location. By clicking the + icon you can browse it to specify a more exact location for your backup image.

![Archive Location](image)

7. Edit the archive name if necessary.

![Archive Details](image)

8. Add comments to your backup describing its contents.

![Comment](image)

9. Choose whether to accomplish the operation immediately, **set a time table for it**, or **generate a script**.

10. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

---

**⚠️ This operation can also be accomplished with the WinPE recovery environment.**

---

**Backing up a dual boot Mac to an external USB drive**

To back up a dual boot Mac (Mac OS X and Windows XP/Vista/7) and then place the resulted image to an external USB drive, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

   **Recovery Media Builder** can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

   **⚠️** To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. Connect an external USB drive to the computer.

3. Restart the computer. It will be automatically started up into the Linux recovery environment (**Normal Mode**), since it’s the only mode that provides support for Mac computers.
4. In the Linux launch menu select **Hard Disk Manager**.

5. Launch the Backup Wizard by selecting in the Main Menu of the program: **Wizards > Backup Wizard**.

6. On the Wizard's Welcome page, click the Next button.

7. On the What to back up page, select your Mac hard disk.

8. On the Backup Destination page, select the **Save data to any local drive or a network share** option.
9. Select an external USB drive as a backup destination.

10. Edit the archive name if necessary.

Please take into account values of the parameters Estimated archive size and Space available on backup destination - if the archive size exceeds the available space, another drive needs to be selected.

11. Add comments to your backup describing its contents.

12. Choose whether to accomplish the operation immediately or generate a script.
13. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

---

This operation can also be accomplished with the WinPE recovery environment or under Windows.

---

**Backing up files to a local mounted/unmounted (without drive letter assigned) partition**

To back up required files or folders and then place the resulted image to a local mounted/unmounted drive, please do the following:

**Launcher**

1. Click the **Back up Files** item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Wizard’s Welcome page, click the Next button.

3. On the What folders and files to back up page you can see a list of all partitions (both mounted and unmounted) available in the system. Mark a checkbox opposite a file, folder or even a whole partition to build up contents of the future backup image.

4. On the Backup Destination page, select a local mounted/unmounted (without drive letter assigned) disk as a backup destination.
5. Edit the archive name if necessary.

![Archive name](image)

6. **Specify include masks.** The program includes a lot of ready-made filters to effectively control contents of your backup images.

![Include masks](image)

You can also create your own filter by clicking the **Add category...** button.

![Add category](image)

- **Name.** Give to the filter any name you like, but try to use an informative one;
• **Filter.** Press the Browse button to select files or folders you would like to be included or specify a filter mask by using * or ? wildcards;

• **Description.** Add a short description to the filter not to miss it up later.

Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox opposite its name you can choose whether to use it or not.

---

**By setting an include mask, you automatically ignore files that do not match to it, thus they won’t be added to the backup image.**

7. **Specify exclude masks.** The program includes a lot of ready-made filters to effectively control contents of your backup images.

![Exclude masks window](image)

---

8. Add comments to your backup describing its contents.

![Comment field](image)

9. Choose whether to accomplish the operation immediately, **set a time table for it,** or **generate a script.**

10. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

---

**This operation can also be accomplished with the WinPE recovery environment.**

---

**Creating a differential to a full partition backup**

To update an image of the selected partition, please do the following:

**Launcher**

1. Click the **Differential Partition Backup** item of the Wizards menu.
2. On the Wizard's Welcome page, click the Next button.

3. On the Browse for Archive page, specify the required full (base) partition archive:

   • By clicking the **Switch to Archive List View** link, you can see a list of images contained in the Archive Database (if any).

![Archive List View](image1)

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description.

---

!! To know more on the subject, please consult the [Viewing Image Properties](#) chapter.

---

• By clicking the **Switch to File View** link, you can find the required image in the browser-like window. The section below (i.e. Archive File Details) will also display a short description of the selected image.

![File View](image2)
157

To know more on the subject, please consult the Viewing Image Properties chapter.

4. The Archive Content page displays detailed information about the contents of the archive. It includes a full description of properties about the partition. In addition, there is the possibility to modify backup settings. To activate the advance mode, you need to mark the appropriate option at the foot of the page.

5. On the Backup Destination page, select where you want to place your backup image.

6. Edit the archive name if necessary.

Please take into account values of the parameters Estimated archive size and Space available on backup destination - if the archive size exceeds the available space, another drive needs to be selected.

7. Add comments to your backup describing its contents;
8. Choose whether to accomplish the operation immediately, set a time table for it, or generate a script.

9. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

After the operation is completed you receive a differential backup of the selected partition. It is placed into the specified destination (a local or network disk, the Backup Capsule or a CD/DVD disc), its features defined by the wizard.

⚠️ This operation can also be accomplished with the WinPE recovery environment.

Creating an increment to a full partition backup
To update only files you need since the last full partition backup, please do the following:

Launcher

1. Click the **Create File Complement**... item of the Wizards menu.

2. On the Wizard's Welcome page, click the Next button.

3. On the Browse for Archive page, specify the required full (base) partition archive:
   - By clicking the **Switch to Archive List View** link, you can see a list of images contained in the Archive Database (if any).

   ![Switch to Archive List View](image)

   To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description.

   ![Archive File Details](image)

   To know more on the subject, please consult the Viewing Image Properties chapter.

   - By clicking the **Switch to File View** link, you can find the required image in the browser-like window. The section below (i.e. Archive File Details) will also display a short description of the selected image.
4. On the What folders and files to back up page you can see contents of the selected partition archive. Mark a checkbox opposite a file or folder to build up contents of the future incremental image.

5. **Specify include masks.** The program includes a lot of ready-made filters to effectively control contents of your backup images.
You can also create your own filter by clicking the **Add category**... button.

- **Name.** Give to the filter any name you like, but try to use an informative one;
- **Filter.** Press the Browse button to select files or folders you would like to be included or specify a filter mask by using * or ? wildcards;
- **Description.** Add a short description to the filter not to miss it up later.

Click the OK button and you will get a new item on the list of filters. By marking/unmarking a checkbox opposite its name you can choose whether to use it or not.

---

**By setting an include mask, you automatically ignore files that do not match to it, thus they won't be added to the backup image.**

---

6. **Specify exclude masks.** The program includes a lot of ready-made filters to effectively control contents of your backup images.
7. Add comments to your backup describing its contents.

8. Choose whether to accomplish the operation immediately, set a time table for it, or generate a script.

9. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

After the operation is completed you receive an incremental backup of the selected partition archive containing information specified in the wizard. It is placed into the same destination as the base image.

---

**This operation can also be accomplished with the WinPE recovery environment.**

---

**Creating an increment to a full file backup**

To update a file backup, please do the following:

**Launcher**

1. Click the Incremental File Backup item of the Wizards menu.

2. On the Wizard’s Welcome page, click the Next button.

3. On the Browse for Archive page, specify the required full (base) file archive:
   - By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive Database (if any).
To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description.

To know more on the subject, please consult the Viewing Image Properties chapter.

- By clicking the Switch to File View link, you can find the required image in the browser-like window. The section below (i.e. Archive File Details) will also display a short description of the selected image.

After the operation is completed you receive an incremental backup of the selected file archive. It is placed into the same destination as the base image.

This operation can also be accomplished with the WinPE recovery environment.

**Back up with Smart Backup Wizard**

To let Smart Backup Wizard help you back up exactly what you need and then place the resulted image to the required location, please do the following:
Launcher

1. Click the **Smart Backup** item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Wizard's Welcome page, click the Next button.

3. On the What to back up page, click on the section you find answering to your task.

- **Disk or Partitions** to create a sector-based backup of the whole disk system, or only separate partitions;
- **E-mail** to create a file-based backup of e-mail databases, accounts and address books of MS Outlook, MS Express, and Windows Mail;
- **Media Files** to create a file-based backup of all media files (photo, video, music, etc) stored in the My Documents folder;
- **Documents** to create a file-based backup of all office documents stored in the My Documents folder;
- **Other Files and Folders** to create a file-based backup of any files and folders.

4. Depending on your choice you’ll either need to specify more exactly the object of operation and then choose location for the resulted backup (relevant for **Disk or Partitions** or **Other Files and Folders**), or just choose location for the resulted backup (for all the others).

   To know more on how to specify the object of operation for sector and file backups as well as location for the resulted backup file, please consult the other backup scenarios.

5. Add comments to your backup describing its contents.

6. Choose whether to accomplish the operation immediately, set a time table for it, or generate a script.

7. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

**Creating a cyclic partition backup**

To automate the partition backup process, please do the following:
1. Launch the Cyclic Backup Wizard by selecting in the Main Menu: Wizards > Backup Utilities > Cyclic Backup...

2. On the Wizard's Welcome page, click the Next button;

3. On the What to back up page, select a partition you want to make a cyclic backup of;

! The current version of the program enables to make a cyclic backup of only one partition at a time.

4. On the Backup Destination page, select a mounted/unmounted partition, a network share, or an FTP server to place backup images to.

5. Edit the archive name if necessary.
Please take into account values of the parameters Estimated archive size and Space available on backup destination - if the archive size exceeds the available space, another drive needs to be selected.

6. Add comments to your backup describing its contents.

7. Set a timetable for the operation.

To know more on the subject, please consult the Task Scheduling chapter.

8. On the Cyclic backup type page, choose the way of creating a cyclic backup:

- **Base type.** Every image created during the operation will be made as a full archive.
- **Differential type.** Every first image will be made as a full (base) archive and all the others will be differentiated from it. This operation requires much less space, thus considerably saving your system resources.

By setting the **Maximum disk space to store images** and the **Maximum number of images to store** parameters you may define when the operation will be cycled. That means that on exceeding these two parameters the
oldest archives will be automatically overwritten (if choosing the Differential type only differential images will be overwritten).

9. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

The operation will run according to the set timetable. The resulted backup images will be placed into the specified destination (a local or a network disk), its features defined by the wizard.

**Merging a full partition backup with one of its differentials**

To merge a full partition backup with one of its differentials, thus getting a new full partition archive, please do the following:

**Launcher**

1. Click the **Synthetic Backup** item of the Wizards menu.

2. On the Wizard’s Welcome page, click the Next button.

3. On the Browse for Archive page, you only need to specify the required differential archive. The program then will automatically find its base image:
   - By clicking the **Switch to Archive List View** link, you can see a list of images contained in the Archive Database (if any).

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description.

To know more on the subject, please consult the **Viewing Image Properties** chapter.
• By clicking the **Switch to File View** link, you can find the required image in the browser-like window. The section below (i.e., Archive File Details) will also display a short description of the selected image.

   ![Switch to Archive List View](image)

   ![Archive File Details](image)

---

⚠️ **To know more on the subject, please consult the Viewing Image Properties chapter.**

4. On the Synthesis Settings page you can additionally modify any property of the selected backup image if necessary. To accomplish our task we have no need to change anything at all.

   ![Backup image options](image)

5. On the Synthetic Archive Destination page, select where you want to place the resulted backup image.
6. Edit the archive name if necessary.

![Archive details]

Please take into account values of the parameters Estimated archive size and Space available on backup destination - if the archive size exceeds the available space, another drive needs to be selected.

7. Add comments to your backup describing its contents;

![Comment field]

8. On the Synthesis Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

![Synthesis Summary]

After the operation is completed you receive a new full partition archive. It is placed into the specified destination (a local or network disk, or a CD/DVD disc), its features defined by the wizard.

This function is currently unavailable for modification of entire hard disk backups.

This operation can also be accomplished with the WinPE recovery environment.
Recovery Scenarios

Fixing MBR after a boot virus attack
Let’s assume that the MBR (Master Boot Record) of your hard disk has been corrupted as a result of a boot virus attack, thus your system fails to boot.

To fix the MBR of your hard disk, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. In the boot menu select **Normal Mode** to use the Linux recovery environment (more preferable) or **Safe Mode** to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the **Low-Graphics Safe Mode** (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.

By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. In the Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.
4. On the Wizard's Welcome page, select the **Correct the Master Boot Record (MBR)** option.

5. On the next page choose the required hard disk from the pull-down list (if several) and then select the **Update the MBR executable code** option.

6. Confirm the operation.

7. After the operation is completed click the Report button to see a well informative summary page. The program also enables to store the resulted report. To do that, just press the Save button and choose the exact location in the opened dialog.
8. Click the Finish button to close Boot Corrector.

9. Reboot the computer.

Fixing Windows startup ability
Let’s assume that due to an unknown reason your Windows fails to complete the startup procedure. At first everything seems quite OK, you can see the standard startup messages on the screen, but at some moment it hangs up.

To fix your Windows startup ability, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

   Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

   To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.
By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. In the Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.

4. On the Wizard's Welcome page, select the **Search for Windows installations to correct** option.

5. On the next page choose the required Windows installation from the list of found installations (if several), then select the **Edit the Boot.ini file** option. If you’re not sure which installation you need, please use the Properties button to get more info on the selected item.
6. Examine the file – maybe that’s where the problem is. If it contains a mistake, correct it by using the appropriate buttons.

7. If the Boot.ini file does not contain any mistake, please return to the Correct Windows Installations page to correct drive letters in the Windows System Registry.
8. On the next page choose a hard disk from the pull-down list (if several), then the required partition. If you’re not sure which installation you need, please use the Properties button to get more info on the selected item.

9. Click the Edit Letters button to correct an existing drive letter or assign a new one in the Windows System Registry.

10. Once you’ve assigned the appropriate drive letter, close the dialog, then click the Apply button.
11. Confirm the operation.

![Image of Apply the changes? dialog with options Yes and No]

12. After the operation is completed click the Report button to see a well informative summary page. The program also enables to store the resulted report. To do that, just press the Save button and choose the exact location in the opened dialog.

![Image of Reporting dialog with a report summary]

13. Click the Finish button to close Boot Corrector.

14. Reboot the computer.

Restoring a hard disk from the bootable Backup Capsule

Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical files. But you’ve got the bootable backup capsule containing a backup of your hard disk. That’s just enough to easily get your system back on track again.

To restore your hard disk from a backup image contained in the backup capsule when the current OS is down, please do the following:

1. Start up the computer from the bootable backup capsule. By default, the program offers to use the F1 hot key to boot from it.

![Image of boot options with Boot Environment, Normal Mode, and Safe Mode]
This scenario implies that the backup capsule is bootable.

2. In the boot menu select **Normal Mode** to use the Linux recovery environment (more preferable) or **Safe Mode** to use the PTS DOS recovery environment (in case you’ve got problems with Linux).

**By default the Normal Mode will be automatically initiated after a 10 second idle period.**

3. In the Linux launch menu select the Simple Restore Wizard. You can find the same wizard in PTS DOS as well.

4. On the Wizard’s Welcome page, click the Next button.

5. On the What to Restore page, you can see a list of available images (if several). Most likely the required archive will be there too. If not, click the standard browse button [...] to find it. When you find your image, double click on it to proceed.

6. On the Image Properties page, make sure that you select the correct image by viewing the provided information about the archive.
7. On the next page specify a hard disk to restore the image to (if several in your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we actually need.

You can also make the program resize the on-disk partitions proportionally if necessary by marking the appropriate checkbox.

- All contents on the disk selected for restoring purposes will be deleted during the operation.

8. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next button to initiate the restore process.

9. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.
10. After completing the operation close the wizard and reboot the computer.

This operation can also be accomplished with the WinPE recovery environment.

To make a Win2K+ operating system bootable on different hardware, please additionally complete the **P2P Adjust OS Wizard**.

Restoring a system partition from external media (CD/DVD)

Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical files. But you’ve got a backup of your system partition on a bootable DVD disc. That’s just enough to easily get your system back on track again.

To restore your system partition from a backup image located on CD/DVD when the current OS is down, please do the following:

1. Insert a CD/DVD disc containing the previously prepared backup image into a CD/DVD drive (the BIOS must be enabled to boot the system from the CD/DVD device).

   **This scenario implies that you have got a bootable archive on your CD/DVD.**

   **In case the backup image is stored on several CD/DVD disks, please insert the first one.**

2. Restart the computer.

3. In the boot menu select **Normal Mode** to use the Linux recovery environment (more preferable) or **Safe Mode** to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the **Low-Graphics Safe Mode** (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.
By default the Normal Mode will be automatically initiated after a 10 second idle period.

4. In the PTS DOS launch menu select the Simple Restore Wizard. You can find the same wizard in Linux as well.

5. On the Wizard's Welcome page, click the Next button.

6. On the What to Restore page, you can see a list of available images (if several). Most likely the required archive will be there too. If not, click the standard browse button [...] to find it. When you find your image, double click on it to proceed.
7. On the Image Properties page, make sure that you select the correct image by viewing the provided information about the archive.

![Partition preview](Image)

8. On the next page specify a hard disk, then one of its partitions to restore the image to (if several in your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we actually need.

![Disk drive](Image)

---

**Warning:** All contents on the partition selected for restoring purposes will be deleted during the operation.

9. On the Partition Start and Size page you can change size of the partition and its location if necessary.

![Partition preview](Image)

10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next button to initiate the restore process.
11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

12. After completing the operation close the wizard, and then reboot the computer.

---

This operation can also be accomplished with the WinPE recovery environment.

⚠️ To make a Win2K+ operating system bootable on different hardware, please additionally complete the **P2P Adjust OS Wizard**.

---

**Restoring a system partition from a network drive**

Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical files. But you’ve got a backup of your hard disk on a remote backup server. That’s just enough to easily get your system back on track again.

To restore your system partition from a backup image located on a network drive, please do the following:

1. Start up the computer from our WinPE recovery media.

   **Recovery Media Builder** can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

   ⚠️ To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. Once it has been loaded, read the agreement and then mark the appropriate checkbox to accept.
3. Once you accept the agreement, you will see the Universal Application Launcher. Select the Restore Wizard.

4. On the Restore Wizard's Welcome page, click the Next button.

5. On the Browse for Archive page you need to specify the required backup image. So you should take the following steps to do that:

   - Select **Network** as a backup destination;

   - Map a network disk where your archives are placed:
     - Call the Map Network Drive dialog by clicking the appropriate button;
- Click the standard browse button [...] to browse for the required network share or manually enter a path to it;

- Define a letter from the pull-down list of available drive letters;

- Click the Connect as user button at the foot of the dialog page to specify a user name and password to access the selected network share if necessary.

You can also map a network disk with Network Configurator.

- Choose the required archive in the browser-like window. The Archive File Details section displays a short description of the selected image.

6. The What to Restore page displays detailed information about the contents of the archive. Select the required item to restore. In our case it is the first partition of the disk.
7. On the Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if several in your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we actually need.

8. On the Restore Results page you can see the resulted disk layout. Besides there’s the possibility to change size of the partition and its location if necessary as well as assign a particular drive letter.

9. On the next page of the wizard confirm the operation by selecting the appropriate option.
10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Mark the checkbox at the bottom of the window to automatically switch off the computer on the successful accomplishment of the restore operation.

11. After completing the operation close the wizard, and then reboot the computer.

This operation can also be accomplished with the Linux/DOS recovery environment.

To make a Win2K+ operating system bootable on different hardware, please additionally complete the P2P Adjust OS Wizard.

Restoring a system partition from a local drive

Let’s assume that your operating system gives trouble after having installed brand new software. But you’ve got a backup of the system partition on a local disk. That’s just enough to easily roll it back to the point when run smoothly.

To restore your system partition from a backup image located on a local disk, please do the following:

Launcher

1. Click the Restore item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Restore Wizard's Welcome page, click the Next button.

3. On the Browse for Archive page, specify the required archive:
   
   - By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive Database (if any).
To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description.

⚠️ To know more on the subject, please consult the Viewing Image Properties chapter.

- By clicking the Switch to File View link, you can find the required image in the browser-like window. The section below (i.e. Archive File Details) will also display a short description of the selected image.

⚠️ To know more on the subject, please consult the Viewing Image Properties chapter.
4. On the Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if several in your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we actually need.

![Image of hard disk selection]

**Warning:** All contents on the partition selected for restoring purposes will be deleted during the operation.

5. On the Restore Results page you can see the resulted disk layout. Besides there’s the possibility to change size of the partition and its location if necessary as well as assign a particular drive letter.

![Image of disk layout after changes]

6. Complete the wizard and then apply the pending changes.

![Image of apply pending changes dialog]

7. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the appropriate button to agree.
8. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

After completing the operation the program will automatically reboot the computer.

This operation can also be accomplished with the Linux/DOS or WinPE recovery environments.

To make a Win2K+ operating system bootable on different hardware, please additionally complete the P2P Adjust OS Wizard.

Restoring a dual boot Mac from an external USB drive
Let’s assume that your Mac fails to boot because of a hard disk malfunction. But you’ve got a backup of your hard disk on an external USB drive. Just replace the failed disk with a new one and carry out a bare metal restore.
To restore a dual boot Mac from a backup image located on an external USB drive, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

   Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

   To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. Connect an external USB drive to the computer.

3. Restart the computer.

4. In the boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode that enables to work with USB devices.

   By default the Normal Mode will be automatically initiated after a 10 second idle period.

5. In the Linux launch menu select the Simple Restore Wizard.

6. On the Wizard's Welcome page, click the Next button.
7. On the What to Restore page, click the standard browse button [...] to find the required archive. When done, double click on it to select.

8. On the Image Properties page, make sure that you select the correct image by viewing the provided information about the archive.

9. On the next page specify a hard disk to restore the image to.
All contents on disk selected for restoring purposes will be deleted during the operation.

10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next button to initiate the restore process.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

12. After completing the operation close the wizard, and then reboot the computer.

Restoring a file increment

Let’s assume that you’re busy with developing some project and you make file increments of it on a day-to-day basis not to lose valuable information. So you’ve got a file backup chain. One day you understand that the job of the last three days is a complete and utter failure. Don’t give up – recover your project to the state when everything’s ok.

To restore a file increment, please do the following:

Launcher

1. Click the Restore item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Restore Wizard's Welcome page, click the Next button.

3. On the Browse for Archive page, specify the required file increment:
• By clicking the **Switch to Archive List View** link, you can see a list of images contained in the Archive Database (if any).

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description.

To know more on the subject, please consult the **Viewing Image Properties** chapter.

• By clicking the **Switch to File View** link, you can find the required image in the browser-like window. The section below (i.e. Archive File Details) will also display a short description of the selected image.

To know more on the subject, please consult the **Viewing Image Properties** chapter.
4. On the How to Restore page specify the way your archive will be restored. In our case we’d rather restore contents of the backup to its original location with replacing existing files as well.

5. Complete the wizard and then apply the pending changes.

6. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

This operation can also be accomplished with the WinPE recovery environment.

Restoring a file increment to a partition backup
Let’s assume that your operating system gives trouble because of a virus attack. But you’ve got a backup of your system partition on a local disk. Besides you make file increments of your documents and e-mail database to that backup on a regular basis. That’s just enough to easily roll everything back to the point when run smoothly.
To restore your system partition with a file increment from a backup image located on a local disk, please do the following:

**Launcher**

1. Click the **Restore** item of the Wizards menu (any of the ways described earlier can also be used here).
2. On the Restore Wizard's Welcome page, click the Next button.
3. On the Browse for Archive page, specify the required file increment archive to your system partition backup:
   - By clicking the **Switch to Archive List View** link, you can see a list of images contained in the Archive Database (if any).

   ![Archive List View](image)

   To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File Details) display a short description.

   ![Archive File Details](image)

   To know more on the subject, please consult the **Viewing Image Properties** chapter.

   - By clicking the **Switch to File View** link, you can find the required image in the browser-like window. The section below (i.e. Archive File Details) will also display a short description of the selected image.
4. On the How to Restore File Complement page select whether you want to restore both, the partition archive and the desired file increment or just the file increment. In our case we choose the first option.

5. On the Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if several in your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we actually need.

- All contents on the partition selected for restoring purposes will be deleted during the operation.

6. On the Restore Results page you can see the resulted disk layout. Besides there’s the possibility to change size of the partition and its location if necessary as well as assign a particular drive letter.
7. Complete the wizard and then apply the pending changes.

8. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the appropriate button to agree.

9. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.
After completing the operation the program will automatically reboot the computer.

⚠️ This operation can also be accomplished with the WinPE recovery environment.

**Copying of data from the corrupted system disk to another hard disk**

To retrieve valuable information from your hard disk and copy it to another hard disk when the system fails to boot, please do the following:

1. Connect the second hard disk to the computer.
2. Start up the computer from our Linux/DOS recovery media.

**Recovery Media Builder** can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

⚠️ To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

3. In the boot menu select **Normal Mode** to use the Linux recovery environment (more preferable) or **Safe Mode** to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the **Low-Graphics Safe Mode** (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.
By default the Normal Mode will be automatically initiated after a 10 second idle period.

4. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.

5. On the Wizard’s Welcome page, click the Next button.

6. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.
Click the Calc button to estimate the resulted data size.

8. On the Select Destination Type, choose the way the data will be stored. Select the **Save data to any local drive or a network share** item.

   Please select how would you like to save the data:

   - **Save data to any local drives or a network share**
     Choose this option if you want to save your data to local mounted or physical partition, to USB or FireWare external drives and to a mounted network share. You will be prompted to choose a location you want to save the archive to.

   - **Burn data to CD/DVD**
     Choose this option if you want the Wizard to burn the data to CD or DVD. You will be prompted to choose a CD or DVD RW drive.

9. On the Select Destination Path page, select a hard disk to copy the data to by pressing the standard browse button [...].

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.
12. After the operation is completed, close the wizard by pressing the appropriate button.

13. Turn off the computer.

⚠️ This operation can also be accomplished with the WinPE recovery environment.

---

**Burning of data from the corrupted system disk to CD/DVD**

To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to boot, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

   **Recovery Media Builder** can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

   ⚠️ To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. In the boot menu select **Normal Mode** to use the Linux recovery environment, since it’s the only mode that enables to burn CD/DVD discs.

   ⚠️ By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
4. On the Wizard's Welcome page, click the Next button.

5. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.

6. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Click the Calc button to estimate the resulted data size.
7. On the Select Destination Type, choose the way the data will be stored. Select the **Burn data to CD/DVD** item.

   Please select how would you like to save the data:
   - **Save data to any local drives or a network share**
     Choose this option if you want to save your data to local mounted or physical partition, to USB or FireWare external drives and to a mounted network share. You will be prompted to choose a location you want to save the archive to.
   - **Burn data to CD/DVD**
     Choose this option if you want the Wizard to burn the data to CD or DVD. You will be prompted to choose a CD or DVD RW drive.

8. On the Choose a Recorder page, select a recorder from the list of available devices and then set a volume label by entering it in the appropriate field.

   ![](Vendor|Product|Type)
<table>
<thead>
<tr>
<th>Vendor</th>
<th>Product</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optiarc</td>
<td>DVD RW AD-7170A</td>
<td>CD-R, CD-RW, DVD-R</td>
</tr>
</tbody>
</table>

   Volume label:  **My Data**

9. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the operation.

10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

11. After the operation is completed, close the wizard by pressing the appropriate button.

12. Turn off the computer.

   **This operation can also be accomplished with the WinPE recovery environment.**
Copy your data from a backup to the corrupted system partition

The system fails to boot since some files are damaged. If you have a backup of the system partition, you can recopy these files to make the system operable again:

1. Start up the computer from our Linux/DOS recovery media.

   Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

   To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.

   ![Normal Mode](image)

   By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.

4. On the Wizard’s Welcome page, click the Next button.
5. Select a disk where the system backup is stored from the pull-down list in the right pane of the page.

6. Double click on the required backup to open.

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Click the Calc button to estimate the resulted data size.

8. On the Select Destination Type, choose the way the data will be stored. Select the **Save data to any local drive or a network share** item.
9. On the Select Destination Path page, select your system disk to copy the data to by pressing the standard browse button [...].

![Select path window](image)

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

![Operations list](image)

12. After the operation is completed, close the wizard by pressing the appropriate button.

13. Turn off the computer.
This operation can also be accomplished with the WinPE recovery environment.

Restoring separate files and folders from a backup

The program provides a very convenient option to access backup archives and restore only data you need (the so called selective restore functionality). This operation can be accomplished either with the Restore Wizard, File Transfer Wizard or Volume Explorer.

**Restore Wizard**

To restore separate files and folders from a backup image with the Restore Wizard, please do the following:

1. Start up the computer from our WinPE recovery media.

   **Recovery Media Builder** can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

   To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. Once it has been loaded, read the agreement and then mark the appropriate checkbox to accept.

   If you do not agree with any conditions stated there, you won’t be able to use the program.

3. Once you accept the agreement, you will see the Universal Application Launcher. Select the Restore Wizard.

4. On the Restore Wizard's Welcome page, click the Next button.

5. On the Browse for Archive page choose the required archive in the browser-like window. The Archive File Details section displays a short description of the selected image.
6. On the next page specify what you need to extract from the backup by marking checkboxes next to the required data items. At the right lower corner of the window you can see the resulted amount of the selected data.

7. On the How to Restore page specify the way the selected data will be restored. In our case we’d rather restore contents of the backup to its original location with replacing existing files as well.

8. On the Restore Summary page review all parameters of the operation and modify them if necessary.
9. On the next page of the wizard confirm the operation by selecting the appropriate option.

10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

11. After completing the operation close the wizard, and then reboot the computer.

⚠️ This operation can also be accomplished under Windows.

**File Transfer Wizard**

To restore separate files and folders from a backup image with the File Transfer Wizard, please do the following:

**Launcher**

1. Call the popup menu for the required backup image (right click of the mouse button) in the Archive Database and then select the menu item: Restore File from Archive. Thus you automatically open it with the File Transfer Wizard.

2. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.
3. On the Select Destination Type, choose the way the data will be stored. Select the **Save data to any local drive or a network share** item.

4. On the Select Destination Path page, specify the exact place to copy the data to.

5. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the operation.

6. After the operation is completed, close the wizard by pressing the appropriate button.

**Volume Explorer**

To restore separate files and folders from a backup image with Volume Explorer, please do the following:
Launcher

1. Click the Disk View tab and then choose Volume Explorer;

2. Browse for the required archive and then open it by double click of the left mouse button.

3. Call the popup menu (right click of the mouse button) for a file/folder you need and then select the Export item.

4. Select a place on the disk where the file/folder will be extracted to.
5. Click the OK button to accomplish the operation.

The current version of the program does not enable to access file archives with Volume Explorer.

Resize Scenarios

Creating a new partition to detach operating system from the rest of data
Let’s assume that you’re a rank and file user who is most likely to have only one hard disk with only one partition (the only partition is always system). To secure yourself against a system malfunction or a virus attack you’ve got nothing to do, but make a backup of the whole partition, which besides the operating system itself contains all your family photos, favorite films and music, program distributives, whatever. As a result you’ll get a very huge backup image. You can easily tackle this issue however by detaching your operating system from the rest of data.

To create a new partition on your hard disk, please do the following:

Express Launcher

Click Switch to Full Scale Launcher in the Express Launcher.

1. Click the Express Create Partition item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Wizard's Welcome page, click the Next button.

3. Choose a method you find the most suitable to create the partition. The wizard is especially designed to minimize your participation in finding an appropriate place for it and its resulted size. The only thing you’re to do is to choose between several modes. The most relevant thing here is the amount of space that will be allocated for that partition. For easy perception, you can see the resulted disk layout on the disk map by selecting this or that mode.
The number of available methods depends on your disk layout.

To learn more on the way the wizard works, please click the corresponding link on the first page of the wizard.

4. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do with the system partition resize, like we do in our case, you will be asked to restart your computer in a special boot-up mode to accomplish the operation. So click the appropriate button to agree.

5. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment.
After completing the operation your computer will be automatically restarted back to Windows where you can see the newly created NTFS partition. Now you’ve got a place to keep your stuff apart from Windows.

**Increasing size of a system partition by taking unused space of an adjacent partition**

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from an adjacent partition, please do the following:

**Express Launcher**

1. Click the **Partitioning** button and then select **Resize Partitions**.

2. On the Wizard’s Welcome page, click the Next button.

3. Click on your system partition. By doing that, the wizard will automatically select an adjacent partition as well. This partition will later act as a space donor.

---

**Important Note:**

If you’ve got more than two partitions on your hard disk and a partition you need to increase is surrounded by other partitions, you’ve got the choice to choose which partition will act as a space donor. Just click on the left partition of the pair, as the right one will be
4. Increase size of the system partition with the slider or manually by entering the required value. Please note, when you change size of one partition the size of the other will be changed as well, thus redistributing the unused space between the partitions.

![Image of partition settings](image)

5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option.

![Image of confirmation options](image)

6. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do with the system partition resize, like we do in our case, you will be asked to restart your computer in a special boot-up mode to accomplish the operation. So click the appropriate button to agree.

![Image of system restart confirmation](image)

7. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment.

![Image of progress window](image)
After completing the operation your computer will be automatically restarted back to Windows where you can see that your system partition is bigger now.

**Increasing size of a system partition by taking unused space from any other**

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming applications and system updates your system partition has started to suffer from the lack of free space. But one of your partitions has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from any other on-disk partition, please do the following:

**Express Launcher**

Click **Switch to Full Scale Launcher** in the Express Launcher.

1. In the main window select the required hard disk (if several) on the Disk Map.

2. Choose a space donor partition and then call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.
3. In the opened dialog shift the edge of the partition to the right by the drag-and-drop technique. While doing this, free space from the partition will be released (displayed in aqua-green). You can also do it manually by entering the exact size of free space. Click the Yes button to continue.

4. Now you’ve got a block of free space to add to the system partition. You cannot do it directly however, but by carrying out a number of extra move/resize operations.
5. Since the block of free space is within the extended partition, you need to take it out first. The program enables to resize the extended partition only when there’s a block of free space adjoining its borders. In our case it’s between two logical disks. So we need to move it. To do that, please select the first logical partition and then call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.

6. At first shift the right edge of the partition to the right, then do the same with the left edge. Make sure the partition size has been left unchanged.

7. Now you can resize the extended partition to take the block of free space out of it. Call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.

8. In the opened dialog shift the edge of the extended partition to the right.
9. The block of free space has been released.

10. Now you need to move the second primary partition just the way we did it with the logical partition to make the block of free space adjoin the system partition.

11. Finally increase size of the system partition. Call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.

12. In the opened dialog shift the edge of the partition to the right, thus increasing its size.

13. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual Operations Bar.
14. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the appropriate button to agree.

Shrinking a system partition to increase size of a data partition

Let’s assume you’ve got two partitions on your hard disk, the first one takes about 40% of all the disk space and is exclusively used for Vista 64-bit, while the second servers as a data storage. One day you realize that your system partition doesn’t need so much disk space, that’s what your data partition really requires at the moment. You can easily tackle this problem with Paragon Linux/DOS Recovery CD.

To increase size of a data partition by taking unused space from a system partition, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

   *Recovery Media Builder* can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

   !WARNING TO automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. In the boot menu select **Normal Mode** to use the Linux recovery environment (more preferable) or **Safe Mode** to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the **Low-Graphics Safe Mode** (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.

   ![Normal Mode](image)

   By default the **Normal Mode** will be automatically initiated after a 10 second idle period.

3. In the Linux launch menu select **Hard Disk Manager**. You can find it in PTS DOS as well.
4. In the main window select the required hard disk (if several) on the Disk Map.

5. Choose your system partition and then call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.

6. In the opened dialog set a new size for the partition by moving the slider or by entering the exact value in the appropriate field. While doing this, free space from the partition will be released (displayed in aqua-green). Click OK to continue.
7. Now you’ve got a block of free space to add to your data partition.

8. Choose the data partition and then call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.

9. Move the slider to the right to increase size of the partition. Click OK to continue.

10. Apply the pending changes.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.
Resizing partitions of Apple Boot Camp

Let’s assume you’re a Boot Camp user who’s got Windows XP as the second operating system. Initially allocated space for the Windows partition has turned out to be insufficient for your current needs. The only way out is to take some space from your Mac partition, thus redistributing the unused space between the partitions.

To increase size of the Windows partition by taking unused space from the Mac partition, please do the following:

Express Launcher

1. Click the Partitioning button and then select Resize Partitions.

2. On the Wizard’s Welcome page, click the Next button.

3. The wizard will automatically select Windows (the NTFS file system) and Mac (the Apple HFS file system) partitions of your Boot Camp configuration.

   On the disk map you can also see the GPT service partition (called EFI) as well as a 128-megabyte free block between Mac and Windows partitions made with Boot Camp. It’s just for your information.

4. Increase size of your Windows partition with the slider or manually by entering the required value. Please note, when you change size of one partition the size of the other will be changed as well, thus redistributing the unused space between the partitions.
5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option.

6. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do with the system partition resize, like we do in our case, you will be asked to restart your computer in a special boot-up mode to accomplish the operation. So click the appropriate button to agree.

7. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment.
After completing the operation your computer will be automatically restarted back to Windows where you can see that your system partition is bigger now.

Creating Dual Boot Systems

For Windows computers

Release of Windows Vista has given a new impetus to the problem of establishing a dual boot system. In this connection we decided to consider two the most frequently used situations a rank and file user may face, i.e. Windows Vista + Windows XP and Windows XP + Windows Vista. Please note that for reasons of better security and system independence these operating systems will be installed on different partitions. That is why we need to hide the first system partition before installation of the second OS.

Windows Vista + Windows XP

Suppose you have got Windows Vista coming with your brand new computer. Everything is great except one thing – your favourite applications simply reject to work correctly on it. Software updates are expected to release in the near future, but you cannot wait any more. Thus the best way out is to leave Windows Vista intact and install the time-proved Windows XP.

Most likely you have only one hard disk with only one partition (the only partition is always system). To install the second operating system you need to repartition your drive first, as it requires a separate primary partition. If this is the case, you can do your job either with the Install New OS Wizard (a specially designed tool for that) or traditionally with a number of the corresponding wizards and dialogs.

Install New OS Wizard

This scenario implies that operating systems will be installed on different partitions to provide better security and system independence.

Express Launcher

1. Click Boot Management and then select Install New OS in the Express Launcher.
2. On the Wizard’s Welcome page, click the Next button.
3. Select the appropriate option to create a new primary partition on your hard disk.

4. On the next page of the wizard, define size of the new partition. If the selected hard disk contains blocks of free space, the wizard will automatically merge them all and allocate the resulted space to create the partition. If not, it will take 50% of the unused space of an adjacent partition, thus resizing it.

5. The next page enables to specify a file system and a number of additional parameters. Since we are going to install Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to continue.

6. Enter a label for the future partition in the textual field. It will later be used for the drive identification.

7. The program will carry out all the necessary operations and then automatically restart the computer to initiate the installation process.

---

⚠️ On this page you can specify a number of additional parameters that can also be of help. However here we pay attention to the most relevant to fulfill our task.

⚠️ If you’ve changed your mind on installing a new operating system, don’t insert its distributive CD but press ESC when the following message appears:
All the mentioned above operations can also be accomplished with the WinPE recovery environment.

8. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you can find all the necessary information in documentation that comes with the product. However to avoid any problems, we consider it necessary to draw your attention on the following issues:

- You need a bootable distributive CD of Windows XP to install it;
- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from CD first or press F12 during startup to select a bootable device;
- Do not forget to select the newly created partition as destination.

9. So if everything is OK, you’ve got to have by this moment Windows XP successfully installed. Your Windows Vista however is still non-bootable. To fix this issue you need to launch the Boot Manager Setup wizard. To do that, please install our program once again, but this time in Windows XP to activate Boot Manager.

To avoid double installation, please use our WinPE recovery environment to activate Boot Manager.

10. Click Boot Management and then select Boot Manager in the Express Launcher.

11. Set up the Boot Manager wizard. The most relevant option here is the possibility to hide other primary partitions except the one selected to boot and it is by all means should be activated to make Windows Vista and Windows XP unaware of each other. The rest of the parameters offered by default will do in our case, so just complete the wizard and it will automatically find the two operating systems and update the MBR.
12. Now restart the computer to make sure you have got a dual boot system.

**Traditional way**

This scenario implies that operating systems will be installed on different partitions to provide better security and system independence.

**Express Launcher**

Click **Switch to Full Scale Launcher** in the Express Launcher.

1. In the main window select your hard disk on the Disk Map to make a block of free space on it.

2. Release some free space (not less than 10 GB to install Windows XP) from the partition. To do that, please call the context menu for the selected partition (right click of the mouse button) and launch the Move/Resize dialog.
3. In the opened dialog shift the edge of the partition to the left by the drag-and-drop technique. While doing this, free space from the partition will be released (displayed in aqua-green). You can also do it manually by entering the exact size of free space. Click the Yes button to continue.

![Image of Disk View with partition details]

> The Move/Resize dialog offers a number of additional parameters that can also be of help. However here we pay attention to the most relevant to fulfill our task.

4. Now you have a block of free space sufficient in size to hold a new partition.

![Image of Disk View with free space and new partition]  

5. Create a new partition to install Windows XP. To do that, please call the context menu for a newly created block of free space (right click of the mouse button) and launch the Create Partition dialog.
6. Define parameters of the future partition. By all means it has to be primary and since we are going to install Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to continue.

![Create Partition dialog](image1)

⚠️ The Create Partition dialog offers a number of additional parameters that can also be of help. However here we pay attention to the most relevant to fulfill our task.

7. As a result of the operation we have got a newly created FAT32 partition just enough in size to comfortably work with Windows XP.

![Basic Hard Disk 0](image2)

8. Hide the Windows Vista partition to avoid writing any data on it during the Windows XP installation, as it is the best way to provide system independence. To do that, please call the context menu for it (right click of the mouse button) and launch the Hide Partition dialog. Click the Yes button to continue.
Hiding of the system partition will make OS non-bootable, what is quite normal.

9. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual Operations Bar.

10. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the appropriate button to agree.

After all the operations are completed you will not be able to restart the system, what is quite normal. Nevertheless if you do try it, the following error will occur:

All the mentioned above operations can also be accomplished with the WinPE recovery environment.

11. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you can find all the necessary information in documentation that comes with the product. However to avoid any problems, we consider it necessary to draw your attention on the following issues:

- You need a bootable distributive CD of Windows XP to install it;
- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from CD first or press F12 during startup to select a bootable device;
- Do not forget to select the newly created partition as destination.
12. Launch the Boot Manager Setup wizard. As your Windows Vista is non-bootable any more, you need to install our program once again, but this time in Windows XP to activate Boot Manager.

**To avoid double installation, please use our WinPE recovery environment to activate Boot Manager.**

13. Click **Boot Management** and then select **Boot Manager** in the Express Launcher.

14. Set up the Boot Manager wizard. The most relevant option here is the possibility to hide other primary partitions except the one selected to boot and it is by all means should be activated to make Windows Vista and Windows XP unaware of each other. The rest of the parameters offered by default will do in our case, so just complete the wizard and it will automatically find the two operating systems and update the MBR.

15. Now restart the computer to make sure you have got a dual boot system.

*Windows XP + Windows Vista*

If you’ve got Windows XP and are willing to try the latest Windows Vista but not sure your favorite applications will flawlessly work on it, the best way out is to leave the time-proved Windows XP intact and install Windows Vista for studying purposes.

As this very situation is very close to the previous one, please use the **Windows Vista + Windows XP** scenario. However please take into consideration one more step you need to accomplish if you decide to use the traditional scenario:

1. Besides hiding of the system partition before installation of the second OS you need to make it inactive as well. To do that, please call the context menu for it (right click of the mouse button) and launch the corresponding dialog. Click the Yes button to continue;
Reviving the system partition

In case you are not able or not willing to complete the mentioned above scenarios, but have already reached the point when all changes are applied and everything is ready to install the second OS, please do the following to make your system bootable once again (only relevant for the traditional scenario):

1. Start up the computer from our Linux/DOS recovery media.

   **Recovery Media Builder** can help you prepare the Linux/DOS or WinPE recovery environment either on a CD/DVD disc or a thumb drive.

   ! Important: To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. In the Linux launch menu select **Hard Disk Manager**.

3. In the main window select your non-bootable Windows partition on the Disk Map.
4. Unhide the partition by calling the context menu for it (right click of the mouse button) and then selecting **Unhide**.

5. Only for the Windows XP + Windows Vista scenario you need to make the system partition active as well by calling the context menu for it (right click of the mouse button) and then selecting **Set Active**.

6. You will be notified after the operations are completed.
7. Restart the computer.

**System Migration and Virtualization Scenarios**

**Migrating system to another hard disk (Clone HDD)**

Let’s assume that you’ve bought a new hard disk. It’s faster and of much higher capacity than your current system disk, so it’s quite natural you start thinking about system migration. We can help you do that.

To migrate your system from one hard disk to another, please do the following:

**Launcher**

1. Connect both source and destination disks to the computer.

2. Turn on the computer.

3. Click the **Copy Disk** item of the Wizards menu (any of the ways described earlier can also be used here).

4. On the Wizard’s Welcome page, click the Next button.

5. On the Select Hard Disk to Copy page, select a source disk (a hard disk you want to copy).

6. On the Select Target Hard Disk page, select a destination disk (a hard disk to copy contents of the source disk).
During the operation all contents of the destination disk will be deleted.

7. On the next page of the wizard, define the copy options. In our case we'd rather copy data with a proportional resize to occupy the entire disk. Besides we recommend you to enable the surface test to make sure your new hard disk is flawless.

8. On the Revise Copy Results page review all parameters of the operation.

9. Complete the wizard and then apply the pending changes.
10. When copying is completed, shut down the computer.

11. Disconnect (physically) the source hard disk.

12. Boot the computer from the destination hard disk.

To make a Win2K+ operating system bootable on different hardware, please additionally complete the P2P Adjust OS Wizard.

Virtualizing the current system (P2V)

Let’s assume that you’re about to migrate to a brand-new hardware platform with the latest operating system available for it. Your current system is quite obsolete, but you still need access to some of its software. You don’t want to waste time re-installing the old software to the new system, and you do know for sure that the bulk of it won’t work anyway. The best way out is to virtualize your old system.

But before you start, please make sure the following conditions are met:

- Your hard disk has enough free space to store a virtual image of your Windows (depends on the system).
- You’ve got one of the supported virtualization software.

To make a virtual disk out of your current system, please do the following:

Launcher

1. Click the P2V Copy item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Wizard’s Welcome page, click the Next button.

3. Select either an entire hard disk or only the system partition you want to make a virtual disk of.

It’s pretty enough to select the system partition only to make your Windows start up in a virtual environment. However that doesn’t guarantee all your applications will work, as they can be installed on the other partitions of the disk.

4. Choose your virtualization software vendor and a number of additional parameters, including.
- **Type of the virtual disk.** You can either create an IDE or a SCSI virtual disk (relevant for VMware only);

- **Create a split disk.** You can choose whether to automatically cut the resulted virtual image to files of 2 GBs or not (available for VMware only);

- **Pre-allocate all disk space.** You can choose whether to pre-allocate all space of the future virtual disk, or do it dynamically;

![Select your virtualization software:](image)

Not all vendors may be available to choose. If the capacity of the selected object exceeds the maximum capacity for a certain virtual disk, its vendor will be shadowed.

5. Depending on your choice the next page of the wizard enables to set the following parameters:

**For a separate partition**

- **Size of the virtual disk.** By default the program offers to create a virtual disk exactly the size of the selected object, which you can upsize however. Please note, you can only increase size of the resulted virtual disk;

- **Take all space for the partition.** If you upsize the resulted virtual disk, you can choose whether to occupy the whole disk space by that partition or not;

- **Adjust OS to virtual hardware** to make sure the operating system will be bootable after the operation.

![Please preview the resulting layout of the virtual disk before you proceed:](image)

**For a hard disk**

- **Size of the virtual disk.** By default the program offers to create a virtual disk exactly the size of the selected object, which you can resize however.
- **Resize partitions proportionally.** If you upsize the resulted virtual disk, you can make the program proportionally change the size of partitions keeping their relative order intact.

- **Adjust OS to virtual hardware** to make sure the operating system will be bootable after the operation.

The maximum limit you can downsize the virtual disk is the capacity of its first partition.

6. On the next page of the wizard set a file name for the resulted virtual disk and its location. Besides you can also provide a path to the integration package of your virtualization software.

It’s strongly recommended to provide a path to VM Tools/Additions ISO image if you transfer Windows XP to a VMware SCSI disk, otherwise your system won’t boot after the operation.

7. The wizard will provide a detailed report on successful accomplishment of the operation. You can save it by clicking the appropriate button.
8. **Now you can connect the resulted virtual disk to your virtual machine.** Your system has been virtualized.

---

⚠️ **You need to close the program to unlock the virtual disk. Otherwise you won’t be able to connect it to a virtual machine.**

---

**Virtualizing system from its backup image (P2V)**

Let’s assume that your system has been corrupted as a result of a hardware failure. You realize it’s quite obsolete and it’s next to impossible to replace the damaged hardware devices. Migration to a new hardware platform seems the best way out, if not for one thing – you still need access to your software, but you do know for sure that the bulk of it won’t work on the new platform. Luckily you’ve got a backup image of your old system made with Paragon software – that’s just enough for its virtualization.

But before you start, please make sure the following conditions are met:

- You’ve got a backup image of your Windows.

- Your hard disk has enough free space to store a virtual image of your Windows (depends on the system).

- **You’ve got one of the supported virtualization software.**

To make a virtual disk out of your old system backed up with a Paragon disaster recovery tool, please do the following:

**Launcher**

1. Click the **P2V Restore** item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Wizard’s Welcome page, click the Next button.

3. Browse for the required backup image of your old system. The section below (i.e. Archive File Details) will also display a short description of the selected image.
4. On the next page specify exactly what you need to virtualize, only the system partition or the entire hard disk (in case you have to do with a hard disk backup image).

When having to do with a hard disk backup image, it’s pretty enough to select the system partition only to make your Windows start up in a virtual environment. However that doesn’t guarantee all your applications will work, as they can be installed on the other partitions of the disk.

5. Choose your virtualization software vendor and a number of additional parameters, including.

- **Type of the virtual disk.** You can either create an IDE or a SCSI virtual disk (relevant for VMware only);

- **Create a split disk.** You can choose whether to automatically cut the resulted virtual image to files of 2 GBs or not (available for VMware only);

- **Pre-allocate all disk space.** You can choose whether to pre-allocate all space of the future virtual disk, or do it dynamically;
Not all vendors may be available to choose. If the capacity of the selected object exceeds the maximum capacity for a certain virtual disk, its vendor will be shadowed.

6. Depending on your choice the next page of the wizard enables to set the following parameters:

For a separate partition

- **Size of the virtual disk.** By default the program offers to create a virtual disk exactly the size of the selected object, which you can upsize however. Please note, you can only increase size of the resulted virtual disk;

- **Take all space for the partition.** If you upsize the resulted virtual disk, you can choose whether to occupy the whole disk space by that partition or not;

- **Adjust OS to virtual hardware** to make sure the operating system will be bootable after the operation.

For a hard disk

- **Size of the virtual disk.** By default the program offers to create a virtual disk exactly the size of the selected object, which you can resize however.

- **Resize partitions proportionally.** If you upsize the resulted virtual disk, you can make the program proportionally change the size of partitions keeping their relative order intact.

- **Adjust OS to virtual hardware** to make sure the operating system will be bootable after the operation.
The maximum limit you can downsize the virtual disk is the capacity of its first partition.

7. On the next page of the wizard set a file name for the resulted virtual disk and its location. Besides you can also provide a path to the integration package of your virtualization software.

It's strongly recommended to provide a path to VM Tools/Additions ISO image if you transfer Windows XP to a VMware SCSI disk, otherwise your system won't boot after the operation.

8. The wizard will provide a detailed report on successful accomplishment of the operation. You can save it by clicking the appropriate button.
9. **Now you can connect the resulted virtual disk to your virtual machine.** Your old system has been virtualized from its backup image.

⚠️ **You need to close the program to unlock the virtual disk. Otherwise you won’t be able to connect it to a virtual machine.**

### Making system bootable on virtual hardware (P2V Adjust OS)

Let’s assume you had to migrate to a new hardware platform. Willing to conserve your system, you decided to virtualize it with a 3rd party tool, but unsuccessfully - you got a virtual disk as a result of the operation, but the system was failing to start up. You had nothing to do but forget about your old system. With our program you’ve now got the option to make your virtualized system bootable.

To recover bootability after migrating your physical system to a virtual disk with a 3rd party tool, please do the following:

**Launcher**

1. Click the **P2V Adjust OS** item of the Wizards menu (any of the ways described earlier can also be used here).

2. On the Wizard’s Welcome page, click the Next button.

3. Browse for the required virtual disk.
4. Provide a path to the integration package of your virtualization software.

It's strongly recommended to provide a path to VM Tools/Additions ISO image if you transfer Windows XP to a VMware SCSI disk, otherwise your system won’t boot after the operation.

5. The wizard will provide a detailed report on successful accomplishment of the operation. You can save it by clicking the appropriate button.
Now your virtualized system is 100-percent bootable.

---

**You need to close the program to unlock the virtual disk. Otherwise you won’t be able to connect it to a virtual machine.**

---

**Connecting a virtual disk (Connect VD)**

You’ve got the option to connect a virtual disk of [one of the supported types](#) directly to our program as if it’s an ordinary physical disk, so opening up enormous possibilities:

- Exchange data between your physical environment and the virtual one through Volume Explorer (data import only) or File Transfer Wizard (data import and export). The way we offer is much easier and faster, as you don’t need a VM shared folder, the network, or the slow-goer drag-and-drop;
- Import data from a parent virtual disk to one of its snapshots;
- Accomplish drive partitioning (create, format, delete, move, resize, etc.);
- Modify partition attributes (Active flag, Hidden flag, Volume Label, etc.);
- Clone a partition or an entire hard disk;
- Edit/View sectors, and many more.

To connect a virtual disk (snapshot) to our program, please do the following:

**Launcher**

1. Click the [Connect a Virtual Disk](#) item of the Hard Disk menu (any of the ways described earlier can also be used here).

2. In the opened dialog browse for the required virtual disk, then click Connect to accomplish the operation.
   
   You’ve also got the option to have this disk be connected automatically at every program startup by marking the appropriate checkbox.
Click the “Show recently used disks” link to select and connect one of the disks you’ve already worked with.

3. That’s all. The selected virtual disk will be available on the disk map, as if it’s an ordinary physical disk.

Limitations:
- A virtual disk opened for writing with a 3rd party tool (e.g. being used by a virtual machine) won’t be connected, as asynchronous parallel writing to the disk file will most likely result in data corruption;
- A virtual disk opened for reading with a 3rd party tool (e.g. it’s a parent VMware disk, which snapshot is being used by a virtual machine) will be opened for reading only with the corresponding notification;
- A double disk connection is prohibited.

**Repartitioning a virtual disk**

Let’s assume you’ve got several partitions on a virtual disk. After installing a number of resource-consuming applications and system updates the system partition has started to suffer from the lack of free space. But an adjacent partition has a plenty of redundant space. That’s just enough to make the system partition suffer no more.

To increase size of a system partition by taking unused space from an adjacent partition, please do the following:

**Launcher**

1. Connect the required virtual disk to our program.

2. Select it on the disk map.

3. Right click on the space donor partition, then select **Move/Resize Partition**...
In case you’ve got more than two partitions on the disk, and the required space donor is not adjacent to the system partition, you can still use this scenario by consecutively redistributing free space between all partitions involved in the operation.

4. In the opened dialog drag-and-drop the left edge of the partition to the right to release the required amount of the free space (displayed in aqua-green). You can also do it manually by entering the exact size of free space.

5. Now you’ve got a block of free space to add to the system partition.
6. Right click on the system partition, then select Move/Resize Partition…

7. In the opened dialog shift the right edge of the partition to the right end, thus increasing its size.
8. Apply all introduced changes. By default, the program works in the virtual mode of execution, so you have to confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual Operations Bar.

9. When done, either disconnect the virtual disk or close our program.

**Exchanging data between physical and virtual environments**

Let’s assume you need to import a lot of data from one of your virtual disks. The best way out is to use our program, as it can help you do that without starting up the virtual environment and the other actions typical for this task.

To import data from a virtual environment, please do the following:

**Launcher**

1. **Connect the required virtual disk to our program.**

2. Select in the Main Menu: **Tools > File Transfer Wizard** (any of the ways described earlier can also be used here).

3. On the Wizard’s Welcome page, click the Next button.

4. Select a disk where the required data is stored from the pull-down list in the right pane of the window. You can find it among physical partitions, as a connected virtual disk cannot have an assigned drive letter either.

![](image)

To easily find the disk you need, please use its volume label or sequence number as a check point.

5. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. Click **Next** to continue.
6. Select the **Save data to local/network drives** item. Click **Next** to continue.

7. Specify the exact place to copy the data to.

8. Finish the wizard to accomplish the operation.

**Copying data from a parent virtual disk to one of its snapshots**

Let’s assume you’ve got a virtual machine with several snapshots. You need to copy some data from a parent image to one of its snapshots. You can’t just roll back to the parent image, as you don’t want to lose the latest data of the snapshot, so the best way out is to copy the required data from the parent image to the snapshot.

To copy data from a parent image to one of its snapshots, please do the following:

**Launcher**

1. **Connect the required snapshot disk to our program.**
2. **Connect its parent disk to our program.** It’ll be connected for reading only.
3. **Copy the required data from the parent disk to the snapshot.**
4. Disconnect the virtual disks or close the program.

**Migrating from one virtual environment to another (V2V)**

Let’s assume you’re willing to shift to another virtual machine (e.g. from a Microsoft Virtual PC to VMware Workstation). The only thing that holds you back from it is a lot of virtual disks for MS Virtual PC, which cannot be used with VMware Workstation. Don’t worry, we can help you out.

Before you start, please make sure you’ve got enough free space to accomplish the operation.

To make a virtual disk of one vendor out of an existing virtual disk of another vendor, please do the following:
Launcher

1. **Connect the required virtual disk to our program.**

2. **Complete the P2V Copy Wizard.**

3. As a result you’ll get two virtual disks containing the same virtual environment, but of different vendors. You can now delete the original to release some free space.

**Making system bootable on different hardware (P2P Adjust OS)**

Let’s assume you had to migrate to a new hardware platform. You just connected your system hard disk to the brand new PC and tried to start up the operating system - you do know for sure now that this operation had been doomed to failure from the very beginning. With our program you can easily tackle this naughty problem.

But before you start, please make sure the following conditions are met:

- You’ve got drivers for the new hardware ready to use, not zipped or in .exe files.
- Your OS is unrolled on the new computer, not in a backup image.

To recover bootability after migrating your physical system to different hardware, please do the following:

1. Start up the computer from our WinPE media.

2. Once it has been loaded, read the agreement and then mark the appropriate checkbox to accept.

> **If you do not agree with any conditions stated there, you won’t be able to use the program.**

3. Once you accept the agreement, you will see the Universal Application Launcher. Launch **P2P Adjust OS Wizard**.

   **Our WinPE 2.1 based environment offers excellent hardware support. However in case it doesn’t have a driver for your disk controller, your hard disks will be unavailable. Please consult the [Adding specific drivers](#) scenario to know how to tackle this issue.**

4. On the Wizard’s Welcome page, click the Next button.

5. From the list of all found Windows based operating systems (if several) select one you need to adjust to your new hardware. If you’re willing to adjust them all, just re-launch this wizard for each.
The wizard can only work with Microsoft Windows 2000 and later operating systems.

6. Choose whether you’re going to add drivers for the new hardware to the selected operating system or not and the way it’s to be done. Actually you’ve got three options:

- **Upload drivers automatically from the provided driver repository.** Generally together with new hardware you get its drivers for different operating systems on removable media (mostly CD or DVD). By collecting all these drivers in one folder you can let the wizard automatically pick and install only those required for your OS (recommended);

- **Upload drivers manually.** If you know exactly what drivers your operating system is lacking to successfully start up, you can manually provide them for the wizard.

- **Do not upload drivers.** And finally you can just refuse providing 3rd party drivers.

We prefer the wizard to decide what drivers are to be installed.

7. Browse for a folder with drivers for the new hardware or type in a full path to it manually.

8. Apply the changes by confirming the operation.
After the operation is completed your system will be bootable on the new hardware.

**Migrating from a virtual environment to physical (V2P)**

Let’s assume your desktop PC was damaged a couple of months ago. Luckily you had had its system virtualized just before the tragedy. Having a laptop at the disposal, you kept working with the desktop system in a virtual environment for a while, while scanning the market for a replace. To cut it short, you’ve got a brand-new desktop PC just delivered to your door – it’s time for a little V2P operation. Our program can help you do that.

But before you start, please make sure the following conditions are met:

- You’ve got drivers for the new hardware ready to use, not zipped or in .exe files.
- You’ve got access to the virtual disk from your desktop PC. You can have it locally, on external storage, or a network share.

To migrate from a virtual environment to physical, please do the following:

1. Start up the computer from our WinPE media.
2. Once it has been loaded, read the agreement and then mark the appropriate checkbox to accept.
   ![](image)
   If you do not agree with any conditions stated there, you won’t be able to use the program.

Once you accept the agreement, you will see the Universal Application Launcher. Click **Full Scale Launcher**.

3. **Connect the required virtual disk to our program**.
4. **Copy the connected virtual disk to your physical disk** just the way it’s done with physical disks.
5. Right click on the virtual disk, then select **Disconnect Virtual Disk**.
6. **Complete the P2P Adjust OS Wizard**.

**Migrating a Windows 7 vhd**

Let’s assume you need to make your Windows 7 contained in a .vhd file start up on another computer. You’ve copied the virtual disk, added info on it to the BCD boot menu, then tried to start up the OS, but to no avail - your Windows goes BSOD with the 0x000007B error code. We can help you out with this naughty problem.

To make a .vhd image of Windows 7 start up on different hardware, please do the following:

1. Start up the computer from our WinPE media.
2. Once it has been loaded, read the agreement and then mark the appropriate checkbox to accept.

**If you do not agree with any conditions stated there, you won’t be able to use the program.**

Once you accept the agreement, you will see the Universal Application Launcher. Click **Full Scale Launcher**.

3. **Connect the required virtual disk to our program.**

4. **Complete the P2P Adjust OS Wizard.**

**Hard Disk Optimization**

To defragment an NTFS or FAT partition, please do the following:

**Express Launcher**

**You must have administrator’s privileges to accomplish defragmentation of the system partition.**

1. Click the **Security and Optimization** button and then select **Defragment Partition**.

2. In the main window, select a partition you want to defragment on the Disk Map.

3. Launch the Defragment Partition dialog by calling the popup menu for the selected partition (right click of the mouse button) and then selecting the menu item: **Defragment Partition…**

4. In the opened dialog define settings of the operation. To improve the performance we recommend you to mark the **Do not save content of the Pagefile.sys or (and) Hiberfile.sys** checkbox as these files are only needed for the current Windows session.
The Defragment Partition dialog offers a number of additional parameters that can also be of help. However here we pay attention to the most relevant to fulfill our task.

5. Start the operation by clicking the Yes button.

**Hard Disk Utilization**

To irreversibly destroy all on-disk information without any possibility to recover and that way providing the maximum level of security, please do the following:

Launch the Wipe Wizard. There are several ways to do it:

**Express Launcher**

- Click the **Security and Optimization** button and then select **Wipe**.

**Launcher**

- In the Main Menu: select **Wizards > Wipe Hard Disk or Partition**...
- On the Wizard's Welcome page, click the Next button.

1. Select a hard disk, the data of which you want to wipe out.

2. On the Wipe Mode page, select the wipe out all the data to irreversible destroy all on-disk information.
3. On the Wipe Method page select a specific data erasure algorithm or choose to create a customized one (in our case we prefer to use a certified military standard).

4. The next page of the wizard enables to get detailed information on the selected algorithm, choose whether to carry out residual data verification or not specifying the percentage of sectors to check and estimate the time required to accomplish the operation.

5. Review all parameters of the operation and modify them if necessary.

6. Complete the wizard and then apply the pending changes.
Extra Scenarios for WinPE

Adding specific drivers
Our WinPE 2.1 based recovery environment offers excellent hardware support. Anyway you’ve got the option to add drivers for specific hardware with a handy dialog.

To add drivers for specific hardware, please do the following:

1. Once you accept the agreement, you will see the Universal Application Launcher. Click Load Drivers.

2. In the opened dialog browse for an .INF file of the required driver package located on a floppy disk, local disk, CD/DVD or a network share. Then click the Open button to initiate the operation.

To know how to map a network share, please consult the Configuring network scenario.

3. You will be notified on the successful accomplishment of the operation. Click Yes to load another driver or No to close the dialog.

Our WinPE 2.1 recovery environment is 32-based, thus you need to use 32-bit drivers for injection.
Configuring network

If your local network has a DHCP server, a network connection will be automatically configured once our WinPE recovery environment has been started up. Otherwise you will need to do it manually with a handy dialog by providing an IP address, a network mask, default gateway, etc. Besides with its help you can easily map network shares.

To manually set up a network connection and map a network share, please do the following:

1. Once you accept the agreement, you will see the Universal Application Launcher. Click **Configure Network**.

2. In the opened dialog provide an IP address, a network mask, default gateway, etc. for your network device.

3. Click the **Network drivers** tab to map a network share.

4. Click **Map Network Drive** and provide all the necessary information to map a network share in the opened dialog:

   - Click the standard browse button [...] to browse for the required network share or manually enter a path to it;
   - Define a letter from the pull-down list of available drive letters;
   - Click the **Connect as user** button at the foot of the dialog page to specify a user name and password to access the selected network share if necessary.
By clicking Disconnect Drive... you can delete an existing network share if necessary.

5. Click the Network identification tab to change a network name of your computer (generated automatically) and a workgroup name.

6. By default, the wizard saves all network settings in the netconf.ini file located on the WinPE RAM drive, thus it will only be available until you restart the computer. However, you can just once configure your network device and then save this file to some other destination, for instance a local drive, and this way avoid constant re-configuration, just by providing a path to it. So Click Save to file to save the netconfig.ini file to the required destination.

Saving log files
The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of having difficulties with handling the program, you, with the help of this very function, can address the company support engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in order to tackle the encountered problem. Information of that kind is stored in log files.

To prepare a log files package, please do the following:

1. Once you accept the agreement, you will see the Universal Application Launcher. Click Log Saver.

2. In the opened dialog browse for the required location of the log files package or manually provide a full path to it. Click Collect to initiate the operation.

Log files do not contain any confidential information on the operating system settings or the user documents.

Connecting Virtual Disks to a Virtual Machine
With our program you can only create virtual disks not virtual machines. Thus to work with your virtualized system, first you need to connect its virtual disk to a virtual machine. Actually you’ve got two options:

- Connect the virtual disk to an existing virtual machine;
- Connect the virtual disk to a new virtual machine.
Connecting virtual disks to an existing virtual machine

**For VMware Workstation**

To connect a VMware Workstation virtual disk to an existing virtual machine, please do the following:

1. Open an existing VMware Workstation virtual machine.

2. Please make sure its guest OS is the same as on your virtual disk, otherwise you may face hardware incompatibility problems.

3. Click **Add...** to connect your virtual disk to the machine.
4. In the opened dialog select **Hard Disk** as the required hardware type to add.

5. On the next page select **Use an existing virtual disk**.

7. Click **Finish** to complete the operation. Most likely you will be asked to convert your virtual disk to a new format. You can update your disks, since this procedure involves change of a version only, nothing else. To know more on the subject please consult the **Known Issues** chapter.

8. That’s all. You can now launch the virtual machine.

---

**Connecting virtual disks to a new virtual machine**

*For VMware Workstation*

To connect a VMware Workstation virtual disk to a new virtual machine, please do the following:

1. Click **New Virtual Machine**.
2. On the Wizard's Welcome page, click the Next button.

3. On the next page select Typical.

4. Select the required guest OS. Please make sure it's the same as on your virtual disk, otherwise you may face hardware incompatibility problems.
5. Provide a name and location for your virtual machine.

6. The wizard will offer you to create a virtual disk. As you cannot skip it, click **Next** to complete the operation.

7. Edit settings of the newly created machine.

8. Select the default virtual disk and click **Remove** to delete.
9. Click **Add...** to connect your virtual disk to the machine.

10. In the opened dialog select **Hard Disk** as the required hardware type to add.
11. On the next page select **Use an existing virtual disk**.


13. Click **Finish** to complete the operation. Most likely you will be asked to convert your virtual disk to a new format. You can update your disks, since this procedure involves change of a version only, nothing else. To know more on the subject please consult the **Known Issues** chapter.

14. That’s all. You can now launch the virtual machine.
For Windows Virtual PC

1. Click **Start**, and then select **Windows Virtual PC**.

2. Click **Create virtual machine**.

3. Give a name to the new machine and modify the default location (if necessary).
4. Specify an amount of RAM to allocate (512 MBs for Windows XP is recommended), then choose whether you need the network support or not by marking the appropriate checkbox.

5. Select **Use an existing virtual hard disk**, then browse for the previously created virtual disk or manually type in a full path to it. Click **Create** to complete the operation.

⚠️ **To know more on the subject, please click the links on this page.**
6. Right click on the newly created virtual machine, then select **Open** to start up your Windows in a virtual environment.

![Create a virtual machine](image)

**Troubleshooter**

Here you can find answers to the most frequently asked questions that might arise while using the program.

1. I try to run an operation, but the program claims my partition is in use and suggests restarting the computer.

   There are a number of operations that cannot be performed while your partition is in use (or locked in other words). Please agree to reboot your machine to make the program accomplish the operation in a special boot-up mode.

2. I run an operation and restart the machine as required, but it just boots back into Windows without accomplishing the operation.

   Please run 'chkdsk /f' for the partition in question.

3. I cannot create a new partition on the disk.

   There can be a number of reasons for that:
   
   - The program cannot create a new partition on a dynamic disk, but only on a hard disk that uses the DOS partitioning scheme.
• According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot be created:
  - Two Extended Partitions on one hard disk;
  - Five or more Primary partitions on one hard disk;
  - If there is an Extended Partition on the disk, only three Primary partitions are allowed.

• The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free space on an existing partition to a new partition.

4. I cannot copy a partition.
   
   There can be a number of reasons for that:
   
   - The source or target disk you select is a dynamic disk;
   
   - 4 primary partitions (or three primary partitions and an extended one) already exist on the target disk.

5. I need to copy a partition. But when selecting a place where to make a copy, I always get a crossed circle sign no matter which partition is selected.
   
   The program enables to copy a partition only to a block of un-partitioned space. If you don’t have a block of free space on your hard disk, please delete or reduce an existing partition to accomplish the operation.

6. I cannot do anything with my USB flash drive. I get a crossed circle sign when trying to select any area on it.
   
   Some USB flash drives don’t have the MBR (Master Boot Record), that’s the cause of your problem. To fix the issue please use the Update MBR function of our program or ‘fixmbr’ of the Windows installation disc to write a standard code to your flash drive.

7. When trying to back up my system the program asks to restart the computer.
   
   Most likely the Hot Processing mode is disabled. Please make it active in the program settings.

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program throws "VSS could not be started for processed volume".
   
   Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the Paragon Hot Processing mode instead.

9. I cannot back up my hard disk to an external hard drive. Once started, the operation is aborted with the following error: Hard Disk management, Error Code 0x1100a. What is wrong here?
   
   The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the program. But this service has not been started in your WindowsXP/Windows2003/Vista. Please start this service (right click on My Computer > Manage > Services > find Microsoft Volume Shadow Copy Service and make it active. Set also to start it automatically).

10. When running a backup operation with the Paragon Hot Processing mode enabled, I get an error: error code 0x1200e "Internal error during Hot Backup"
    
    Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer’s tool.
11. When running a backup operation with the Microsoft VSS mode enabled, I get the following error: error code 0x12016 "VSS: can’t read volume data"

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer’s tool.

You can find a name of the tool you need here: http://kb.paragon-software.com

12. When trying to back up to a network share, I get the following error: "i/o error" or "can’t open/create file"

Please check whether you’ve got a permission to write to the selected destination or not.

13. When trying to restore a backup archive, I get the following error: "Can't restore to current selection" or "Archive does not fit"

Most likely you’re trying to restore a backup of the whole hard disk to a partition or vice versa.

14. I set up a timetable for a task, but it fails to execute.

There can be a number of reasons for that:

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling a simple task (call Notepad through scheduling);

- You don’t have permission to write to the selected backup destination.

**Glossary**

**Active Partition** is a partition from which an x86-based computer starts up. The active partition must be a primary partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the system volume.

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the standard bootstrap.

The term **backup** originates from the time when the best way to protect valuable information was to store it in form of archives on external media. It’s become now a general notion to mean making duplications of data for protection purposes.

**Bootable Archive** is created by adding a special bootable section when backing up the data to CD/DVDs. Thus you will be able to restore the data from these archives without having to run the program, but by simply booting from these CD/DVDs.

**Cluster** is the smallest amount of disk space that can be allocated to hold a file. All file systems used by Windows organize hard disks based on clusters, which consist of one or more contiguous sectors. The smaller the cluster size, the more efficiently a disk stores information. If no cluster size is specified during formatting, Windows picks defaults based on the size of the volume. These defaults are selected to reduce the amount of space that is lost and the amount of fragmentation on the volume. A cluster is also called an allocation unit.

**Extended Partition** is a partition type you create only on a basic MBR (Master Boot Record) disk. Extended partition is used if you want to create more than four volumes on a disk, since it may contain multiple logical drives.
**File System Metadata.** The servicing structures of a file system, which contain information about allocating files and directories, security information etc., are named the file system metadata. It is invisible for users and regular applications because its accidental modification usually makes a partition unusable.

**Hard Disk Geometry.** Traditionally, the usable space of a hard disk is logically divided into cylinders, cylinders are divided into tracks (or heads), and tracks are divided into sectors.

The triad of values \([\text{Sectors-per-Track}], [\text{Tracks-per-Cylinder}], [\text{Amount-of-Cylinders}]\) is usually named the Hard Disk Geometry or C/H/S geometry.

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk parameters play an essential role in the DOS Partitioning scheme.

Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes that all on-disk sectors are continuously enumerated from “0”. To allow backward compatibility with older standards, modern hard disks can additionally emulate the C/H/S geometry.

**Hidden Partition.** The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. By default, an operating system does not mount a hidden partition, thus preventing access to its contents.

A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. This is achieved by XOR-ing the partition ID with a 0x10 hexadecimal value.

**Master File Table (MFT)** is a relational database that consists of rows of file records and columns of file attributes. It contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is similar to a FAT table in a FAT file system.

**MBR & 1st track of the hard disk** is the 0th sector of the disk. MBR (Master Boot Record) contains important information about the disk layout:

- The used partitioning scheme;
- The starting records of the Partition Table;
- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses).

Generally, the 0th sector is used for similar purposes in all existing partitioning schemes.

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot software is allowed to use the entire 0th track of the disk. For example, boot managing utilities such as LILO, GRUB and Paragon Boot Manager are located in the 0th track.

**Partition ID** (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly detect partitions of supported types. A number of operating systems completely rely on it to distinguish supported partitions.

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space.

**Partition Label** (or Volume Label) is a small textual field (up to 11 characters) that is located in the partition’s boot sector. This value is used for notification purposes only. It is detectable by any partitioning tool including the DOS FDISK utility.

Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to contain a relatively large amount of text in multiple languages.
**Partitioning Scheme** is a set of rules, constraints and format of the on-disk structures to keep information on partitions located on a hard disk.

There are known several partitioning schemes. The most popular of them is the so-called DOS partitioning scheme. It was introduced by IBM and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible computers.

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from the UNIX mainframe systems. Veritas Executive accommodates a simplified version of LDM to the Windows 2000 operating system.

Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme and the new Dynamic Disk Management (DDM). The problem is that earlier versions of Windows do not support DDM. In addition, most hard disk utilities do not support it as well.

**Recovery Media** is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot for maintenance or recovery purposes.

**Root Directory** is the top-level directory of a formatted logical drive to include other files and directories. In modern file systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other directories. This is not the case for old FAT12 and FAT16 file systems.

**Serial Number.** In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial number represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is assigned when the MBR sector is initialized by Microsoft standard disk managing tools, such as Windows Disk Administrator and the FDISK utility.

In fact, a hard disk's serial number is not important for most operating systems and software. It is known that Windows NT, 2000 and XP store its value in the database of assigned drive letters.

A partition's serial number is stored in its boot sector (in FAT16, FAT32 and NFTS file systems). Its value is assigned when the partition is formatted. It does not play an important role for most operating systems and software as well.